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Product Overview
In this section...
“Introduction” on page 1-2
“The Role of Simulation in Design” on page 1-2
“Required and Related Products” on page 1-2

Introduction
Simscape Electrical Specialized Power Systems software and other products of the Physical Modeling
product family work together with Simulink software to model electrical, mechanical, and control
systems.

Simscape Electrical Specialized Power Systems software operates in the Simulink environment.
Therefore, before starting this user's guide, make yourself familiar with Simulink documentation.

The Role of Simulation in Design
Electrical power systems are combinations of electrical circuits and electromechanical devices like
motors and generators. Engineers working in this discipline are constantly improving the
performance of the systems. Requirements for drastically increased efficiency have forced power
system designers to use power electronic devices and sophisticated control system concepts that tax
traditional analysis tools and techniques. Further complicating the analyst's role is the fact that the
system is often so nonlinear that the only way to understand it is through simulation.

Land-based power generation from hydroelectric, steam, or other devices is not the only use of power
systems. A common attribute of these systems is their use of power electronics and control systems to
achieve their performance objectives.

Simscape Electrical Specialized Power Systems software is a modern design tool that allows
scientists and engineers to build models that simulate power systems rapidly and easily. It uses the
Simulink environment, allowing you to build a model using simple click and drag procedures. Not
only can you draw the circuit topology rapidly, but your analysis of the circuit can include its
interactions with mechanical, thermal, control, and other disciplines. This is possible because all the
electrical parts of the simulation interact with the extensive Simulink modeling library. Since
Simulink uses the MATLAB® computational engine, designers can also use MATLAB toolboxes and
Simulink blocksets. Simscape Electrical Specialized Power Systems software belongs to the Physical
Modeling product family and uses similar block and connection line interface.

Required and Related Products
Simscape Electrical Specialized Power Systems software requires the following products:

• MATLAB
• Simulink
• Simscape

In addition to Simscape Electrical Specialized Power Systems software, the Physical Modeling
product family includes other products for modeling and simulating mechanical and electrical
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systems. Use these products together to model physical systems in Simulink and Simscape
environment. There are also several closely related products from MathWorks that you can use with
Simscape Electrical Specialized Power Systems software. For more information about any of these
products, see the MathWorks website at https://www.mathworks.com; see the “Products” section.
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Build and Simulate a Simple Circuit

In this section...
“Introduction” on page 1-4
“Building the Electrical Circuit with the Simscape Electrical Specialized Power Systems Library” on
page 1-4
“Interfacing the Electrical Circuit with Other Simulink Blocks” on page 1-7
“Measuring Voltages and Currents” on page 1-8
“Basic Principles of Connecting Capacitors and Inductors” on page 1-8
“Using the Powergui Block to Simulate Simscape Electrical Specialized Power Systems Models” on
page 1-9

Introduction
Simscape Electrical Specialized Power Systems allows you to build and simulate electrical circuits
containing linear and nonlinear elements.

In this section, you

• Explore the Simscape Electrical Specialized Power Systems library.
• Learn how to build a simple circuit from the Simscape Electrical Specialized Power Systems

library.
• Interconnect Simulink blocks with your circuit.

The circuit in the figure represents an equivalent power system feeding a 300-km transmission line.
The line is compensated by a shunt inductor at its receiving end. A circuit breaker allows energizing
and de-energizing of the line. To simplify matters, only one of the three phases is represented. The
parameters shown in the figure are typical of a 735-kV power system.

Circuit to Be Modeled

Building the Electrical Circuit with the Simscape Electrical Specialized
Power Systems Library
The graphical user interface uses Simulink functionality to interconnect various electrical
components. The electrical components are grouped in the Simscape Electrical Specialized Power
Systems library.
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1 To open the Simscape Electrical Specialized Power Systems main library, at the MATLAB
command prompt, enter:

simscapepowersystems_ST
2 Open a new blank model to contain your first circuit and save it as circuit1.
3 Add the AC Voltage Source block from the Simscape > Electrical > Specialized Power

Systems > Fundamental Blocks > Electrical Sources library.
4 Set the Amplitude, Phase, and Frequency parameters of the AC Voltage Source block according

to the values shown in “Circuit to Be Modeled” on page 1-4.

The amplitude to be specified for a sinusoidal source is its peak value (424.4e3*sqrt(2) volts, in
this case).

5 Change the name of this block from AC Voltage Source to Vs.
6 Add the Parallel RLC Branch block from the Simscape > Electrical > Specialized Power

Systems > Fundamental Blocks > Elements library, set its parameters as shown in “Circuit to
Be Modeled” on page 1-4, and name it Z_eq.

7 The resistance Rs_eq of the circuit can be obtained from the Parallel RLC Branch block.
Duplicate the Parallel RLC Branch block, which is already in your circuit1 window. Select R for
the Branch Type parameter and set the R parameter according to “Circuit to Be Modeled” on
page 1-4.

Once the dialog box is closed, notice that the L and C components have disappeared so that the
icon now shows a single resistor.

8 Name this block Rs_eq.
9 Resize the various components and interconnect blocks by dragging lines from outputs to inputs

of appropriate blocks.

10 Add a PI Section Line block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Elements library. You add the circuit breaker later in “Simulating
Transients” on page 1-19.

The model of a line with uniformly distributed R, L, and C parameters normally consists of a
delay equal to the wave propagation time along the line. This model cannot be simulated as a
linear system because a delay corresponds to an infinite number of states. However, a good
approximation of the line with a finite number of states can be obtained by cascading several PI
circuits, each representing a small section of the line.

A PI section consists of a series R-L branch and two shunt C branches. The model accuracy
depends on the number of PI sections used for the model. Copy the PI Section Line block from
the Simscape > Electrical > Specialized Power Systems > Fundamental Blocks >
Elements library into the circuit1 window, set its parameters as shown in “Circuit to Be
Modeled” on page 1-4, and specify one line section.
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11 The shunt reactor is modeled by a resistor in series with an inductor. You could use a Series RLC
Branch block to model the shunt reactor, but then you would have to calculate and specify the R
and L values manually based on the quality factor and reactive power specified in “Circuit to Be
Modeled” on page 1-4.

Therefore, you might find it more convenient to use a Series RLC Load block that allows you to
specify directly the active and reactive powers absorbed by the shunt reactor.

Add a Series RLC Load block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Elements library. Name this block 110 Mvar. Set its parameters as
follows:

Vn 424.4e3 V
fn 60 Hz
P 110e6/300 W (quality factor = 300)
QL 110e6 vars
Qc 0

As no reactive capacitive power is specified, the capacitor disappears on the block icon when the
dialog box is closed. Interconnect the new blocks as shown.

12 Add a Voltage Measurement block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Measurements library. Name it U1. Connect its positive
input to the node B1 and its negative input to a new Ground block.

13 To observe the voltage measured by U1, a display system is needed.

Add a Scope block into your circuit1 window. If the scope were connected directly at the output
of the voltage measurement, it would display the voltage in volts. However, electrical engineers
in power systems are used to working with normalized quantities (per unit system). The voltage
is normalized by dividing the value in volts by a base voltage corresponding to the peak value of
the system nominal voltage. In this case, the scaling factor K is

K = 1
424.4 × 103 × 2

14 Add a Gain block and set its gain as above. Connect its output to the Scope block and connect the
output of the Voltage Measurement block to the Gain block. Duplicate this voltage measurement
system at the node B2, as shown below.
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15 Add a powergui block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks library. The purpose of this block is discussed in “Using the Powergui
Block to Simulate Simscape Electrical Specialized Power Systems Models” on page 1-9.

16 Start the simulation.
17 Open the Scope blocks and observe the voltages at nodes B1 and B2.
18 While the simulation is running, open the Vs block dialog box and modify the amplitude. Observe

the effect on the two scopes. You can also modify the frequency and the phase. You can zoom in
on the waveforms in the scope windows by drawing a box around the region of interest with the
left mouse button.

Interfacing the Electrical Circuit with Other Simulink Blocks
The Voltage Measurement block acts as an interface between the Simscape Electrical Specialized
Power Systems blocks and the Simulink blocks. For the system shown above, you implemented such
an interface from the electrical system to the Simulink system. The Voltage Measurement block
converts the measured voltages into Simulink signals.

Similarly, the Current Measurement block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Measurements library can be used to convert any measured
current into a Simulink signal.

You can also interface from Simulink blocks to the electrical system. For example, you can use the
Controlled Voltage Source block to inject a voltage in an electrical circuit, as shown in the following
figure.
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Electrical Terminal Ports and Connection Lines  Simscape Electrical Specialized Power Systems
modeling environment is similar to that of other products in the Physical Modeling family. Its blocks
often feature both normal Simulink input and output ports > and special electrical terminal ports :

• Lines that connect normal Simulink ports > are directional signal lines.
• Lines that connect terminal ports  are special electrical connection lines. These lines are

nondirectional and can be branched, but you cannot connect them to Simulink ports > or to
normal Simulink signal lines.

• You can connect Simulink ports > only to other Simulink ports and electrical terminal ports  only
to other electrical terminal ports.

• Converting Simulink signals to electrical connections or vice versa requires using a Simscape
Electrical Specialized Power Systems block that features both Simulink ports and electrical
terminal ports.

Some Simscape Electrical Specialized Power Systems blocks feature only one type of port.

Measuring Voltages and Currents
When you measure a current using a Current Measurement block, the positive direction of current is
indicated on the block icon (positive current flowing from + terminal to – terminal). Similarly, when
you measure a voltage using a Voltage Measurement block, the measured voltage is the voltage of the
+ terminal with respect to the – terminal.

Basic Principles of Connecting Capacitors and Inductors
Pay particular attention when you connect capacitor elements together with voltage sources, or
inductor elements in series with current sources. When you start the simulation, the software
displays an error message if one of the following two connection errors are present in your diagram:

1 You have connected a voltage source in parallel with a capacitor, or a series of capacitor
elements in series, like in the two examples below.
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To fix this problem, you can add a small resistance in series between the voltage source and the
capacitors.

2 You have connected a current source in series with an inductor, or a series of inductors
connected in parallel, like in the example below.

To fix this problem, you can add a large resistance in parallel with the inductor.

Using the Powergui Block to Simulate Simscape Electrical Specialized
Power Systems Models
The Powergui block is the environment block for Simscape Electrical Specialized Power Systems
models. It is used to store the equivalent Simulink circuit that represents the state-space equations of
the Simscape Electrical Specialized Power Systems blocks. It also opens tools for steady-state and
simulation results analysis and for advanced parameter design. When you start the simulation, you
will get an error if no Powergui block is found in your model.

See powergui for more information on how to use the powergui block in your models.
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Analyze a Simple Circuit

In this section...
“Introduction” on page 1-10
“Electrical State Variables” on page 1-10
“State-Space Representation Using power_analyze” on page 1-10
“Steady-State Analysis” on page 1-11
“Frequency Analysis” on page 1-11

Introduction
In this section, you

• Obtain the state-space representation of your model with the power_analyze command
• Compute the steady-state voltages and currents using the graphical user interface of the Powergui

block
• Analyze an electrical circuit in the frequency domain

Electrical State Variables
The electrical state variables are the Simulink states of your diagram associated to the capacitor and
inductor devices of the Simscape Electrical Specialized Power Systems blocks. Inductors and
capacitors elements are found in the RLC-branch type blocks such as the Series RLC Branch block,
Three-Phase Parallel RLC Load block, in the transformer models, in the PI Section Line block, in the
snubber devices of the power electronic devices, etc.

The electrical state variables consist of the inductor currents and the capacitor voltages. Variable
names for Simscape Electrical Specialized Power Systems electrical states contain the name of the
block where the inductor or capacitor is found, preceded by the Il_ prefix for inductor currents or
the Uc_ prefix for capacitor voltages.

State-Space Representation Using power_analyze
You compute the state-space representation of a model with the power_analyze command. Enter
the following command at the MATLAB prompt.

[A,B,C,D,x0,electrical_states,inputs,outputs]=power_analyze('power_gui')

The power_analyze command returns the state-space model of power_gui example model in the
four matrices A, B, C, and D. x0 is the vector of initial conditions of the electrical states of your
circuit. The names of the electrical state variables, inputs, and outputs are returned in three
matrices.

See the power_analyze reference page for more details on how to use this function.
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Steady-State Analysis
Open the power_gui example model by typing power_gui at the command line. Then open the
Powergui Steady-State Voltages and Currents Tool to display the steady-state phasors voltages
measured by the voltage measurement and current measurement blocks of the model.

Each measurement output is identified by a character vector corresponding to the measurement
block name. The magnitudes of the phasors correspond to the peak value of the sinusoidal voltages.

You can also display the steady-state values of the source voltage or the steady-state values of the
inductor currents and capacitor voltages by selecting either the Sources or the States check box.

Refer to the section “Measuring Voltages and Currents” on page 1-8 for more details on the sign
conventions used for the voltages and currents of sources and electrical state variables listed in the
Steady-State Tool window.

Frequency Analysis
The Simscape > Electrical > Specialized Power Systems > Fundamental Blocks >
Measurements library contains an Impedance Measurement block that measures the impedance
between any two nodes of a circuit. In the following two sections, you measure the impedance in the
power_gui model by using two methods:

• Automatic measurement using the Impedance Measurement block and the Powergui block
• Calculation from the state-space model

Obtaining the Impedance vs. Frequency Relation from the Impedance Measurement and
Powergui Blocks

The process to measure a circuit impedance from the state-space model (which is described in detail
in the next section, “Obtaining the Impedance vs. Frequency Relation from the State-Space Model”
on page 1-13) has been automated in a Simscape Electrical Specialized Power Systems block. In the
power_gui example model, two Impedance Measurement blocks of powerlib measure impedance at
two points in the model. Delete the Impedance B3 block and reconnect the Impedance B1 as shown.

Measuring Impedance vs. Frequency with the Impedance Measurement Block
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In the 150 km Line block, set Number of pi sections to 1, and click OK. Open the Powergui dialog.
In the Tools tab, select Impedance Measurement. A new window opens, showing the list of
Impedance Measurement blocks available in the circuit.

Fill in the frequency range by entering 0:2:5000 (zero to 5000 Hz by steps of 2 Hz). Select the
logarithmic scale to display Z magnitude.

When the calculation is finished, the window displays the magnitude and phase as functions of
frequency. In the 150 km Line block dialog box, set the Number of pi sections to 10. In the
Powergui Impedance vs Frequency Measurement tool, click the Update button. The block dialog box
displays the frequency response for the new circuit.
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Obtaining the Impedance vs. Frequency Relation from the State-Space Model

Note The following section assumes that you have Control System Toolbox™ software installed.

To measure the impedance versus frequency at the same node where the impedance measurement
block is connected, you need a current source providing a second input to the state-space model. Add
the AC Current Source block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Electrical Sources library to your model. Connect this source, as shown
below. Set the current source magnitude to zero and keep its frequency at 60 Hz.
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AC Current Source at the B2 Node

Now compute the state-space representation of the model with the power_analyze command. Enter
the following command at the MATLAB prompt.

sys1 = power_analyze('power_gui','ss')

This command returns a state-space model representing the continuous-time state-space model of
your electrical circuit.

In the Laplace domain, the impedance is defined as the transfer function between the current
injected by the AC current Source block and the voltage measured by the U2 Voltage Measurement
block.

Z2 s = U2 s
I2 s

You obtain the names of the inputs and outputs of this state-space model as follows.

sys1.InputName
ans = 
    'U_Vs (60Hz)'
    'I_AC Current Source'
sys1.OutputName
ans = 
    'U_Ub2'
    'U_Ub1'

The impedance at the measured node then corresponds to the transfer function between output 1 and
input 2 of this state-space model. For the 0–5000 Hz range, it can be calculated and displayed as
follows.

freq=0:5000;
w=2*pi*freq;
bode(sys1(1,2),w);

Repeat the same process to get the frequency response with a 10 section line model. Open the PI
Section Line dialog box and change the number of sections from 1 to 10. To calculate the new
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frequency response and superimpose it upon the one obtained with a single line section, enter the
following commands.

sys10 = power_analyze('power_gui','ss');
bode(sys1(1,2),sys10(1,2),w);

Open the property editor of the Bode plot and select units for Frequency in Hz using linear scale and
Magnitude in absolute using log scale. The resulting plot is shown below.

Impedance at the Measured Node as Function of Frequency

This graph indicates that the frequency range represented by the single line section model is limited
and the 10 line section model gives a better approximation for higher frequencies.
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Specify Initial Conditions
In this section...
“Introduction” on page 1-16
“State Variables” on page 1-16
“Initial States” on page 1-17
“Specify Initial Electrical States with Powergui” on page 1-17

Introduction
In this section, you

• Learn what are the state variables of a Simulink diagram containing Simscape Electrical
Specialized Power Systems blocks

• Specify initial conditions for the electrical state variables

State Variables
The state variables of a Simulink diagram containing Simscape Electrical Specialized Power Systems
blocks consist of

• The electrical states associated to RLC branch-type Simscape Electrical Specialized Power
Systems blocks. They are defined by the state-space representation of your model. See “Electrical
State Variables” on page 1-10 for more details about the electrical states.

• The Simulink states of the Simscape Electrical Specialized Power Systems electrical models such
as the Synchronous Machine block, the Saturable Transformer block, or the Three-Phase Dynamic
Load block.

• The Simulink states of the other Simulink blocks of your model (controls, user-defined blocks, and
other blocksets).

The following picture provides an example that contains the three types of state variables:
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Initial States
Initial conditions, which are applied to the entire system at the start of the simulation, are generally
set in the blocks. Most of the Simulink blocks allow you to specify initial conditions. For the case of
the electrical states, the Simscape Electrical Specialized Power Systems software automatically sets
the initial values of the electrical states to start the simulation in steady state.

However, you can specify the initial conditions for the capacitor voltage and inductor currents in the
mask of these blocks:

• the Series and Parallel RLC Branch blocks
• the Series and Parallel RLC Load blocks

The initial values entered in the mask of these blocks overwrites the default steady-state parameters
calculated by the Simscape Electrical Specialized Power Systems software. In the same sense, you
can overwrite initial conditions of the overall blocks by specifying them in theModel Configuration
Parameters.

See the power_init function reference page for more details on how you can specify initial states
for a Simulink diagram with Simscape Electrical Specialized Power Systems blocks.

Specify Initial Electrical States with Powergui
1 Open the Transient Analysis of a Linear Circuit example by typing power_transient at the

command line. Rename the RLC Branch blocks as shown in the next figure.

2 Double-click the powergui block, open the Tools tab, and click Initial State. The initial values of
the five electrical state variables (three inductor currents and two capacitor voltages) are
displayed. These initial values corresponds to the values that the software automatically sets to
start the simulation in steady state.

3 Open the Scope block and start the simulation. As the electrical state variables are automatically
initialized, the system starts in steady state and sinusoidal waveforms are observed.

4 The initial value for STATE_D state is set to 1.589e5 V. It corresponds to the initial capacitor
voltage found in the STATE_D block. Open this block, select the Set the initial capacitor
voltage parameter, then specify a capacitor initial voltage of -2e5 V. Click the OK button.

5 Click the From diagram button of the Powergui Initial States Tool to refresh the display of initial
states. The initial state of STATE_D block is now set to -2e5 V.

6 Start the simulation. In the second trace of the Scope block, zoom around the transient at the
beginning of the simulation. As expected, the model does not start in steady state, but the initial
value for the capacitor voltage measured by the Voltage Measurement block is -2e5 V.
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7 Select the STATE_A state variable in the Initial States Tool list. In the Set selected electrical
state field, set the initial inductor current to 50 A, and click Apply. Open the mask of the
STATE_A block, and note that the Set the initial inductor current parameter is selected and
the initial inductor current is set to 50 A.

Run the simulation and observe the new transient caused by this new setting.

Forcing Initial States to Zero

Now suppose that you want to reset all the initial electrical states to zero without losing the settings
you have done in the previous steps.

1 From the Initial State Tool window, select the To zero check box under Force initial electrical
states, then click Apply. Restart the simulation and observe the transient when all the initial
conditions start from zero.

2 Open the masks of the STATE_C and STATE_A blocks and note that even if initial conditions are
still specified in these blocks, the setting for the initial states is forced to zero by the Powergui
block.

A message is displayed at the command line to remind you every time you start the simulation that
the electrical initial states of your model are forced to zero by the Powergui block, which overwrites
the block settings in your model.

Forcing Initial States to Steady State

Similarly, you can set all the initial states to steady without losing the settings you have done in the
previous steps.

1 From the Initial State Tool window, select the To steady state check box under Force initial
electrical states, then click Apply.

2 Restart the simulation and observe that the simulation starts in steady state.

A message is displayed at the command line to remind you every time you start the simulation that
the electrical initial states of your model are forced to steady state by the Powergui block.

Returning to Block Settings

To return to the block settings, clear both check boxes under Force initial electrical states, then
click Apply.
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Simulating Transients
In this section...
“Introduction” on page 1-19
“Simulating Transients with a Circuit Breaker” on page 1-19
“Discretizing the Electrical System” on page 1-21

Introduction
In this section, you

• Learn how to create an electrical subsystem
• Simulate transients with a circuit breaker
• Compare time domain simulation results with different line models
• Learn how to discretize a circuit and compare results thus obtained with results from a

continuous, variable time step algorithm

Simulating Transients with a Circuit Breaker
One of the main uses of Simscape Electrical Specialized Power Systems software is to simulate
transients in electrical circuits. This can be done with either mechanical switches (circuit breakers)
or switches using power electronic devices.

1 Open the power_gui example model.
2 To simulate a line energization, add a Breaker block from the Simscape > Electrical >

Specialized Power Systems > Fundamental Blocks > Elements library to the model and set
the parameters as follows:.

Breaker resistance Ron (Ohm) 0.001 Ω
Initial status 0 (open)
Snubber resistance Rs (Ohm) inf
Snubber capacitance Cs (F) 0
Switching times [(1/60)/4]

3 Insert the Breaker block in series with the sending end of the line, then rearrange the circuit as
shown in the figure.
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4 Right-click the two lines that connect to the Scope 1 block and select Properties. In the dialog
box, select Log signal data for the two signals and click OK. From the Simulation Data
Inspector, select Send Logged Workspace Data to Data Inspector.

5 Open the 150 km Line block dialog box and set the number of sections to 1. Start the
simulation.

6 Open the 150 km Line block dialog box and change the number of sections from 1 to 10. Start
the simulation.

7 Add a Distributed Parameters Line block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Elements library. Set the number of phases to 1 and use
the same R, L, C, and length parameters as the 150 km Line block. Delete the 150 km Line
block and replace it with the Distributed Parameters Line block. Start the simulation.

8 Compare the three waveforms obtained from the three line models. Open the Simulation Data
Inspector. Select the Ub1 and Ub2 signals of Run 1, the Ub2 signals of Run 2, and Run 3.

A zoom on these waveforms is shown in the next figure. As expected from the frequency analysis
performed during “Analyze a Simple Circuit” on page 1-10, the single PI model does not respond to
frequencies higher than 229 Hz. The 10 PI section model gives better accuracy, although high-
frequency oscillations are introduced by the discretization of the line. You can clearly see the
propagation time delay of 1.03 ms associated with the distributed parameter line.

1 Getting Started

1-20



Receiving End Voltage Obtained with Three Different Line Models

Discretizing the Electrical System
An important product feature is its ability to simulate either with continuous, variable step
integration algorithms or with discrete solvers. For small systems, variable time step algorithms are
usually faster than fixed step methods, because the number of integration steps is lower. For large
systems that contain many states or many nonlinear blocks such as power electronic switches,
however, it is advantageous to discretize the electrical system.

When you discretize your system, the precision of the simulation is controlled by the time step. If you
use too large a time step, the precision might not be sufficient. The only way to know if it is
acceptable is to repeat the simulation with different time steps and find a compromise for the largest
acceptable time step. Usually time steps of 20 µs to 50 µs give good results for simulation of
switching transients on 50-Hz or 60-Hz power systems or on systems using line-commutated power
electronic devices such as diodes and thyristors. You must reduce the time step for systems using
forced-commutated power electronic switches. These devices, the insulated-gate bipolar transistor
(IGBT), the field-effect transistor (FET), and the gate-turnoff thyristor (GTO) are operating at high
switching frequencies.

For example, simulating a pulse-width-modulated (PWM) inverter operating at 8 kHz would require a
time step of at most 1 µs.
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1 Open the power_3level example. In the Powergui block, note that the Simulation type is set to
Discrete and the sample time is set to 1e-6 s by the Ts variable defined in the Model
Properties. Run a first simulation.

2 To perform a continuous simulation, open the Powergui block parameters dialog box and set
Simulation type to Continuous. Select the ode23tb variable-step solver in the
Configuration Parameters dialog box. Simulate the model.

3 In the Powergui block, set Simulation type to Discrete. In the InitFcn model callback
section of the Model Properties, specify Ts = 20e-6. Run the simulation.

4 Open the Simulation Data Inspector and compare the differences on the high-frequency
transients.

The 1 µs compares reasonably well with the continuous simulation. However, increasing the time step
to 20 µs produces appreciable errors. The 1 µs time step would therefore be acceptable for this
circuit, while obtaining a gain on simulation speed.
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Introducing the Phasor Simulation Method
In this section...
“Introduction” on page 1-23
“When to Use the Phasor Solution” on page 1-23
“Continuous and Discrete Phasor Solutions” on page 1-23
“Continuous Phasor Simulation of a Circuit Transient” on page 1-24

Introduction
In this section, you

• Apply the phasor simulation method to a simple linear circuit
• Learn advantages and limitations of this method

Up to now you have used two methods to simulate electrical circuits:

• Simulation with variable time steps using the continuous Simulink solvers
• Simulation with fixed time steps using a discretized system

This section explains how to use a third simulation method, the phasor solution method.

When to Use the Phasor Solution
The phasor solution method is mainly used to study electromechanical oscillations of power systems
consisting of large generators and motors. An example of this method is the simulation of a
multimachine system in “Three-Phase Systems and Machines” on page 2-17. However, this
technique is not restricted to the study of transient stability of machines. It can be applied to any
linear system.

If, in a linear circuit, you are interested only in the changes in magnitude and phase of all voltages
and currents when switches are closed or opened, you do not need to solve all differential equations
(state-space model) resulting from the interaction of R, L, and C elements. You can instead solve a
much simpler set of algebraic equations relating the voltage and current phasors. This is what the
phasor solution method does. As its name implies, this method computes voltages and currents as
phasors. Phasors are complex numbers representing sinusoidal voltages and currents at a particular
frequency. They can be expressed either in Cartesian coordinates (real and imaginary) or in polar
coordinates (amplitude and phase). As the electrical states are ignored, the phasor solution method
does not require a particular solver to solve the electrical part of your system. The simulation is
therefore much faster to execute. Keep in mind, however, that this faster solution technique gives the
solution only at one particular frequency.

Continuous and Discrete Phasor Solutions
In the Simulation type parameter of a Powergui block, you can choose one of two simulation
methods. Phasor specifies a continuous phasor solution using a Simulink variable-step solver (such as
ode23tb). Discrete phasor uses a local solver to discretize and solve the phasor model at a specified
sample time. The discrete phasor simulation method allows you to use Simulink Coder™ to generate
code and simulate your model in real time.
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Contrary to the continuous phasor solver, which uses a full set of machine differential equations for
modelling stator and rotor transients, the discrete phasor solver uses simplified three-phase
synchronous and asynchronous machine models where differential equations on the stator side are
replaced with algebraic equations. These lower-order machine models eliminate two states (the phid
and phiq stator fluxes) to produce simulation results similar to commercial stability software.

Because of this simplification, high-frequency variations of electromagnetic torque and speed due to
the DC components of transient stator currents are ignored, resulting in cleaner waveforms that are
identical to those obtained with stability software. For stability studies of multi-machine systems
involving low frequency electromechanical oscillations (typically in the 0.1–2 Hz range), the discrete
phasor solver will produce accurate frequency and voltage variations with sample times in the 2–8 ms
range, but which may differ slightly from those obtained with the continuous phasor solver. For
models containing no machines, the phasor and discrete phasor solvers will produce identical results.

The larger sample times allowed for the discrete phasor solver allows you to simulate much larger
systems than with the discrete solver (when the Simulation type parameter is set to Discrete).
The discrete phasor solver has also several additional advantages:

• It uses a robust solution method that allows it to eliminate machine parasitic loads.

• It eliminates voltage glitches that occur with the continuous phasor solver during fault clearing
because small time constants are used in machine models to break algebraic loops.

• It simulates multi-machine systems faster than the continuous phasor solver.

• It allows you to use Simulink Coder to generate code and simulate your model in real time. With
the continuous phasor solver, real-time simulation works only if the model contains no machines.

Continuous Phasor Simulation of a Circuit Transient
You now apply the phasor solution method to a simple linear circuit. Open the example named
Transient Analysis of a Linear Circuit (power_transient).

This circuit is a simplified model of a 60 Hz, 230-kV three-phase power system where only one phase
is represented. The equivalent source is modeled by a voltage source (230 kV RMS / sqrt(3) or 132.8
kV RMS, 60 Hz) in series with its internal impedance (Rs Ls). The source feeds an RL load through a
150-km transmission line modeled by a single PI section (RL1 branch and two shunt capacitances, C1
and C2). A circuit breaker is used to switch the load (75 MW, 20 Mvar) at the receiving end of the
transmission line. Two measurement blocks are used to monitor the load voltage and current.

The Powergui block at the lower-left corner indicates that the model is continuous. Select the I_load
and V_line signals. From the Simulation Data Inspector, select Log Selected Signals. Start the
simulation and observe transients in voltage and current waveforms when the load is first switched
off at t = 0.0333 s (2 cycles) and switched on again at t = 0.1167 s (7 cycles).

Invoking the Phasor Solution in the Powergui Block

You now simulate the same circuit using the phasor simulation method. This option is accessible
through the Powergui block. Open the Powergui block. Set the Simulation type parameter to
Phasor. Specify the frequency used to solve the algebraic network equations. A default value of 60
Hz should already be entered in the Frequency (Hz) field. Close the Powergui and notice that the
words Phasor 60 Hz now appear on the Powergui icon, indicating that the Powergui now applies
this method to simulate your circuit. Before restarting the simulation, specify the appropriate format
for the two signals sent to the Scope block.
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Selecting Phasor Signal Measurement Formats

If you now double-click the Voltage Measurement block or the Current Measurement block, you see
that the Output Signal parameter allows you to output phasor signals in four different formats:
Complex (default choice), Real-Imag, Magnitude-Angle, or just Magnitude. The Complex
format is useful when you want to process complex signals. Note that the Scope block does not
accept complex signals. Select Magnitude format for both the Line Voltage and the Load Current
Measurement blocks. This allows you to observe the magnitude of the voltage and current phasors.

Restart the simulation. Open the Simulation Data Inspector. Waveforms obtained from the continuous
simulation and the phasor simulation are superimposed in this plot.

Waveforms Obtained with the Continuous and Phasor Simulation Methods

Note that with continuous simulation, the opening of the circuit breaker occurs at the next zero
crossing of current following the opening order; whereas for the phasor simulation, this opening is
instantaneous. This is because there is no concept of zero crossing in the phasor simulation.

 Introducing the Phasor Simulation Method

1-25



Processing Voltage and Current Phasors

To use the Discrete phasor solution method, open the powergui block and set Simulation type to
Discrete phasor. Set Sample time (s) to 1e-3 sec. Run the simulation. The voltage and current
magnitude waveforms should compare with the continuous phasor model, except that the resolution
for the breaker switching times is now 1 ms.

The Complex format allows the use of complex operations and processing of phasors without
separating real and imaginary parts. Suppose, for example, that you need to compute the power
consumption of the load (active power P and reactive power Q). The complex power S is obtained
from the voltage and current phasors as

S = P + jQ = 1
2 ⋅ V ⋅ I

∗

where I* is the conjugate of the current phasor. The 1/2 factor is required to convert magnitudes of
voltage and current from peak values to RMS values.

Select the Complex format for both current and voltage and, using blocks from the Simulink Math
library, implement the power measurement as shown.

Power Computation Using Complex Voltage and Current

The Complex to Magnitude-Angle blocks are required to convert complex phasors to magnitudes
before sending them to the scope.

Note that the Power (phasor) block available in the Specialized Power Systems > Control &
Measurements > Measurementslibrary implements the above complex equation for measuring
active power (P) and reactive power (Q). Connect the complex outputs of the voltage and current
measurement blocks to the V and I inputs of the Power (phasor) block.
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Advanced Components and Techniques

This chapter introduces methods and devices that enhance your power system simulations and make
them more realistic.

The first two tutorials illustrate power electronics, simple motors, and Fourier analysis. The third
tutorial demonstrates three-phase power systems, electrical machinery, load flow, and use of the
phasor solution method for transient stability studies of electromechanical systems. The fourth
explains how you can create and customize your own nonlinear blocks.

• “Introducing Power Electronics” on page 2-2
• “Simulate Variable Speed Motor Control” on page 2-8
• “Three-Phase Systems and Machines” on page 2-17
• “Building and Customizing Simscape Electrical Specialized Power Systems Models” on page 2-37
• “Building a Model Using Model Construction Commands” on page 2-45
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Introducing Power Electronics
In this section...
“Introduction” on page 2-2
“Simulation of the TCR Branch” on page 2-3
“Simulation of the TSC Branch” on page 2-5

Introduction
In this section you

• Learn how to use power electronics components
• Learn how to use transformers
• Change initial conditions of a circuit

Simscape Electrical Specialized Power Systems software is designed to simulate power electronic
devices. This section uses a simple circuit based on thyristors as the main example.

Consider the circuit shown below. It represents one phase of a static var compensator (SVC) used on
a 735 kV transmission network. On the secondary of the 735 kV/16 kV transformer, two variable
susceptance branches are connected in parallel: one thyristor-controlled reactor (TCR) branch, in
blue, and one thyristor-switched capacitor (TSC) branch, in red.
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One Phase of a TCR/TSC Static Var Compensator

The TCR and TSC branches are both controlled by a valve consisting of two thyristor strings
connected in antiparallel. An RC snubber circuit is connected across each valve. The TSC branch is
switched on/off, thus providing discrete step variation of the SVC capacitive current. The TCR branch
is phase controlled to obtain a continuous variation of the net SVC reactive current.

Simulation of the TCR Branch
1 Enter power_new at the command line to open a new model. Save it as power_TCRTSC.
2 Add a Thyristor block from the Simscape > Electrical > Specialized Power Systems >

Fundamental Blocks > Power Electronics library to the model.
3 Open the Thyristor Block Parameters window and set the parameters as follows:

Ron 1e-3
Lon 0
Vf 14*0.8
Rs 500
Cs 0.15e-6

Notice that the snubber circuit is integral to the Thyristor dialog box.
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4 Rename this block TCR 1 and duplicate it.
5 Connect this new thyristor TCR 2 in antiparallel with TCR 1, as shown in “One Phase of a

TCR/TSC Static Var Compensator” on page 2-3.

As the snubber circuit has already been specified with TCR 1, the snubber of TCR 2 must be
eliminated.

6 Open the TCR 2 dialog box and set the snubber parameters to

Rs Inf
Cs 0

Notice that the snubber disappears on the block icon.
7 Add a Linear Transformer block from the Simscape > Electrical > Specialized Power

Systems > Fundamental Blocks > Elements library. Set its nominal power, frequency, and
winding parameters (winding 1 = primary; winding 2 = secondary) as shown in “One Phase
of a TCR/TSC Static Var Compensator” on page 2-3.

The Units parameter allows you to specify the resistance R and leakage inductance L of each
winding as well as the magnetizing branch Rm/Lm, either in SI units (ohms, henries) or in per
units (pu). Keep the default pu setting to specify directly R and L in per unit quantities. As there
is no tertiary winding, deselect Three windings transformer. Winding 3 disappears on the TrA
block.

Finally, set the magnetizing branch parameters Rm and Xm at [500, 500]. These values
correspond to 0.2% resistive and inductive currents. For more information on the per unit (pu)
system, see “Per-Unit System of Units”.

8 Add a voltage source, Ground block, and two Series RLC Branch blocks and set the parameters
as shown in the One Phase of a TCR/TSC Static Var Compensator figure.

9 Add a Current Measurement block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Measurements library to measure the primary current.

10 Notice that the Thyristor blocks have an output identified by the letter m. This output returns a
Simulink vectorized signal containing the thyristor current (Iak) and voltage (Vak). These outputs
are connected to terminators blocks. Select the signal line connected at the m output of the TCR
1 block and the signal connected at the i output of the i prim block. From the Simulation Data
Inspector, select Log Selected Signals.

11 Copy two Pulse Generator blocks into your system, name them Pulse1 and Pulse2, and connect
them to the gates of the thyristor blocks.

12 Now you have to define the timing pulses of the two thyristors. At every cycle a pulse has to be
sent to each thyristor α degrees after the zero crossing of the thyristor commutation voltage. Set
the Pulse1 and Pulse2 block parameters as follows:

Amplitude 1
Period 1/60 s
Pulse width (% of period) 1% (3.6 degrees pulses)
Phase Delay 1/60+T for Pulse1

1/60+1/120+T for Pulse2
13 The pulses sent to TCR 2 are delayed by 180 degrees with respect to pulses sent to TCR 1. The

delay T is used to specify the firing angle α. To get a 120 degree firing angle, specify T in the
workspace by entering
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T = 1/60/3;
14 Set the stop time to 0.1, then start the simulation. The results can be observed in the Simulation

Data Inspector, as shown in the figure.

TCR Simulation Results

Simulation of the TSC Branch
You can now create the TSC branch.

1 Duplicate the TCR branch (shown in blue), rename the blocks, and specify resistance and
inductance value as shown in the “One Phase of a TCR/TSC Static Var Compensator” on page 2-3
figure.

2 Connect a capacitor of 308e-6 Farad in series with the TSC 1 and TSC 2 valve.
3 Connect a Voltage Measurement block across the capacitor. Connect the output of the block to a

terminator block. Select the signal and stream the selected signal to the Simulation Data
Inspector.

4 Contrary to the TCR branch, which was fired by a synchronous pulse generator, a continuous
firing signal is now applied to the two thyristors. Delete the two pulse generators. Add a Step
block and connect its output at both gates of TSC 1 and TSC 2. Set its step time at 1/60/4
(energizing at the first positive peak of the source voltage).

5 Start the simulation.

As the capacitor is energized from zero, you can observe in the Simulation Data Inspector a
low damping transient at 200 Hz, superimposed with the 60 Hz component in the capacitor
voltage and primary current. During normal TSC operation, the capacitor has an initial voltage
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left since the last valve opening. To minimize the closing transient with a charged capacitor, the
thyristors of the TSC branch must be fired when the source voltage is at maximum value and
with the correct polarity. The initial capacitor voltage corresponds to the steady-state voltage
obtained when the thyristor switch is closed. The capacitor voltage is 17.67 kVrms when the
valve is conducting. At the closing time, the capacitor must be charged at the peak voltage.

Uc = 17670 × 2 = 24989 V
6 Double-click the powergui block, and in the Tools tab, click Initial State. A list of all the state

variables with their default initial values appears. The value of the initial voltage across the
capacitor C (variable Uc_C) should be -0.3141 V. This voltage is not exactly zero because the
snubber allows circulation of a small current when both thyristors are blocked. Now select the
Uc_C state variable and enter 24989 in the upper right field. Then click the Apply button to
make this change effective.

7 Start the simulation. As expected the transient component of capacitor voltage and current has
disappeared. The voltages obtained with and without initial voltage are compared in the
Simulation Data Inspector as shown in the figure.
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Transient Capacitor Voltage With and Without Initial Charge
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Simulate Variable Speed Motor Control
In this section...
“Building and Simulating the PWM Motor Drive” on page 2-8
“Using the Multimeter Block” on page 2-13
“Discretizing the PWM Motor Drive” on page 2-14
“Performing Harmonic Analysis Using the FFT Tool” on page 2-15

Variable speed control of AC electrical machines makes use of forced-commutated electronic switches
such as IGBTs, MOSFETs, and GTOs. Asynchronous machines fed by pulse width modulation (PWM)
voltage sourced converters (VSC) are nowadays gradually replacing the DC motors and thyristor
bridges. With PWM, combined with modern control techniques such as field-oriented control or direct
torque control, you can obtain the same flexibility in speed and torque control as with DC machines.
This tutorial shows how to build a simple open loop AC drive controlling an asynchronous machine.
Simscape Electrical Specialized Power Systems contains a library of prebuilt models that enable you
to simulate electric drives systems without the need to build those complex systems yourself. For
more information about this library, see “Electric Drives Library” on page 4-2.

The Simscape > Electrical > Specialized Power Systems > Fundamental Blocks > Machines
library contains four of the most commonly used three-phase machines: simplified and complete
synchronous machines, asynchronous machine, and permanent magnet synchronous machine. Each
machine can be used either in generator or motor mode. Combined with linear and nonlinear
elements such as transformers, lines, loads, breakers, etc., they can be used to simulate
electromechanical transients in an electrical network. They can also be combined with power
electronic devices to simulate drives.

The Simscape > Electrical > Specialized Power Systems > Fundamental Blocks > Power
Electronics library contains blocks allowing you to simulate diodes, thyristors, GTO thyristors,
MOSFETs, and IGBT devices. You could interconnect several blocks together to build a three-phase
bridge. For example, an IGBT inverter bridge would require six IGBTs and six antiparallel diodes.

To facilitate implementation of bridges, the Universal Bridge block automatically performs these
interconnections for you.

Building and Simulating the PWM Motor Drive
Follow these steps to build a model of a PWM-controlled motor.
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Assembling and Configuring the Model

1 Type power_new at the command line to open a new model. Save the model as
power_PWMmotor

2 Add a Universal Bridge block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Power Electronics library

3 In the Parameters settings for the Universal Bridge block, set the Power Electronic device
parameter to IGBT /Diodes.

4 Add an Asynchronous Machine SI Units block from the Simscape > Electrical > Specialized
Power Systems > Fundamental Blocks > Machines library

5 Set the parameters of the Asynchronous Machine SI Units block as follows.

Settings Parameter Value  
Configuration Rotor type Squirrel-cage  
Parameters Nominal power,

voltage (line-line),
and frequency
[ Pn(VA), Vn(Vrms),
fn(Hz) ]

[3*746 220 60]  

Stator resistance
and inductance
[ Rs(ohm) Lls(H) ]

[1.115 0.005974]  

Rotor resistance
and inductance
[ Rr'(ohm) Llr'(H) ]

[1.083 0.005974]  
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Settings Parameter Value  
Mutual inductance
Lm (H)

0.2037  

Inertia, friction
factor, pole pairs
[ J(kg.m^2)
F(N.m.s) p() ]

[0.02 0.005752 2]  

[slip, th(deg),
ia,ib,ic(A), pha,
phb, phc(deg)]

[1 0 0 0 0 0 0 0]  

Setting the nominal power to 3*746 VA and the nominal line-to-line voltage Vn to 220 Vrms
implements a 3 HP, 60 Hz machine with two pairs of poles. The nominal speed is therefore
slightly lower than the synchronous speed of 1800 rpm, or ws = 188.5 rad/s.

Setting the Rotor type parameter to Squirrel-cage, hides output ports, a, b, and c, because
these three rotor terminals are typically short-circuited together for normal motor operation.

6 Access internal signals of the Asynchronous Machine block:

a Add a Bus Selector block from the Simulink > Signal Routing library.
b Connect the measurement output port, m, of the machine block to the input port of the Bus

Selector block.
c Open the Block Parameters dialog box for the Bus Selector block. Double-click the block.
d Remove the preselected signals. In the Selected elements pane, Shift select ??? signal1

and ??? signal2, then click Remove.
e Select the signals of interest:

i In the left pane of the dialog box, select Stator measurements > Stator current is_a
(A). Click Select>>.

ii Select Mechanical > Rotor speed (wm). Click Select>>.
iii Select Electromagnetic torque Te (N*m). Click Select>>.

Loading and Driving the Motor

Implement the torque-speed characteristic of the motor load. Assuming a quadratic torque-speed
characteristic (fan or pump type load)., the torque T is proportional to the square of the speed ω.

T = k × ω2

The nominal torque of the motor is

Tn = 3 × 746
188.5 = 11.87 Nm

Therefore, the constant k should be

k =
Tn
ω2 = 11.87

188.52 = 3.34 × 10−4
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1 Add an Interpreted MATLAB Function block from the Simulink > User-Defined Functions
library. Double-click the function block, and enter the expression for torque as a function of
speed: 3.34e-4*u^2.

2 Connect the output of the function block to the torque input port, Tm, of the machine block.
3 Add a DC Voltage Source block from the Simscape > Electrical > Specialized Power Systems

> Fundamental Blocks > Electrical Sources library. In the Parameters settings for the block,
for the Amplitude (V) parameter, specify 400.

4 Change the name of the Voltage Measurement block to VAB.
5 Add a Ground block from the Simscape > Electrical > Specialized Power Systems >

Fundamental Blocks > Elements library. Connect the power elements and voltage sensor
blocks as shown in the diagram of the power_PWMmotor model.

Controlling the Inverter Bridge with a Pulse Generator

To control the inverter bridge, use a pulse generator.

1 Add a PWM Generator (2-Level) block from the Simscape > Electrical > Specialized Power
Systems > Control & Measurements > Pulse & Signal Generators library. You can configure
the converter to operate in an open loop, and the three PWM modulating signals are generated
internally. Connect the P output to the pulses input of the Universal Bridge block

2 Open the PWM Generator (2-Level) block dialog box and set the parameters as follows.

Generator type Three-phase bridge (6 pulses)
Mode of operation Unsynchronized
Frequency 18*60Hz (1080 Hz)
Initial Phase 0 degrees
Minimum and maximum values [-1,1]
Sampling technique Natural
Internal generation of reference signal selected
Modulation index 0.9
Reference signal frequency 60 Hz
Reference signal phase 0 degrees
Sample time 10e-6 s

3 The block has been discretized so that the pulses change at multiples of the specified time step.
A time step of 10 µs corresponds to +/- 0.54% of the switching period at 1080 Hz.

One common method of generating the PWM pulses uses comparison of the output voltage to
synthesize (60 Hz in this case) with a triangular wave at the switching frequency (1080 Hz in this
case). The line-to-line RMS output voltage is a function of the DC input voltage and of the
modulation index m as given by the following equation:

VLLrms = m
2 × 3

2Vdc = m × 0.612 × VDC

Therefore, a DC voltage of 400 V and a modulation factor of 0.90 yield the 220 Vrms output line-
to-line voltage, which is the nominal voltage of the asynchronous motor.
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Displaying Signals and Measuring Fundamental Voltage and Current

1 You now add blocks measuring the fundamental component (60 Hz) embedded in the chopped
Vab voltage and in the phase A current. Add a Fourier block from the Simscape > Electrical >
Specialized Power Systems > Control & Measurements > Measurementslibrary to your
model.

Open the Fourier block dialog box and check that the parameters are set as follows:

Fundamental frequency 60 Hz
Harmonic n 1
Initial input [0 0]
Sample time 10e-6 s

Connect this block to the output of the Vab voltage sensor.
2 Duplicate the Fourier block. To measure the phase A current, you connect this block to the

Stator current is_a output of the Bus selector block.
3 Stream these signals to the Simulation Data Inspector: the Te, ias, and w signals of the

measurement output of the Asynchronous Machine block, and the VAB voltage.

Simulating the PWM Motor Drive with Continuous Integration Algorithm

Set the stop time to 1 s and start the simulation. Open the Simulation Data Inspector and look at
the signals.

The motor starts and reaches its steady-state speed of 181 rad/s (1728 rpm) after 0.5 s. At starting,
the magnitude of the 60 Hz current reaches 90 A peak (64 A RMS) whereas its steady-state value is
10.5 A (7.4 A RMS). As expected, the magnitude of the 60 Hz voltage contained in the chopped wave
stays at

220 × 2 = 311 V

Also notice strong oscillations of the electromagnetic torque at starting. If you zoom in on the torque
in steady state, you should observe a noisy signal with a mean value of 11.9 N.m, corresponding to
the load torque at nominal speed.

If you zoom in on the three motor currents, you can see that all the harmonics (multiples of the 1080
Hz switching frequency) are filtered by the stator inductance, so that the 60 Hz component is
dominant.
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PWM Motor Drive; Simulation Results for Motor Starting at Full Voltage

Using the Multimeter Block
The Universal Bridge block is not a conventional subsystem where all the six individual switches are
accessible. If you want to measure the switch voltages and currents, you must use the Multimeter
block, which gives access to the bridge internal signals:

1 Open the Universal Bridge dialog box and set the Measurement parameter to Device
currents.

2 Add a Multimeter block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Measurements library Double-click the Multimeter block. A window
showing the six switch currents appears.

3 Select the two currents of the bridge arm connected to phase A. They are identified as

iSw1 Universal Bridge
iSw2 Universal Bridge

4 Click Close. The number of signals (2) is displayed in the Multimeter icon.
5 Send the signal from the Multimeter block to the Simulation Data Inspector.
6 Restart the simulation. The waveforms obtained for the first 20 ms are shown in this plot.
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Currents in IGBT/Diode Switches 1 and 2

As expected, the currents in switches 1 and 2 are complementary. A positive current indicates a
current flowing in the IGBT, whereas a negative current indicates a current in the antiparallel diode.

Note Multimeter block use is not limited to the Universal Bridge block. Many blocks of the Electrical
Sources and Elements libraries have a Measurement parameter where you can select voltages,
currents, or saturable transformer fluxes. A judicious use of the Multimeter block reduces the number
of current and voltage sensors in your circuit, making it easier to follow.

Discretizing the PWM Motor Drive
You might have noticed that the simulation using a variable-step integration algorithm is relatively
long. Depending on your computer, it might take tens of seconds to simulate one second. To shorten
the simulation time, you can discretize your circuit and simulate at fixed simulation time steps.

In the Simulation tab, click Model Settings. Select Solver. Under Solver selection, select the
Fixed-step and Discrete (no continuous states) options. Open the powergui block and set

2 Advanced Components and Techniques

2-14



Simulation type to Discrete. Set the Sample time to 10e-6 s. The power system, including the
asynchronous machine, is now discretized at a 10 µs sample time.

Start the simulation. Observe that the simulation is now faster than with the continuous system.
Results compare well with the continuous system.

Performing Harmonic Analysis Using the FFT Tool
The two Fourier blocks allow computation of the fundamental component of voltage and current while
simulation is running. If you would like to observe harmonic components also you would need a
Fourier block for each harmonic. This approach is not convenient.

Add a Scope block to your model and connect it at the output of the VAB Voltage Measurement block.
In the Scope block, log data to workspace as a structure with time. Start the simulation. Now use the
FFT tool of powergui to display the frequency spectrum of voltage and current waveforms.

When the simulation is complete, open the powergui and select FFT Analysis. A new window opens.
Set the parameters specifying the analyzed signal, the time window, and the frequency range as
follows:

Name ScopeData
Input input 1
Signal number 1
Start time 0.7 s
Number of cycles 2
Display FFT window
Fundamental frequency 60 Hz
Max frequency 5000 Hz
Frequency axis Harmonic order
Display style Bar (relative to Fund or DC)

The analyzed signal is displayed in the upper window. Click Display. The frequency spectrum is
displayed in the bottom window, as shown in the next figure.
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FFT Analysis of the Motor Line-to-Line Voltage

The fundamental component and total harmonic distortion (THD) of the Vab voltage are displayed
above the spectrum window. The magnitude of the fundamental of the inverter voltage (312 V)
compares well with the theoretical value (311 V for m=0.9).

Harmonics are displayed in percent of the fundamental component. As expected, harmonics occur
around multiples of carrier frequency (n*18 +- k). Highest harmonics (30%) appear at 16th harmonic
(18 - 2) and 20th harmonic (18 + 2).
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Three-Phase Systems and Machines
In this section...
“Introduction” on page 2-17
“Three-Phase Network with Electrical Machines” on page 2-17
“Machine Initialization Tool” on page 2-18
“Load Flow Tool” on page 2-20
“Using the Phasor Solution Method for Stability Studies” on page 2-33

Introduction
In this section you

• Learn how to simulate a three-phase power system containing electrical machines and other
three-phase models

• Perform a load flow study and initialize machines to start simulation in steady state by using the
Machine Initialization and Load Flow tools (positive-sequence load flow and unbalanced load flow)
of the powergui block.

• Simulate the power system and observe its dynamic performance by using and comparing results
of the Continuous and Phasor Simscape Electrical Specialized Power Systems simulation types
(continuous and discrete).

You now use three types of machines in the Simscape > Electrical > Specialized Power Systems
> Fundamental Blocks > Machines library: simplified synchronous machines, detailed
synchronous machines, and asynchronous machines. You interconnect these machines with linear and
nonlinear elements such as transformers, loads, and breakers to study the transient stability of an
uninterruptible power supply using a diesel generator.

Three-Phase Network with Electrical Machines
The two-machine system shown in this single line diagram is this section's main example:

Diesel Generator and Asynchronous Motor on Distribution Network

This system consists of a plant (bus B2), simulated by a 1 MW resistive load and a motor load (ASM)
fed at 2400 V from a distribution 25 kV system through a 6 MVA, 25/2.4 kV transformer, and from an
emergency synchronous generator/diesel engine unit (SM).
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The 25 kV system is modeled by a simple R-L equivalent source (short-circuit level 1000 MVA, quality
factor X/R = 10) and a 5 MW load. The asynchronous motor is rated 2250 HP, 2.4 kV, and the
synchronous machine is rated 3.125 MVA, 2.4 kV.

Initially, the motor develops a mechanical power of 2000 HP and the diesel generator is in standby,
delivering no active power. The synchronous machine therefore operates as a synchronous condenser
generating only the reactive power required to regulate the 2400 V bus B2 voltage at 1.0 pu. At t =
0.1 s, a three-phase to ground fault occurs on the 25 kV system, causing the opening of the 25 kV
circuit breaker at t = 0.2 s, and a sudden increase of the generator loading. During the transient
period following the fault and islanding of the motor-generator system, the synchronous machine
excitation system and the diesel speed governor react to maintain the voltage and speed at a constant
value.

This system is modeled in the power_machines example.

The SM parameters as well as the diesel engine and governor models were taken from reference [1].

If you simulate this system for the first time, you normally do not know what the initial conditions are
for the SM and ASM to start in steady state.

These initial conditions are

• SM block: Initial values of speed deviation (usually 0%), rotor angle, magnitudes and phases of
currents in stator windings, and initial field voltage required to obtain the desired terminal
voltage under the specified load flow

• ASM block: Initial values of slip, rotor angle, magnitudes and phases of currents in stator
windings

Open the dialog box of the Synchronous Machine and Asynchronous Machine blocks. All initial
conditions should be set at 0, except for the initial SM field voltage and ASM slip, which are set at 1
pu. Open the three scopes monitoring the SM and ASM signals as well as the bus B2 voltage. Start
the simulation and observe the first 100 ms before fault is applied.

As the simulation starts, note that the three ASM currents start from zero and contain a slowly
decaying DC component. The machine speeds take a much longer time to stabilize because of the
inertia of the motor/load and diesel/generator systems. In our example, the ASM even starts to rotate
in the wrong direction because the motor starting torque is lower than the applied load torque. Stop
the simulation.

References

[1] Yeager K.E. and Willis J.R. "Modeling of Emergency Diesel Generators in an 800 Megawatt
Nuclear Power Plant." IEEE Transactions on Energy Conversion. Vol.8, No.3, September
1993.

Machine Initialization Tool
To start the simulation in steady state with sinusoidal currents and constant speeds, all the machine
states must be initialized properly. This is a difficult task to perform manually, even for a simple
system. In the next section you learn how to use the Machine Initialization tool of the powergui
block to initialize the machines.
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1 In the Tools tab of the powergui block dialog box click the Machine Initialization button. A
new window appears. The upper-right window displays a list of the machines appearing in your
system.

2 Select SM 3.125 MVA in the machine list. The Bus Type parameter should already be initialized
as P & V generator, indicating that the machine is controlling its active power and terminal
voltage. For more info on the meaning of the Bus type parameter see “Load Flow Tool” on page
2-20.

3 Check that the desired Terminal Voltage UAB is initialized at the nominal machine voltage
(2400 Vrms).

4 Set the Active Power to zero. The synchronous machine therefore absorbs or generates reactive
power only to keep terminal voltage at 1 pu.

5 Select ASM 2250 HP in the machine list. The only parameter that needs to be set is the
Mechanical power developed by the motor. Enter 1.492e6 (2000 HP = 2000*746 watts).

6 Click the Compute and Apply button. The three phasors of line-to-line machine voltages, as well
as currents, are updated as shown on the next figure. Values are displayed both in SI units (volts
RMS or amperes RMS) and in pu.

The Machine info section displays the SM active and reactive powers, mechanical power, and
field voltage, the ASM active and reactive powers absorbed by the motor, slip, and torque.

7 Close the Machine Initialization tool.
8 Open the SM and ASM block dialogs and see that the initial conditions have been updated. Note

that the ASM torque value (7964 N.m) has been entered in the Constant block connected at the
ASM torque input.

9 Double-click the Diesel Engine Governor block. The initial mechanical power is set to 0.0002701
pu.
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10 Open the Excitation block. Double-click the AC1A Excitation System block and select the Initial
Values tab. The initial terminal voltage and field voltage are set to 1.0 pu and 1.427 pu,
respectively.

11 The Machine Initialization tool also initializes the Constant blocks connected at the reference
inputs (wref and vref) of the Governor and Excitation blocks, as well as the Constant block
connected at the load torque input (Tm) of the Asynchronous Machine block.

12 Start the simulation. Open the three scopes displaying the internal signals of synchronous and
asynchronous machines and phase A voltage. The simulation starts in steady state.

Note To initialize machines, you can use the Load Flow tool instead of the Machine Initialization tool.
The Load Flow tool allows you to display a more detailed load flow solution.

Load Flow Tool
The Load Flow tool of the powergui block uses the Newton-Raphson method and comes with a user
interface that allows you to display load flow solution at all buses.

Simscape Electrical Specialized Power Systems allows you to perform two types of load flows:

• Positive-sequence load flow applied to a three-phase system. Positive-sequence voltages as well as
active power (P) and reactive power (Q) flows are computed at each three-phase bus.

• Unbalanced load flow applied to a mix of three-phase, two-phase, and single-phase systems.
Individual phase voltage and PQ flow are computed for each phase.

For more information, see power_loadflow.

To solve a load flow, you need to determine these four quantities at each three-phase or single-phase
bus:

• The net active power P and reactive power Q injected into the bus
• The voltage magnitude V and angle Vangle of bus positive-sequence voltage (positive-sequence

voltage or phase voltage)

Bus Types

It is important that you understand the three bus types that are used by the Load Flow tool to solve a
load flow. Before solving the load flow, two of the above quantities are known at every bus and the
other two are to be determined. Therefore, the following bus types are used:

• PV bus—For this type of bus, specify P and V. This is the generation bus where a generator such
as a voltage source or three-phase synchronous machine is connected. Active power P is
generated and generator terminal voltage V is imposed. The load flow solution returns the
machine reactive power Q, required to maintain the reference voltage magnitude V, and the
reference voltage angle Vangle.

• PQ bus — At this bus, specified active power P and reactive power Q are either injected into the
bus (generation PQ bus) or absorbed by a load connected at that bus. The load flow solution
returns bus voltage magnitude V and angle Vangle.

• Swing bus—This bus imposes voltage magnitude V and angle Vangle. The load flow solution
returns the active power P and reactive power Q, generated or absorbed at that bus in order to
balance generated power, loads, and losses. At least one bus in the model must be defined as a
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swing bus, but usually a single swing bus is required unless you have isolated networks. Normally
for a positive-sequence load flow, you select one synchronous machine or voltage source as a
swing bus. For an unbalanced load flow, you can select the three phases of a Three-Phase Voltage
Source block or single-phase AC Voltage Source blocks as swing buses.

Performing Load Flow Analysis and Initializing Your Model

To perform a load flow analysis and initialize your model so that it starts in steady state:

1 Define the model buses using Load Flow Bus blocks.
2 Specify the load flow parameters of all blocks having load flow parameters. These blocks are

referred to as load flow blocks.
3 Solve the load flow and, eventually, interactively modify the load flow parameters until a

satisfactory solution is obtained.
4 Save the load flow parameters and machine initial conditions in the model.

The load flow blocks and the Load Flow Bus block are described in the next sections.

Load Flow Blocks for Positive-Sequence Load Flow

Load flow blocks are Simscape Electrical Specialized Power Systems blocks in which you can specify
active power (P) and reactive power (Q) to solve the positive-sequence load flow. They are:

• Asynchronous Machine
• Simplified Synchronous Machine
• Synchronous Machine
• Three-Phase Dynamic Load
• Three-Phase Parallel RLC Load
• Three-Phase Series RLC Load
• Three-Phase Programmable Voltage Source
• Three-Phase Source

You specify P and Q in the Load Flow tab of the block dialog boxes.
Load Flow Parameters of Three-Phase Sources and Synchronous Machines

The Three-Phase Sources and Synchronous Machine blocks allow control of their generated or
absorbed powers P and Q and their positive-sequence terminal voltage. You can specify the generator
bus type as swing, PV, or PQ.
Load Flow Parameters of Asynchronous Machine Blocks

The Asynchronous Machine block requires specification of the mechanical power Pmec at the
machine shaft.
Load Flow Parameters of the RLC Load Blocks

You can specify the Three Phase RLC Load blocks as constant impedance (Z), constant PQ power, or
constant current (I).
Load Flow Parameters of Dynamic Load Blocks

The Three-Phase Dynamic Load block dialog box does not have a Load Flow tab. The load is always
considered as a constant PQ load. P and Q are the initial active and reactive power Po, Qo that you
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specify by using the Active and reactive power at initial voltage parameter. The Initial positive-
sequence voltage Vo parameter (Mag and Phase) updates according to the load flow solution.

Load Flow Blocks for Unbalanced Load Flow

Load flow blocks are Simscape Electrical Specialized Power Systems blocks in which you can specify
active power (P) and reactive power (Q) to solve the load flow at each phase of every bus. They are:

• AC Voltage Source
• Asynchronous Machine
• Parallel RLC Load
• Series RLC Load
• Synchronous Machine
• Three-Phase Dynamic Load
• Three-Phase Parallel RLC Load
• Three-Phase Series RLC Load
• Three-Phase Source

You specify P and Q in the Load Flow tab of the block dialog boxes.

Load Flow Parameters of Single-Phase and Three-Phase Sources

The single-phase AC Voltage Source block allows control of its generated or absorbed powers P and Q
and its terminal voltage. The Three-Phase Source block allows control of generated or absorbed
powers P and Q and terminal voltages for each phase (phase A, B, and C). For these two blocks, you
can specify the generator type as swing, PV, or PQ.

Load Flow Parameters of Synchronous Machine

The Three-Phase Synchronous Machine block allows control of its generated or absorbed powers P
and Q (total of phases A, B, and C) and its positive-sequence terminal voltage. You can specify the
generator type as PV or PQ.

Load Flow Parameters of Asynchronous Machine Blocks

The Asynchronous Machine block requires specification of the mechanical power Pmec developed in
positive-sequence at the machine shaft.

Load Flow Parameters of the RLC Load Blocks

You can specify the single-phase and three-phase RLC Load blocks as constant impedance (Z),
constant PQ power, or constant current (I). You can connect single-phase loads phase-to-ground or
phase-to-phase. You can connect three-phase loads connected in Wye (grounded or floating) or delta.

Load Flow Parameters of Dynamic Load Blocks

The Three-Phase Dynamic Load block dialog box does not have a Load Flow tab. The load is always
considered as a constant PQ load. P and Q are the initial active and reactive power Po, Qo that you
specify by using the Active and reactive power at initial voltage parameter. The Initial positive-
sequence voltage Vo parameter (Mag and Phase) updates according to the load flow solution.

Load Flow Bus Blocks

Use the Load Flow Bus block to define the buses in your model.
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If you perform a positive-sequence load flow, you connect a Load Flow Bus block with the
Connectors parameter specified as single to any phase (A, B, or C) of every load flow block in the
model. When several load flow blocks are connected together at the same nodes, only one Load Flow
Bus block is required to identify the bus.

If you perform an unbalanced load flow, you connect a Load Flow Bus block to all phases of every load
flow block in the model. Depending on the number of phases, you need to specify the appropriate
Connectors parameter by selecting either three connectors (ABC), two connectors (AB, AC, or BC)
or a single connector (A, B, or C). When several load flow blocks are connected together at the same
nodes, only one Load Flow Bus block is required to identify the bus. In the load flow report, each bus
is identified by its Bus identification parameter followed by _a, _b, or _c.

These examples show the use of load flow blocks and Load Flow Bus blocks:

• power_LFnetwork_5busshows a positive-sequence load flow on a five-bus system.
• power_13nodeTestFeeder shows an unbalanced load flow on a 13-bus system (mix of three-

phase, two-phase, and single-phase buses).

Example of Positive-Sequence Load Flow

In the Command window, type power_LFnetwork_5bus to access a model containing five Load Flow
Bus blocks and six load flow blocks.

The Load Flow Bus blocks are shown in orange and the load flow blocks are shown in yellow.
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The Load Flow Bus blocks specify the bus base voltages (nominal phase-to-phase rms voltage). They
also specify the voltage at PV buses or the voltage and angle of the swing buses. Once the load flow is
solved, the Load Flow Bus block displays the bus positive-sequence voltage magnitude and phase
angle as block annotations.

The bus type (PV, PQ, or swing) is determined by the load flow blocks connected to the bus. If you
have several load flow blocks with different types (specified in the Generator type parameter or in
the Load type parameter) connected to the same bus, the Load Flow tool determines the resulting
bus type (swing, PQ, or PV).

In the power_LFnetwork_5bus example, the bus types are determined as follows:

Bus Load Flow Blocks Resulting Bus Type
B120 120 kV Three-Phase Source

- Generator type = swing
swing
V=1.02 p.u. 0 deg.

(Specify voltage and angle in the
B120 Load Flow Bus block.)

B13.8 13.8 kV 150 MVA Synchronous Machine
- Generator type = PV

3 MW 2 Mvar RLC Load
- Load type = constant PQ

PV
P = 117 MW
V = 0.98 pu

(Specify voltage in the B13.8
Load Flow Bus block.)

B25_1 10 MW, 3 Mvar Dynamic Load
- Implicit load type = constant PQ

PQ
P = –10 MW
Q = –3 Mvar

B25_2 No load flow block PQ
P = 0 MW
Q = 0 Mvar

B575 Asynchronous generator 9 MW
1.2 Mvar RLC Load
- Load type = constant Z

PQ
P = 0 MW
Q = 0 Mvar

(Constant Z load is included in
the Ybus admittance matrix.)

Some restrictions apply when you connect several source blocks and synchronous machines at the
same bus:

• Two swing generators cannot be connected in parallel.
• A swing generator cannot be connected in parallel with a PV ideal voltage source.
• When a swing voltage source with RL impedance is connected to a PV generator, the swing bus is

automatically moved to the ideal voltage source connection node, behind the RL source
impedance.

• Only one PV generator with finite Q limits can be connected at a generation bus. However, you
may have other PQ generators and loads connected on the same bus.

For more information on how to use the Load Flow Bus block in your model, see the Load Flow Bus
block reference page.
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Using the Load Flow Tool to Perform Load Flow Analysis

Once you have entered the load flow parameters in the Load Flow Bus blocks and in the various load
flow blocks, open the load flow tool by clicking the Load Flow button of the powergui block. The tool
displays a summary of the load flow data of the model. The table below shows the data found in the
power_LFnetwork_5bus model.

Note that the table contains seven lines, whereas there are only six load flow blocks in the model.
This is because the bus B25_2 is not connected to any load flow block. Line 5 is added in the table for
that particular bus, so that you can see all buses listed together with their bus voltages. This bus will
be considered in the load flow analysis as a PQ bus with zero P and Q.

The first column identifies the block type. The second column displays the bus type of the load flow
blocks. The following four columns give the bus identification label, the bus base voltage, the
reference voltage (in pu of base voltage) and the voltage angle of the load flow bus where the block is
connected. The following columns are the P and Q values specified in the Load Flow tab of the
blocks.

The last five columns display the current load flow solution, as well as the full block name of the load
flow block. For now, the load flow has not yet been performed and the columns display zero values.

The load flow parameters in the Preferences tab of the Powergui are used to build the Ybus network
admittance matrix and to solve the load flow. The base power is used to specify units of the
normalized Ybus matrix in pu/Pbase and bus base voltages. The power_LFnetwork_5bus model

 Three-Phase Systems and Machines

2-25



contains five buses; consequently, the Ybus matrix will be a 5x5 complex matrix evaluated at the
frequency specified by the Frequency (Hz) parameter.

The load flow algorithm uses an iterative solution based on the Newton-Raphson method. The Max
iterations parameter defines the maximum number of iterations. The load flow algorithm will iterate
until the P and Q mismatch at each bus is lower than the PQ tolerance parameter (in pu/Pbase). The
power mismatch is defined as the difference between the net power injected into the bus by
generators and PQ loads and the power transmitted on all links leaving that bus.

To avoid a badly conditioned Ybus matrix, you should select the Base power parameter value in the
range of nominal powers and loads connected to the network. For a transmission network with
voltages ranging from 120 kV to 765 kV, a 100 MVA base is usually selected. For a distribution
network or for a small plant consisting of generators, motors, and loads having a nominal power in
the range of hundreds of kilowatts, a 1 MVA power base is better adapted.

To solve the load flow, click the Compute button. The load flow solution is then displayed in the last
five columns of the table.

To display the load flow report showing power flowing at each bus, click the Report button. You can
also save this report in a file by specifying the file name at the prompt.

The report starts with displaying the summary of active and reactive powers, showing total PQ
sharing between generators (SM and Vsrc type blocks), PQ loads (PQ type RLC loads and DYN loads),
shunt constant Z loads (Z type RLC loads and magnetizing branches of transformers) and
asynchronous machine loads (ASM):

The Load Flow converged in 2 iterations !        
                                                 
SUMMARY for subnetwork No 1                      
                                                 
Total generation :    P=  5.61 MW   Q= 25.51 Mvar
Total PQ load :       P= 13.00 MW   Q=  5.00 Mvar
Total Zshunt load :   P=  0.68 MW   Q= -0.51 Mvar
Total ASM load :      P= -8.90 MW   Q=  4.38 Mvar
Total losses :        P=  0.83 MW   Q= 16.64 Mvar

The Total losses line represents the difference between generation and loads (PQ type + Z type
+ASM). It therefore represents series losses. After this summary, a voltage and power report is
presented for each bus:

1 : B120  V= 1.020 pu/120kV 0.00 deg  ; Swing bus 
        Generation : P= -114.39 MW Q=   62.76 Mvar
        PQ_load    : P=    0.00 MW Q=    0.00 Mvar
        Z_shunt    : P=    0.25 MW Q=    0.23 Mvar
   -->  B13.8      : P= -116.47 MW Q=   53.89 Mvar
   -->  B25_1      : P=    1.84 MW Q=    8.63 Mvar
                                                  

2 Advanced Components and Techniques

2-26



2 : B13.8  V= 0.980 pu/13.8kV -23.81 deg          
        Generation : P=  120.00 MW Q=  -37.25 Mvar
        PQ_load    : P=    3.00 MW Q=    2.00 Mvar
        Z_shunt    : P=    0.17 MW Q=    0.17 Mvar
   -->  B120       : P=  116.83 MW Q=  -39.42 Mvar
                                                  
3 : B25_1  V= 0.998 pu/25kV -30.22 deg            
        Generation : P=    0.00 MW Q=    0.00 Mvar
        PQ_load    : P=   10.00 MW Q=    3.00 Mvar
        Z_shunt    : P=    0.25 MW Q=    0.21 Mvar
   -->  B120       : P=   -1.83 MW Q=   -8.44 Mvar
   -->  B25_2      : P=   -8.41 MW Q=    5.23 Mvar
                                                  
4 : B25_2  V= 0.967 pu/25kV -20.85 deg            
        Generation : P=    0.00 MW Q=    0.00 Mvar
        PQ_load    : P=   -0.00 MW Q=   -0.00 Mvar
        Z_shunt    : P=    0.01 MW Q=   -0.03 Mvar
   -->  B25_1      : P=    8.87 MW Q=   -3.67 Mvar
   -->  B575       : P=   -8.88 MW Q=    3.70 Mvar
                                                  
5 : B575  V= 0.953 pu/0.575kV -18.51 deg          
        Generation : P=    0.00 MW Q=    0.00 Mvar
        PQ_load    : P=   -0.00 MW Q=   -0.00 Mvar
        Z_shunt    : P=    0.01 MW Q=   -1.09 Mvar
   -->  ASM        : P=   -8.90 MW Q=    4.38 Mvar
   -->  B25_2      : P=    8.89 MW Q=   -3.29 Mvar

For every bus, the bus voltage and angle are listed on the first line. The next 3 lines give the PQ
generated at the bus (all SM and voltage sources), the PQ absorbed by the PQ type loads, and the PQ
absorbed by the Z type loads.

The last lines, preceded by an arrow (-->), list the PQ transmitted to neighbor buses connected
through lines, series impedances, and transformers, as well power absorbed by ASM.

Apply the Load Flow Solution to Your Model

When performing a load flow analysis, you may need to iterate on P, Q, V values until you find
satisfactory voltages at all buses. This may require, for example, changing generated power, load
powers, or reactive shunt compensation.

To change the load flow setup, you need to edit the parameters of the load flow blocks and of the
Load Flow Bus blocks. Then click the Update button to refresh the load flow data displayed by the
table. The previous load flow solution is then deleted from the table. Click the Compute button to
obtain a new load flow solution corresponding to the changes you made.

Once you have obtained a satisfactory load flow, you need to update the model initial conditions
according to the load flow solution. Click the Apply to Model button to initialize the machine blocks
of the model, as well as the initial conditions of regulators connected to the machines.

Open the Three-Phase Parallel RLC Load block connected at the B13.8 bus. As the Load type
specified in the Load Flow tab is constant PQ, the nominal voltage of this block has been changed to
the corresponding bus voltage of 0.98 pu. The Nominal phase-phase voltage parameter is set to
(13800)*0.98.

Open the Three-Phase Dynamic Load block connected at the B25_1bus. The Initial positive-
sequence voltage Vo is set to [0.998241 pu -30.2228 deg].
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Note that the voltage magnitudes and angles obtained at each bus have been written as block
annotations under the Load Flow Bus blocks.

Open the scope and start the simulation.

The Three-Phase Fault block has been programmed to apply a six-cycle fault at B120 bus.

Observe waveforms of SM active power, SM and ASM speeds, and PQ of DYN load, and notice that
simulation starts in steady state.

Example of Unbalanced Load Flow

At the command prompt, enter power_13NodeTestFeeder to open a model containing 12 Load Flow
Bus blocks and 13 load flow blocks. This model is a benchmark network taken from the “Radial
Distribution Test Feeder” Distribution System Analysis Subcommittee Report, Power Engineering
Society, pages 908–912, 2001.

The original benchmark system contains 13 nodes. However, as the power_13NodeTestFeeder model
does not include the regulating transformer, it contains only 12 nodes.

The Load Flow Bus blocks are shown in orange and the Load Flow blocks are shown in yellow.

The Load Flow Bus blocks specify the bus base voltages (nominal phase-to-ground rms voltage). They
specify the voltage at PV buses or the voltage and angle of the swing buses. Once the load flow is
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solved, the Load Flow Bus block displays the bus voltage magnitude and phase angle as block
annotations.

Note By default the block annotations are set in the Block Annotation tab of the Load Flow Bus
block properties to display the phase A magnitude (<VLF> parameter) and the phase A angle
(<angleLF> parameter). To display phase B magnitude and angle, specify <VLFb> and <angleLFb>,
respectively. To display phase C magnitude and angle, specify <VLFc> and <angleLFc>, respectively.

You can also delete some block annotations. In the power_13NodeTestFeeder example, only the
bus identification is displayed (<ID> parameter).

The bus type (PV, PQ, or swing) is determined by the load flow blocks connected to the bus. If you
have several load flow blocks with different types (specified in the Generator type parameter or in the
Load type parameter) connected to the same bus, the Load Flow tool determines the resulting bus
type (swing, PQ, or PV). The table shows how the bus types are determined for some of the model
buses of the power_13NodeTestFeeder example.

Bus Load Flow Blocks Resulting Bus Type
632 4160 V swing

- Generator type = swing
632_a=swing V=1.0210 pu -2.49 deg.
632_b=swing V=1.042 pu -121.72 deg.
632_c=swing V=1.074 pu -121.72 deg.

(Voltages and angles are specified in the
‘632’ Load Flow Bus block)

633 No load flow block PQ
633_a -> P= 0 kW; Q = 0 kvar
633_b -> P= 0 kW; Q = 0 kvar
633_c -> P= 0 kW; Q = 0 kvar

634 634 Yg PQ load block
- Load type = constant PQ

PQ
634_a -> P= 160 kW; Q = 110 kvar
634_b -> P= 120 kW; Q = 90 kvar
634_c -> P= 120 kW; Q = 90 kvar

646 646_Z load block
- Load type = constant Z
- Load connection ‘bc’

PQ
646_bc -> P= 0 MW Q = 0 Mvar

(Constant Z loads are included in the Ybus
admittance matrix.)

675 675 Yg PQ load
- Load type = constant PQ

675 Yg Z load
- Load type = constant Z

PQ
675_a -> P= 485 kW; Q = 190 kvar
675_b -> P= 68 kW; Q = 60 kvar
675_c -> P= 290 kW; Q = 212 kvar

(Constant Z loads are included in the Ybus
admittance matrix.)

Some restrictions apply when you have several source blocks and synchronous machines connected
to the same load flow bus:

• You cannot connect two swing generators in parallel.

 Three-Phase Systems and Machines

2-29



• You cannot connect a swing generator in parallel with a PV ideal voltage source
• You can connect only one PV generator with finite Q limits at a generation bus. However, you can

have other PQ generators and loads connected on the same bus.

For more information on how to use the Load Flow Bus block in your model, see Load Flow Bus block.

Open the Load Flow Tool to Perform Load Flow Analysis

Open the Load Flow tool by clicking the Load Flow button in the powergui block. The tool displays a
list of the individual single-phase buses (one bus per phase) found in the power_13NodeTestFeeder
model. In the Load Flow tool, the load flow has not yet been performed, and the V_LF and Vangle_LF
columns display zero values.

The load flow parameters in the Preferences tab of the Powergui are used to build the Ybus network
admittance matrix and to solve the load flow. The base power is used to specify units of the
normalized Ybus matrix in pu/Pbase and bus base voltages. The power_13NodeTestFeeder model
contains 29 single phase buses; consequently, the Ybus matrix is a 29x29 complex matrix evaluated at
the frequency specified by the Frequency (Hz) parameter.

The load flow algorithm uses an iterative solution based on the Newton-Raphson method. The Max
iterations parameter defines the maximum number of iterations. The load flow algorithm iterates
until the P and Q mismatch at each bus is lower than the PQ tolerance parameter (in pu/Pbase). The
power mismatch is defined as the difference between the net power injected into the bus by
generators and PQ loads and the power transmitted on all links leaving that bus.

To avoid a badly conditioned Ybus matrix, select the Base power parameter value in the range of
nominal powers and loads connected to the network. For a transmission network with voltages
ranging from 120 kV to 765 kV, a 100 MVA base is usually selected. For a distribution network with
loads having a nominal power in the range of tens to hundreds of kVA, a 100 kVA to 1 MVA power
base is better adapted.

To solve the load flow, click Compute. The bus voltages and angles then appear in the V_LF and
Vangle_LF columns of the table.
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To display the load flow report showing the power flow at each bus, click Report. You can also save
this report in a file by specifying the file name at the prompt.

The report starts with displaying the summary of active and reactive powers, showing total PQ
sharing between generators (SM- and Vsrc-type blocks), PQ loads (PQ-type RLC loads, dynamic loads,
and asynchronous machine loads), shunt constant Z loads (Z-type RLC loads and magnetizing
branches of transformers):

SUMMARY for subnetwork No 1                                 
                                                            
  Total generation  : P=   3518.74 kW   Q=   1540.14 kvar   
  Total PQ load     : P=   3101.90 kW   Q=   1880.42 kvar   
  Total Zshunt load : P=    363.47 kW   Q=   -479.42 kvar   
  Total losses      : P=     53.36 kW   Q=    139.14 kvar   

The Total losses line represents the difference between generation and loads (PQ type + Zshunt
type). It therefore represents series losses. After this summary, a voltage and power report appears
for each bus.For each phase of every bus, the bus voltage and angle are listed on the first line. The
next three lines give the PQ generated at the bus (all SM and voltage sources), the PQ absorbed by
the PQ type loads, and the PQ absorbed by the Z-type loads. The last lines, preceded by an arrow (–
>), list the PQ power transmitted on all links leaving that bus.

The last column gives the positive-sequence bus voltage V1 (magnitude and angle, for three-phase
buses only) and the sum of PQ powers for all phases (PQ generated by sources, PQ absorbed by loads,
and PQ transmitted through transformers, lines, and series impedances). For example, you can verify
that the total PQ load absorbed at bus 634 (P = 400 kW Q = 290 kvar) corresponds to the sum of
active and reactive powers specified for phases A, B, and C in the load block.
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Apply the Load Flow Solution to Your Model

When performing a load flow analysis, you might need to try different P, Q, and V values until you find
satisfactory voltages at all buses. This can require, for example, changing generated power, load
powers, or reactive shunt compensation.

To change the load flow setup, you need to edit the parameters of the load flow blocks and of the
Load Flow Bus blocks. Then, click Update to refresh the load flow data displayed by the table. Click
Compute to get a new load flow solution corresponding to the changes you made.

Once you have a satisfactory load flow, you need to update the model initial conditions according to
the load flow solution. Click Apply to Model to initialize the PQ-type load blocks, the source block
internal voltages, the machine blocks, as well as the initial conditions of associated regulators.

Open the Three-Phase Series RLC Load block connected at bus 632. As the Load type specified in
the Load Flow tab is constant PQ, the vector of Nominal phase-to-neutral voltages [Va Vb Vc] of
this block has been changed to the corresponding bus voltages [1.021 1.042 1.0174]*2401.78
Vrms . Open the Three-Phase Source block connected at bus 632. The Line-to neutral voltages [Va
Vb Vc] parameter is also set to [1.021 1.042 1.0174]*2401.78 Vrms.

Open the Power Flow Results subsystem and start the simulation.

Observe voltage magnitudes and PQ powers on various Display blocks. These values correspond to
values displayed in the load flow report.

Performing Load Flow Analysis at the Command Line

As an alternative to using the Load Flow tool interface to perform a load flow, you can use the tool at
the command line. For example, to perform the positive-sequence load flow on the
power_LFnetwork_5bus model, enter:

LF = power_loadflow('-v2','power_LFnetwork_5bus','solve')

LF = 
             model: 'power_LFnetwork_5bus'
         frequency: 60
         basePower: 100000000
         tolerance: 0.0001
             Ybus1: [5x5 double]
               bus: [1x7 struct]
                sm: [1x1 struct]
               asm: [1x1 struct]
              vsrc: [1x1 struct]
            pqload: [1x1 struct]
           rlcload: [1x2 struct]
          Networks: [1x1 struct]
            status: 1
        iterations: 2
             error: ''
    LoadFlowSolver: 'PositiveSequence'

The power_loadflow function returns the solution in the LF structure, and the model is initialized
to start in steady state. You can obtain a detailed load flow report by entering:

LF = power_loadflow('-v2','power_LFnetwork_5bus','solve','report');
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The function prompts you to save the report in a file that is displayed in the MATLAB editor.

You can use the same command to perform an unbalanced load flow on the
power_13NodeTestFeeder model:

LF = power_loadflow('-v2','power_13NodeTestFeeder','solve')

LF = 
             model: 'power_13NodeTestFeeder'
         frequency: 60
         basePower: 100000
         tolerance: 0.0001
              Ybus: [29x29 double]
               bus: [1x29 struct]
                sm: [1x1 struct]
               asm: [1x1 struct]
              vsrc: [1x1 struct]
            pqload: [1x1 struct]
           rlcload: [1x1 struct]
          Networks: [1x1 struct]
            status: 1
        iterations: 3
             error: ''
    LoadFlowSolver: 'Unbalanced'

For more information on how to use the power_loadflow function in your code and for detailed
information on the LF structure, see power_loadflow.

Using the Phasor Solution Method for Stability Studies
Up to now, you have simulated a relatively simple power system consisting of a maximum of three
machines. If you increase complexity of your network by adding extra lines, loads, transformers, and
machines, the required simulation time becomes longer and longer. Moreover, if you are interested in
slow electromechanical oscillation modes (typically between 0.02 Hz and 2 Hz on large systems) you
might have to simulate for several tens of seconds, implying simulation times of minutes and even
hours. The conventional continuous or discrete solution method is therefore not practical for stability
studies involving low-frequency oscillation modes. To allow such studies, you have to use the phasor
technique (see “Introducing the Phasor Simulation Method” on page 1-23).

For a stability study, we are not interested in the fast oscillation modes resulting from the interaction
of linear R, L, C elements and distributed parameter lines. These oscillation modes, which are usually
located above the fundamental frequency of 50 Hz or 60 Hz, do not interfere with the slow machine
modes and regulator time constants. In the phasor solution method, these fast modes are ignored by
replacing the network's differential equations by a set of algebraic equations. The state-space model
of the network is therefore replaced by a transfer function evaluated at the fundamental frequency
and relating inputs (current injected by machines into the network) and outputs (voltages at machine
terminals). The phasor solution method uses a reduced state-space model consisting of slow states of
machines, turbines, and regulators, thus dramatically reducing the required simulation time. Two
solver types are available for phasor models: continuous and discrete. The type of solver is specified
in the powergui block by setting Simulation type to either Phasor (continuous) or Discrete
phasor. The continuous phasor solution uses a Simulink variable-step solver. Continuous variable-
step solvers are very efficient in solving this type of problem. Recommended solver is ode23tb with a
maximum time step of one cycle of the fundamental frequency (1/60 s or 1/50 s). Discrete phasor
uses a local solver to discretize and solve the phasor model at a specified sample time. The Discrete
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phasor simulation method allows you to use Simulink Coder to generate code and simulate your
model in real time.

Now apply the phasor solution method to the two-machine system you have just simulated with the
conventional method. Open the power_machines example.

In the powergui block, set Simulation type to Phasor. Specify the fundamental frequency used to
solve the algebraic network equations. Enter 60 in the Frequency field. Note that the words Phasor
60 Hz now appear on the Powergui icon, indicating that this new method is used to simulate your
circuit. To start the simulation in steady state, you must first repeat the machine initialization
procedure by using either the “Machine Initialization Tool” on page 2-18 or the “Load Flow Tool” on
page 2-20.

Observe that simulation is now much faster. The results compare well with those obtained with the
continuous mode simulation.

You may also try the discrete phasor simulation. In the powergui block, set Simulation type to
Discrete phasor and specify a sample time of 4e-3 sec.

The synchronous machine waveforms are compared on the following figure for three simulation
types:

• Continuous (yellow)
• Phasor (continuous) (cyan)
• Discrete phasor with a 4 ms sample time (magenta)

Both phasor models (continuous and discrete) compare well with the continuous model.

Contrary to the continuous phasor solver, which uses a full set of machine differential equations for
modelling stator and rotor transients, the discrete phasor solver uses simplified machine models
where differential equations on the stator side are replaced with algebraic equations. These lower-
order machine models eliminate two states (phid and phiq stator fluxes) and produce simulation
results similar to commercial stability software. Compared with the continuous phasor solver, the
discrete phasor solver produces "cleaner" waveforms. For this example, you can observe that in the
discrete phasor model, the speed (w) and terminal voltage (Vt) high-frequency oscillations are
eliminated and the Vt voltage glitch observed at the breaker opening is also eliminated.

The discrete phasor solver has also two additional advantages:

• This solver uses a robust solution method, which allows you to eliminate machine parasitic loads.
• This solver allows you to use Simulink Coder to generate code and simulate your model in real

time.

Note When you set Simulation type to Discrete phasor, the two control blocks (Diesel Engine
and Governor and Excitation) stay continuous and still use the ode23tb variable-step solver. If you
want to simulate this model in real time, the whole model must use fixed-time steps. You therefore
need to change the variable-step solver to a fixed-step solver that uses the same sample time as the
electric network.
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Comparison of Results for Continuous and Phasor Simulation Methods

The phasor solution method is illustrated on more complex networks presented as the following
examples:

• Transient stability of two machines with power system stabilizers (PSS) and a static var
compensator (SVC) (power_svc_pss model)

• Performance of three power system stabilizers for interarea oscillations (power_PSS model)

The first example illustrates the impact of PSS and use of a SVC to stabilize a two-machine system.
The second example compares the performance of three different types of power system stabilizers
on a four-machine, two-area system.
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The phasor solution method is also used for FACTS models. See the case studies “Improve Transient
Stability Using SVC and PSS” on page 6-2 and “Control Power Flow Using UPFC and PST” on page
6-6.
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Building and Customizing Simscape Electrical Specialized
Power Systems Models

In this section...
“Introduction” on page 2-37
“Modeling a Nonlinear Inductance” on page 2-37
“Modeling a Nonlinear Resistance” on page 2-40
“Connecting Your Model with Other Nonlinear Blocks” on page 2-42

Introduction
Simscape Electrical Specialized Power Systems provides a wide collection of models. It can happen,
however, that you need to interface your own model with the standard models provided in the
Simscape Electrical Specialized Power Systems library. This model could be a simple nonlinear
resistance simulating an arc or a varistor, a saturable inductor, a new type of motor, etc.

In the following sections, a simple saturable inductance and a nonlinear resistance serve as
examples.

Modeling a Nonlinear Inductance
Consider an inductor of 2 henries designed to operate at a nominal voltage, Vnom = 120 V RMS, and
a nominal frequency, fnom = 60 Hz. From zero to 120 V RMS the inductor has a constant inductance,
L = 2 H. When voltage exceeds its nominal voltage, the inductor saturates and its inductance is
reduced to Lsat = 0.5 H. The nonlinear flux-current characteristic is plotted in the next figure. Flux
and current scales are in per units. The nominal voltage and nominal current are chosen as base
values for the per-unit system.

Flux-Current Characteristic of the Nonlinear Inductance

The current i flowing in the inductor is a nonlinear function of flux linkage ψ that, in turn, is a
function of v appearing across its terminals. These relations are given by the following equations:
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v = L ⋅ di
dt = dψ

dt    or   ψ =∫v ⋅ dt

i = ψ
L ψ

The model of the nonlinear inductance can therefore be implemented as a controlled current source,
where current i is a nonlinear function of voltage v, as shown.

Model of a Nonlinear Inductance

“Implementation of a Nonlinear Inductance” on page 2-38 shows a circuit using a 2 H nonlinear
inductance. The nonlinear inductance is connected in series with two voltage sources (an AC Voltage
Source block of 120 volts RMS, 60 Hz, and a DC Voltage Source block) and a 5 ohm resistor.

All the elements used to build the nonlinear model have been grouped in a subsystem named
Nonlinear Inductance. The inductor terminals are labeled In and Out. A Simulink output returning
the flux has been added to the subsystem. You can connect this output to a Scope block to observe the
flux.

The nonlinear model uses a Voltage Measurement block to read the voltage at the inductance
terminals and a Controlled Current Source block. The direction of the arrow of the current source is
oriented from input to output according to the model shown above.

An Integrator block computes the flux from the voltage input, and a 1-D Lookup Table block
implements the saturation characteristic i = f(ψ) described by “Flux-Current Characteristic of the
Nonlinear Inductance” on page 2-37.

Implementation of a Nonlinear Inductance
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Two Fourier blocks from the Simscape > Electrical > Specialized Power Systems > Control &
Measurements > Measurements library are used to analyze the fundamental component and the
DC component of the current.

Using blocks of the Simscape Electrical Specialized Power Systems and Simulink libraries, build the
circuit shown above. To implement the i =f(ψ) relation, specify the following vectors in the 1-D
Lookup Table block:

Breakpoints 1 (flux) [-1.25 -1 1 1.25 ] *(120*sqrt(2)/(2*pi*60))
Table data (current) [-2 -1 1 2]*(120*sqrt(2)/(4*pi*60))

Set the following parameters for the two sources:

AC source
Peak amplitude 120*sqrt(2)
Phase 90 degrees
Frequency 60 Hz

DC source
Amplitude 0 V

Adjust the simulation time to 1.5 s and select the ode23tb integration algorithm with default
parameters. Start the simulation.

As expected, the current and the flux are sinusoidal. Their peak values correspond to the nominal
values.

Peak Current = 120 ⋅ 2
2 ⋅ 2π ⋅ 60 = 0.225 A

Peak Flux = 120 ⋅ 2
2π ⋅ 60 = 0.450 V ⋅ s

Now change the DC voltage to 1 V and restart the simulation. Observe that the current is distorted.
The 1 V DC voltage is now integrated, causing a flux offset, which makes the flux enter into the
nonlinear region of the flux-current characteristic (ψ > 0.450 V.s). As a result of this flux saturation,
the current contains harmonics. Zoom in on the last three cycles of the simulation. The peak value of
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the current now reaches 0.70 A and the fundamental component has increased to 0.368 A. As
expected, the DC component of the current is 1 V/ 0.5 Ω = 0.2.

You can create a mask that specifies the following prompts, variables, and values:

Nominal voltage (Volts rms): Vnom 120
Nominal frequency (Hz): fnom 60
Unsaturated inductance (H): L 2
Saturation characteristic [i1(pu)
phi1(pu); i2 phi2; ...]:

sat [0, 0; 1, 1; 2, 1.25]

The following code in the mask initializations of the block prepares the two vectors Current_vect
and Flux_vect to be used in the Look-Up Table block of the model.

% Define base current and Flux for pu system
I_base = Vnom*sqrt(2)/(L*2*pi*fnom);
Phi_base = Vnom*sqrt(2)/(2*pi*fnom); 

% Check first two points of the saturation characteristic
if ~all(all(sat(1:2,:)==[0 0; 1 1])),
    h=errordlg('The first two points of the characteristic must 
be [0 0; 1 1]','Error');
    uiwait(h);
end 

% Complete negative part of saturation characteristic
[npoints,ncol]=size(sat);
sat1=[sat ; -sat(2:npoints,:)];
sat1=sort(sat1); 

% Current vector (A)  and flux vector (V.s)
Current_vect=sat1(:,1)*I_base;
Flux_vect=sat1(:,2)*Phi_base;

As the saturation characteristic is specified only in the first quadrant, three lines of code are added to
complete the negative part of the saturation characteristic. Notice also how the validity of the first
segment of the saturation characteristic is verified. This segment must be defined by two points [0
0; 1 1] specifying a 1 pu inductance (nominal value) for the first segment.

Modeling a Nonlinear Resistance
The technique for modeling a nonlinear resistance is similar to the one used for the nonlinear
inductance.

A good example is a metal-oxide varistor (MOV) having the following V-I characteristic:

i = I0 ⋅
v

V0

α

where

v, i = Instantaneous voltage and current
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Vo = Protection voltage
Io = Reference current used to specify the protection voltage
α = Exponent defining the nonlinear characteristic (typically between 10 and 50)

The following figure shows an application of such a nonlinear resistance to simulate a MOV used to
protect equipment on a 120 kV network. To keep the circuit simple, only one phase of the circuit is
represented.

Nonlinear Resistance Applied on a 120 kV Network
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This model is available in the power_nonlinearresistor example.

The model does not use a Look-Up Table block as in the case of the nonlinear inductance model. As
the analytical expression of current as a function of voltage is known, the nonlinear I(V)
characteristic is implemented directly with a Fcn block from the Simulink library.

This purely resistive model contains no states. It produces an algebraic loop in the state-space
representation of the circuit.

Algebraic loops often lead to slow simulation times. You should break the loop with a block that does
not change the nonlinear characteristic. Here a first-order transfer function H(s) = 1/(1+Ts) is
introduced into the system, using a fast time constant (T = 0.01 µs).

Connecting Your Model with Other Nonlinear Blocks
Nonlinear models implemented as a current source cannot be connected in series with an inductor,
another current source, or an open circuit. Such circuit topologies cause errors in Simscape
Electrical Specialized Power Systems.

Similarly, if your nonlinear model uses a Controlled Voltage Source block, this model could not be
short-circuited or connected across a capacitor.

Suppose, for example, that you want to study the inrush current in the nonlinear resistance of the
power_nonlinearresistor example model when it is energized on a voltage source:
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Circuit Topology Causing an Error

If you try to simulate this circuit, you get the following error message:

This topology is forbidden because two nonlinear elements simulated by current sources are
connected in series: the Breaker block and the Nonlinear Inductance block. To be able to simulate
this circuit, you must provide a current path around one of the two nonlinear blocks. You could, for
example, connect a large resistance, say 1 MΩ, across the Breaker block or the Inductance block. In
this case, it is more convenient to choose the Breaker block because a series RC snubber circuit is
provided with the model.

Note Using an inductive source impedance (R-L series) instead of a purely resistive impedance
would have produced another error message, because the current source modeling the nonlinear
inductance would have been in series with an inductance, even with a resistive snubber connected
across the breaker. In such a case, you could add either a parallel resistance across the source
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impedance or a large shunt resistance connected between one breaker terminal and the source
neutral terminal.
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Building a Model Using Model Construction Commands
This section shows you how to use model construction commands to add blocks to your models and
connect them.

Suppose you want to add a PI Section Line block and a Voltage Measurement block to your model,
connect the + terminal of the Voltage Measurement block to the left end of the PI Section Line block,
and connect the - terminal of the Voltage Measurement block to the right end of the PI Section Line
block.

The following code shows you how to add and position the two blocks in your model.

add_block('powerlib/Elements/Pi Section Line','Mymodel/Block1');
add_block('powerlib/Measurements/Voltage Measurement', 
'Mymodel/Block2');
set_param('Mymodel/Block1','position',[340,84,420,106]);
set_param('Mymodel/Block2','position',[520,183,545,207]);

For each block you want to connect, you need to know the handles of the terminal ports.

Block1PortHandles = get_param('Mymodel/Block1','PortHandles');
Block2PortHandles = get_param('Mymodel/Block2','PortHandles');

The add_line command uses the RConn and Lconn fields of the Block1PortHandles and
Block2PortHandles structure variables to connect the blocks. The RConn field represents the right
connectors of the blocks and the Lconn field represents the left connectors. You then need to specify
to the add_line command the indices of the connectors you want to connect.

add_line('Mymodel',Block1PortHandles.LConn(1), 
Block2PortHandles.LConn(1));
add_line('Mymodel',Block1PortHandles.RConn(1), 
Block2PortHandles.LConn(2));
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Improving Simulation Performance

• “How Simscape Electrical Specialized Power Systems Software Works” on page 3-2
• “Choosing an Integration Method” on page 3-4
• “Simulating with Continuous Integration Algorithms” on page 3-6
• “Simulating Discretized Electrical Systems” on page 3-8
• “Increasing Simulation Speed” on page 3-12
• “Change Circuit Parameters” on page 3-13
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How Simscape Electrical Specialized Power Systems Software
Works

Every time you start the simulation, a special initialization mechanism is called. This initialization
process computes the state-space model of your electric circuit and builds the equivalent system that
can be simulated by Simulink software. This process performs the following steps:

1 Sorts all Simscape Electrical Specialized Power Systems blocks, gets the block parameters and
evaluates the network topology. The blocks are separated into linear and nonlinear blocks. Each
electrical node is automatically given a node number.

2 Once the network topology has been obtained, the state-space model (A, B, C, D matrices) of the
linear part of the circuit is computed. All steady-state calculations and initializations are
performed at this stage.

If you have chosen to discretize your circuit, the discrete state-space model is computed from the
continuous state-space model.

If you are using the phasor solution method, the state-space model is replaced with the complex
transfer matrix H(jω) relating inputs and outputs (voltage and current phasors) at the specified
frequency. This matrix defines the network algebraic equations.

3 Builds the Simulink model of your circuit and stores it inside the Powergui block located at the
top level of your model.

The Simulink model uses an S-Function block to model the linear part of the circuit as well as the
switches and power electronic devices. Predefined Simulink models are used to simulate nonlinear
elements. Simulink Source blocks connected at the input of the State-Space block are used to
simulate the electrical source blocks.

The next figure represents the interconnections between the different parts of the complete Simulink
model. The nonlinear models are connected in feedback between voltage outputs and current inputs
of the linear model.

Interconnection of Linear Circuit and Nonlinear Models

Once Simscape Electrical Specialized Power Systems software has completed the initialization
process, the simulation starts. You can observe waveforms on scopes connected at the outputs of your
measurement blocks. Through the Powergui block, you can access the Linear System Analyzer and
obtain transfer functions of your system between any pair of input and output. The Powergui block
also allows you to perform an FFT analysis of recorded signals to obtain their frequency spectrum.

If you stop the simulation and double-click the Powergui block, you have access to the steady-state
values of inputs, outputs, and state variables displayed as phasors. You can also use the Powergui
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block to modify the initial conditions. The powergui block allows you to perform a load flow with
circuits involving three-phase machinery and initialize the machine models so that the simulation
starts in steady state. This feature avoids long transients due to mechanical time constants of
machines. The Powergui block allows you to specify the frequency range that you want, visualize
impedance curves, and store results in your workspace for Impedance Measurement blocks
connected in your circuit.

Limitations of the Nonlinear Models
Because nonlinear models are simulated as current sources, they cannot be connected in series with
inductors and their terminals cannot be left open.

If you feed a machine through an inductive source, Simscape Electrical Specialized Power Systems
prompts you with an error message. You can avoid this error by connecting large resistances in
parallel with the source inductances or across the machine terminals.

A series RC snubber circuit is included in the model of the Breaker block and power electronics
blocks. If you keep these snubber circuits in service, you do not encounter any issues. The snubber
can be changed to a single resistance by setting Cs to Inf, or to a single capacitor by setting Rs = 0.
To eliminate the snubber, specify Rs = Inf or Cs = 0.
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Choosing an Integration Method
In this section...
“Introduction” on page 3-4
“Continuous Versus Discrete Solution” on page 3-4
“Phasor Solution Method” on page 3-4

Introduction
Three solution methods are available through the Powergui block. These are:

• Continuous solution method using Simulink variable-step solvers
• Discretization for solution at fixed time steps
• Phasor solution method using Simulink variable-step solvers

Continuous Versus Discrete Solution
One important feature of Simscape Electrical Specialized Power Systems software is its ability to
simulate electrical systems either with continuous variable-step integration algorithms or with a
fixed-step using a discretized system. For small size systems, the continuous method is usually more
accurate. Variable-step algorithms are also faster because the number of steps is fewer than with a
fixed-step method giving comparable accuracy. When using line-commutated power electronics, the
variable-step, event-sensitive algorithms detect the zero crossings of currents in diodes and thyristors
with a high accuracy so that you do not observe any current chopping. However, for large systems
(containing either a large number of states or nonlinear blocks), the drawback of the continuous
method is that its extreme accuracy slows down the simulation. In such cases, it is advantageous to
discretize your system.

You can consider small size a system that contains fewer than 50 electrical states and fewer than 25
electronic switches. Circuit breakers do not affect the speed much, because these devices are
operated only a couple of times during a test.

Phasor Solution Method
If you are interested only in the changes in magnitude and phase of all voltages and currents when
switches are closed or opened, you do not need to solve all differential equations (state-space model)
resulting from the interaction of R, L, C elements. You can instead solve a much simpler set of
algebraic equations relating the voltage and current phasors. The phasor solution method solves a
much simpler set of equations. As its name implies, this method computes voltages and currents as
phasors. The phasor solution method is particularly useful for studying transient stability of networks
containing large generators and motors. In this type of problem, you are interested in
electromechanical oscillations resulting from interactions of machine inertias and regulators. These
oscillations produce a modulation of the magnitude and phase of fundamental voltages and currents
at low frequencies (typically between 0.02 Hz and 2 Hz). Long simulation times are therefore
required (several tens of seconds). The continuous or discrete solution methods are not appropriate
for this type of problem.

In the phasor solution method, the fast modes are ignored by replacing the network differential
equations by a set of algebraic equations. The state-space model of the network is replaced by a

3 Improving Simulation Performance

3-4



complex matrix evaluated at the fundamental frequency and relating inputs (currents injected by
machines into the network) and outputs (voltages at machine terminals). As the phasor solution
method uses a reduced state-space model consisting of slow states of machines, turbines and
regulators, it dramatically reduces the required simulation time.

Continuous variable-step solvers are very efficient in solving this type of problem. Recommended
solver is ode23tb with a maximum time step of one cycle of the fundamental frequency (1/60 s or
1/50 s). This faster solution technique gives the solution only in the vicinity of the fundamental
frequency.
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Simulating with Continuous Integration Algorithms
In this section...
“State-Space Equations” on page 3-6
“Choosing an Integration Algorithm” on page 3-6
“Simulating Switches and Power Electronic Devices” on page 3-7

State-Space Equations
Assuming a circuit containing nx states, ns switches, and ny voltage or current outputs, the software
determines:

• nx state derivatives to be computed from the A and B matrices of

ẋ = A · x + B · u
• ns switch variables (either voltages across open switches or currents through closed switches)
• ny output variables to be computed from the C and D matrices of

y = C · x + D · u

A total of nx + ns + ny equations is obtained.

Unknown variables are state derivatives dx/dt, outputs y, and switch variables (switch voltages or
switch currents). Known variables are state variables x and inputs u (voltage sources or current
sources).

As the switch status (open or closed) is undetermined, circuit equations are expressed using both
switch voltages (vD1, vD2) and switch currents (iD1, iD2).

These equations express Kirchhoff current laws (KCL) at circuit nodes and Kirchhoff voltage laws
(KVL) for the independent loops. These equations are completed by the output equations.

Computation of the state-space model is incorporated in an S-function and performed each time a
switch status is changing.

To get a list of the circuit equations in the Diagnostic Viewer, select the Display circuit differential
equations check box in the Solver tab of the Powergui block parameters dialog box.

Choosing an Integration Algorithm
Simulink software provides a variety of solvers. Most of the variable-step solvers work well with
linear circuits. However circuits containing nonlinear models, especially circuits with circuit breakers
and power electronics, require stiff solvers.

Best accuracy and fastest simulation speed is usually achieved with ode23tb.

Solver ode23tb
Relative tolerance 1e-4
Absolute tolerance auto
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Maximum step size auto
Initial step size auto
Solver reset method fast

Normally, you can choose auto for the absolute tolerance and the maximum step size. In some
instances you might have to limit the maximum step size and the absolute tolerance. Selecting too
small a tolerance can slow down the simulation considerably. The choice of the absolute tolerance
depends on the maximum expected magnitudes of the state variables (inductor currents, capacitor
voltages, and control variables).

For example, if you work with high-power circuit where expected voltage and currents are thousands
of volts and amperes, an absolute tolerance of 0.1 or even 1.0 is sufficient for the electric states.
However, if your electrical circuit is associated with a control system using normalized control signals
(varying around 1), the absolute tolerance is imposed by the control states. In this case, choosing an
absolute tolerance of 1e-3 (1% of control signal) would be appropriate. If you are working with a very
low power circuit with expected currents of milliamperes, set the absolute tolerance to 1e-6.

Note Usually, keeping the Solver reset method parameter of the ode23tb solver to its default value
(Fast) produces the best simulation performance. However, for some highly nonlinear circuits it
might be necessary to set this parameter to Robust. When you build a new model, we recommend
that you try both the Robust and the Fast reset methods. If you do not notice a difference in
simulation results, then keep the Fast method, which provides fastest simulation speed.

Simulating Switches and Power Electronic Devices
In the Preferences tab of the powergui block, you can select Disable snubbers in switching
devices, which disables snubbers of all switches in your model. Otherwise, you may individually
disable snubbers of selected switches by specifying Rs=inf in their block menus. You can also
simulate perfectly ideal switches by disabling the resistances (Ron) and the forward voltages (Vf).

Eliminating the snubbers reduces the circuit stiffness and lets you use a non-stiff solver, for example,
ode45 instead of ode23tb, to achieve correct results and good simulation speed.

If you specify resistive snubber values that are too large, the circuit model might become badly
conditioned and cause the simulation to stop. In such a case, reduce snubber resistances so that the
resulting leakage current remains acceptable (for example 0.01% to 0.1% of switch nominal current).

In some circuits, using switches with a forward voltage Vf greater than zero and Ron=0 might cause
simulation to stop and display an error message due to a State-Source dependency. To avoid this
problem, specify a small Ron value.

 Simulating with Continuous Integration Algorithms

3-7



Simulating Discretized Electrical Systems
In this section...
“Introduction” on page 3-8
“Discretizing Switches and Power Electronics” on page 3-8
“Discretizing Electrical Machines” on page 3-8
“Discretizing Nonlinear Resistors and Inductors” on page 3-10

Introduction
To perform a discrete simulation, open the powergui block and set Simulation type to Discrete,
and specify the sample time. The electrical system is discretized using the Tustin/Backward Euler
(TBE) method. This method combines the Tustin method and the Backward Euler method. It allows
you to simulate snubberless diode and thyristor converters. It eliminates numerical oscillations seen
with the Tustin method and provides better accuracy than the Backward Euler method.

The TBE discretization method combines the accuracy of the Tustin method and the numerical
oscillation damping property of the Backward-Euler method. It allows you to simulate power
electronic circuits with virtually no snubber, using purely resistive snubbers with a very large
resistance value resulting in negligible leakage currents.

The precision of the simulation is controlled by the time step that you choose for the discretization.
Usually sample times of 20 µs to 50 µs give good results for simulation of switching transients on 50
Hz or 60 Hz power systems or on systems using line-commutated power electronic devices such as
diodes and thyristors. Systems using forced-commutated power electronic switches are usually
operating at high switching frequencies and require smaller sample times. For example, simulating a
pulse-width-modulated (PWM) inverter operating at 5 kHz requires a maximum time step of 1 µs.

Even if you discretize your electric circuit, you can still use a continuous control system. However, the
simulation speed is improved by use of a discrete control system.

Discretizing Switches and Power Electronics
Switches and power electronic devices are nonlinear elements which are represented by a purely
resistive element having a low Ron resistance when the switch is closed and an infinite resistance
when the switch is opened. Each time a switch status is changed during the simulation, the discrete
state-space model of the linear part of the circuit is re-evaluated to take into account the change in
circuit topology.

Due to the way the state-space model is computed, switches cannot be connected in series with
inductive circuits. In such situations, snubber circuits have to be connected across power electronic
devices. For forced-commutated devices, the snubber circuit can be made negligible by using purely
resistive snubbers with a high resistance. However, for circuits containing naturally commutated
devices such as diodes and thyristors, because a fixed simulation time step is used, when the device is
blocked, the current zero-crossing is not detected accurately.

Discretizing Electrical Machines
Electrical machines are nonlinear elements simulated as current sources. These elements cannot be
connected to an inductive network unless a parasitic resistive or capacitive element is connected at
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machine terminals. When using electrical machines in discrete systems, you might have to increase
these parasitic resistive load to avoid numerical oscillations. The amount of parasitic load depends on
the sample time and on the integration method used to discretize the electrical machine.

The Synchronous Machine model and the Asynchronous Machine model use a Trapezoidal
discretization method. All other machine models use a Forward Euler discretization method. For the
Synchronous Machine and the Asynchronous Machine, you select the machine discretization method
in the Advanced tab of the block menu.

In the R2018b and earlier versions, two integration methods were available in the Advanced tab of
the Synchronous Machine and Asynchronous Machine blocks: the Trapezoidal noniterative method or
the Trapezoidal iterative method.

The Trapezoidal non iterative method provides a stable and fast solution. However, to preserve
simulation stability, a resistive parasitic load must be connected at machine terminals. For example,
for a sample time of 50 ms, the minimum resistive load can be as large as 5 to 10% of machine
nominal power. For some applications, the only way to reduce these loads to an acceptable level, say
below 0.1% of nominal power, was to simulate machines with the Trapezoidal iterative method. But,
with this method, simulation becomes very slow and even fails to converge when the number of
machines is increased in a model.

In R2019a, two additional methods have been introduced to discretize the machine models: the
Trapezoidal robust method and the Backward Euler robust method. These methods are part of a
robust solver that allows simulating machines faster and more accurately. This solver allows you to
eliminate the parasitic load and simulate a machine at no load or with a circuit breaker directly
connected in series (a circuit topology that was not possible in previous releases). This robust solver
does not use an iterative technique, making it suitable for real time applications.

The new solver addresses a stability problem of the Trapezoidal non iterative method that occurs
when large parasitic load are used, and convergence and slow simulation problems of the Trapezoidal
iterative method. The following example demonstrates the advantages of using the robust solver.

Example of discrete model using SM and ASM blocks

The following example illustrates impact of the machine discretization methods and amount of
parallel load on model stability.

1 Open the Emergency Diesel-Generator and Asynchronous Motor example model. This model
contains a synchronous machine (SM) and an asynchronous machine (ASM) connected at the
same bus in parallel with a 1 MW load.

2 In the Powergui menu, select Simulation type = discrete, and specify a sample time of Ts =
50 μs. In the Preferences tab, select Tustin/Backward Euler discrete solver.

3 Use the Load Flow tool to initialize the machine models.
4 Start the simulation and observe that the model starts in a steady-state.

In this model, the default discretization method specified in the Advanced Tab of the synchronous
machine block and of the asynchronous machine block is Trapezoidal noniterative. The model is
stable because a relative large load of 1 MW is connected at the machine terminals. This load
represents 32% of the SM nominal power and 60% of the ASM nominal power.

Now simulate this discrete model with virtually no load connected at machine terminals. You may try
decreasing the 1 MW load to say 1 kW (representing respectively 0.032% and 0.06% of SM and ASM
machine nominal powers).
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Change the resistive load from 1MW to 1 kW and start simulation. Notice the numerical oscillations,
because the 1 kW load is too small to guarantee stability of the machine models.

If you vary the load by steps of 50 kW, you discover that the minimum load required to obtain a stable
model with the Trapezoidal non iterative method is 300 kW, corresponding to 6.2% of the total
machine nominal power (4.80 MVA = 3.125 MVA for ASM + 1.678 MVA for SM).

In the Advanced tab of the Synchronous Machine block, change the solver to Trapezoidal
iterative, and leave the Trapezoidal non iterative selection for the Asynchronous Machine
block solver. Simulate the model. Simulation results are the same and as accurate as for a continuous
model but return an algebraic loop warning. The drawback of using this solver is the simulation
speed. Moreover, if you attempt to use the Trapezoidal iterative solver for both machines, you
observe that Simulink fails to converge.

The only way to simulate this discrete model with a 1 kW load is to use either the Trapezoidal robust
method or the Backward Euler robust method for both machine blocks. The Trapezoidal robust
method is slightly more accurate than the Backward Euler robust method, especially for larger
sample times. The Trapezoidal robust method tends to produce slight damped numerical oscillations
on voltages when the machines are at no load. In such scenarios, the Backward Euler robust method
prevents oscillations and maintains acceptable simulation accuracy. The robust solver allows you to
eliminate the parallel load at the machine terminals.

Specify the Trapezoidal robust method in both machine blocks and comment out the load. Reconnect
the voltage measurement block between phases A and B (otherwise, Simulink returns an error
because the ground point that was defined by the load no longer exists). Start the simulation and
zoom on the Vab machine voltage to observe small numerical oscillations when the fault is applied
and cleared. These oscillations can be avoided if you use the Backward Euler robust method for both
machines. The simulation speed obtained with the two types of robust solvers is approximately the
same as the one obtained with the Trapezoid non iterative method.

Discretizing Nonlinear Resistors and Inductors
The robust solver provides an accurate modeling of discretized nonlinear resistors and nonlinear
inductors by using an iterative method. When using the robust solver to discretize nonlinear resistors
and nonlinear inductors, the solution is usually found in one or two iterations. For real time
applications, you may need to limit the number of iterations. See the Solver details for nonlinear
elements preference in the powergui block reference page.

Discretizing Nonlinear Resistors

A nonlinear resistor is a resistive element where current (model output) is a nonlinear function of
voltage (model input). This type of element contains no state. Its output varies instantaneously with
input. This means that a direct feedthrough exists between input and output, producing an algebraic
loop. Solving this algebraic loop requires an iterative method.

Nonlinear resistor is used, for example, to model the Surge Arrester block. When the Simulation type
in the powergui block type is set to Discrete, the discretization method is selected in the Advanced
tab of the Surge Arrester block. Three solution method options can be specified using the Break
Algebraic loop in discrete model and Use robust solver in discrete model checkboxes in the
discrete model.

1 When the two checkboxes are cleared, the robust solver is not enabled, and the model contains
an algebraic loop solved by Simulink, which iterates until the solution is found. Although this
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method produces correct results, it is not recommended because simulation may fail to converge
when the number of Surge Arrester blocks is increased in the model. This method cannot be used
in real time applications due to the presence of algebraic loops.

2 When only the Break Algebraic loop in discrete model checkbox is selected, a delay is
inserted at the current output of the nonlinear resistor model to break the algebraic loop. This
delay requires using small sample times. This method is not recommended because it becomes
unstable when sample time is increased.

3 When the Use robust solver in discrete model parameter is selected, the robust solver
provides stable iterations and accurate simulation results. Starting with the R2019a release, this
is the recommended method for discretizing Surge Arrester blocks.

Discretizing Nonlinear Inductors

A nonlinear inductor is an inductive element where the current (model output) is a nonlinear function
of flux linkage corresponding to the integral of the voltage (model input). To achieve good accuracy,
the flux linkage must be computed by using an implicit integration method, such as Trapezoidal or
Backward Euler methods. The drawback is a direct feedthrough between input and output, which
requires an iterative solution.

The nonlinear inductor is used to implement saturation in single-phase and three-phase transformer
blocks. When the Simulation type in the powergui block is set to Discrete, the discretization
method is selected in the Advanced tab of the transformer blocks. You can specify four solution
methods using the Break Algebraic loop in discrete model check box and the Discrete solver
model parameter.

1 When the Break Algebraic loop in discrete model parameter is selected, a delay is inserted at
the output of the nonlinear inductor model to avoid iterations. This delay requires small sample
times to remain stable and produce accurate results.

2 When the Break Algebraic loop in discrete model parameter is cleared and the
Trapezoidal iterative method is used to compute the flux (integration of voltage), Simulink
iterates to find the solution. Although this method produces correct results, it is not
recommended because simulation may fail to converge when the number of Saturable
Transformer blocks is increased in the model. This method cannot be used in real time
applications due to the presence of algebraic loops.

3 When the Trapezoidal robust method is used to compute the flux, the robust solver iterates
to find the solution.

4 When the Backward Euler robust method is used to compute the flux, the robust solver
iterates to find the solution.

Starting with the R2019a release, methods 3 and 4 are the recommended methods. The Trapezoidal
robust method is slightly more accurate than the Backward Euler robust method. The Trapezoidal
robust method may produce slightly damped numerical oscillations on transformer voltages when
transformers are at no load. In this scenario, the Backward Euler robust method prevents oscillations
while maintaining an acceptable accuracy.
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Increasing Simulation Speed
In this section...
“Ways to Increase Simulation Speed” on page 3-12
“Using Accelerator Mode and Simulink Coder” on page 3-12

Ways to Increase Simulation Speed
Once you have selected the proper method (continuous, discrete, or phasor), solver type, and
parameters, there are additional steps you can take to optimize your simulation speed.

• Discretizing your electric circuit and your control system. You can even use a larger sample time
for the control system, provided that it is a multiple of the smallest sample time.

• If you are simulating repeatedly from a particular operating point, specify a vector of initial states:

1 Simulate your model. Save the initial states as a vector in the MATLAB workspace.
2 In Simulink, in the Modeling tab, select Model Settings > Model Settings.
3 In the left pane of the Configuration Parameters dialog box, select Data Import/Export.
4 Select the Initial state parameter and enter the name of the workspace variable that

contains the vector of initial states.
• Reducing the number of open scopes and the number of points saved in the scope also helps in

reducing the simulation time.
• Using the Simulink Accelerator mode. The performance gain obtained with the Accelerator varies

with the size and complexity of your model. Typically you can expect performance improvements
by factors of two to 10.

Using Accelerator Mode and Simulink Coder
The Accelerator mode speeds up the execution of Simulink models by replacing the interpreted M
code running beneath the Simulink blocks with compiled code as your model executes. The
Accelerator mode uses portions of Simulink Coder to generate this code on the fly. Although the
Accelerator mode uses this technology, Simulink Coder is not required to run it. Also, if you do not
have your own C compiler installed, you can use the LCC compiler provided with your MATLAB
installation.

To take full advantage of the performance enhancements made possible by converting your models to
code, you must use Simulink Coder software to generate standalone C code. You can then compile
and run this code and, with Simulink Real-Time™ software, also run it on a target PC operating the
Simulink Real-Time real-time kernel.
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Change Circuit Parameters
In this section...
“Introduction” on page 3-13
“Example of MATLAB Script Performing a Parametric Study” on page 3-13

Introduction
Each time that you change a parameter of the Simscape Electrical Specialized Power Systems library
blocks, you have to restart the simulation to evaluate the state-space model and update the
parameters of the nonlinear models. However, you can change any source parameter (Magnitude,
Frequency, or Phase) during the simulation. The modification takes place as soon as you apply the
modification or close the source block menu.

For the Simulink blocks, all the Simscape Electrical Specialized Power Systems library block
parameters that you specify in the dialog box can contain MATLAB expressions using symbolic
variable names. Before running the simulation, you must assign a value to each of these variables in
your MATLAB workspace. This assignment allows you to perform parametric studies by changing the
parameter values in a MATLAB script.

Example of MATLAB Script Performing a Parametric Study
Suppose that you want to perform a parametric study in a circuit named my_circuit to find the
impact of varying an inductance on switching transients. You want to find the highest overvoltage and
the inductance value for which it occurred.

The inductance value of one of the blocks contains variable L1, which you must define in your
workspace. L1 is varied in 10 steps from 10 mH to 100 mH and the values to be tested are saved in a
vector, L1_vec. The voltage waveform to be analyzed is stored in a ToWorkspace block in array
format with V1 variable name.

You can write a MATLAB script that loops on the 10 inductance values and displays the worst case
scenario.
L1_vec= (10:10:100)*1e-3; % 10 inductances values 10/100 mH
V1_max=0;
for i=1:10
    L1=L1_vec(i);
    fprintf('Test No %d L1= %g H\n', i, L1);
    sim('my_circuit'); % performs simulation
    % memorize worst case
    if max(abs(V1))>V1_max,
        imax=i;
        V1_max=max(abs(V1));
    end
end

fprintf('Maximum overvoltage= %g V occurred for L1=%g H\n', V1_max, L1_vec(imax));
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Systems with Electric Drives
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• “Simulate a DC Motor Drive” on page 4-6
• “Simulate an AC Motor Drive” on page 4-19
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Electric Drives Library
In this section...
“What Is an Electric Drive?” on page 4-2
“Electric Drive Components” on page 4-3
“Multiquadrant Operation” on page 4-4
“Average-Value Models” on page 4-5

The Electric Drives library is designed for engineers from many disciplines who want to incorporate
easily and accurately electric drives in the simulation of their systems. The interface presents the
parameters of the selected drive in a system-look topology, thereby simplifying the adjustments users
may want to bring to the default values. Then they can seamlessly use any other toolboxes or
blocksets to analyze the time or frequency behavior of the electric drive interacting with its system.
The library is most helpful when a powerful drive has to be carefully maneuvered without ignoring
the operating limits of the load on one side and of the power source on the other side. A good
example is the electric drive system of a hybrid car that can switch in milliseconds from driving the
wheels to recharging the batteries when the brakes are engaged.

Engineers and scientists can work readily with the library. The library has seven typical direct current
(DC) drives used in industries and transportation systems, eight alternating current (AC) drives
providing more efficient and versatile motors from traction to positioning devices, and shaft and
speed reducer models useful for connecting to the motor a model of load made of Simulink blocks. An
added value of the library is parameters that assure the validity of the motor, the power converters,
and the control system. When designing the library, particular attention was devoted to the motor
models by comparing the models' behavior to the published data of the major manufacturers.
Numerous examples or case studies of typical drives are supplied with the library. Hopefully, typical
user systems are similar to these analyzed systems, thereby saving time in building the practical
system and supplying a known reference point in the analysis.

To access the Electric Drives library, open the Simscape ElectricalSpecialized Power Systems main
library. At the MATLAB command prompt, enter:

simscapepowersystems_ST

Double-click the Electric Drives icon.

What Is an Electric Drive?
An electric drive is a system that performs the conversion of electric energy into mechanical energy
at adjustable speeds. This is the reason why an electric drive is also called adjustable speed drive
(ASD). Moreover, the electric drive always contains a current (or torque) regulation to provide safe
current control for the motor. Therefore, the electric drive torque/speed is able to match in steady
state the torque/speed characteristics of any mechanical load. This motor to mechanical load match
means better energy efficiency and leads to lower energy costs. In addition, during the transient
period of acceleration and deceleration, the electric drive provides fast dynamics and allows soft
starts and stops, for instance.

A growing number of applications require that the torque and speed vary to match the mechanical
load. Electric transportation means, elevators, computer disk drives, machine tools, and robots are
examples of high-performance applications where the desired motion versus time profile must be
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tracked very precisely. Pumps, fans, conveyers, and HVAC are examples of moderate performance
applications where variable-speed operation means energy savings.

Electric Drive Components
An electric drive consists of these main components:

• Electric motor
• Power electronic converter
• Drive controller

This diagram shows the basic topology of an electric drive.

Electric Drive Basic Topology

The motor used in an electric drive is either a direct current (DC) or an alternating current (AC)
motor. The type of motor used defines the electric drive's classification into DC motor drives and AC
motor drives.

The power electronic converter produces variable AC voltage and frequency from the electric power
source. There are many types of converters depending on the type of electric drive. The DC motor
drives are based on phase-controlled rectifiers (AC-DC converters) or on choppers (DC-DC
converters), while the AC motor drives use inverters (DC-AC converters) or cyclo converters (AC-AC
converters). The basic component of all the power electronic converters is the electronic switch,
which is either semicontrolled (controllable on-state), as in the case of the thyristor, or fully
controllable (controllable on-state and off-state), as in the cases of the IGBT (insulated gate bipolar
transistor) and the GTO (gate turn off thyristor) blocks. The controllable feature of the electronic
switch is what allows the converter to produce the variable AC voltage and frequency.

The purpose of the drive controller is to convert the desired drive torque/speed profile into triggering
pulses for the electronic power converter, taking into account various drive variables (currents,
speed, and so on) fed back by the sensors. To accomplish this conversion, the controller is based first
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on a current (or torque) regulator. The current regulator is mandatory because it protects the motor
by precisely controlling the motor currents. The set point (SP) of this regulator can be supplied
externally if the drive is in torque regulation mode, or internally by a speed regulator if the drive is in
speed regulation mode. In the Electric Drives library, the speed regulator is in series with the current
regulator and is based on a PI controller that has three important features:

• The SP rate of change is limited so that the desired speed ramps gradually to the SP, in order to
avoid sudden step changes.

• The speed regulator output that is the SP for the current regulator is limited by maximum and
minimum ceilings.

• The integral term is also limited in order to avoid wind-up. The following figure shows a block
diagram of a PI controller-based speed controller.

PI Controller-Based Speed Regulator

Multiquadrant Operation
For each electric drive application, the mechanical load to be driven has a specific set of
requirements. The torque/speed possibilities of the electric drive can be represented as a speed
versus torque graph consisting of four quadrants. In the first quadrant, the electric torque and the
speed signs are both positive, indicating forward motoring since the electric torque is in the direction
of motion. In the second quadrant, the electric torque sign is negative and the speed sign is positive,
indicating forward braking since the electric torque is opposite to the direction of motion. In the third
quadrant, the electric torque and speed signs are both negative, indicating reverse motoring. In the
fourth quadrant, the electric torque sign is positive and the speed is negative, indicating reverse
braking. The drive braking is handled either by a braking chopper (dynamic braking) or by
bidirectional power flow (regenerative braking).

This diagram illustrates the four-quadrant operating region of an electric drive. Each quadrant has a
constant torque region from 0 to +/- nominal speed ωb and a region where the torque decreases
inversely with the speed from ωb to the maximum speed ωmax . This second region is a constant power
region and is obtained by decreasing the motor magnetic flux.
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Four-Quadrant Operation of an Electric Drive

Average-Value Models
The Electric Drives library allows two levels of simulation — detailed simulations or average-value
simulations. The detailed simulations use the Universal Bridge block to represent the detailed
behavior of rectifier- and inverter-controlled drives. This simulation level requires small simulation
time steps to achieve correct representation of the high frequency electrical signal components of the
drives.

The average-value simulations use average-value models of the power converters. When simulating in
average-value mode, the electrical input and output currents and voltages of the power converters
driving the electrical motors represent the average values of the real-life currents and voltages. By
doing so, the high frequency components are not represented and the simulations can use much
bigger time steps. Each power converter average-value model is described in the documentation for
each DC or AC model type. The time step used in a drive at average-value level can usually be
increased up to the smallest controller sampling time used in a model. For example, if a drive uses a
20 μs time step for the current loop and a 100 μs time step for the speed loop, then the simulation
time step in average-value mode can be increased up to 20 μs. Simulation time step guidelines are
given in the documentation for each model.
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Simulate a DC Motor Drive
In this section...
“Regenerative Braking” on page 4-6
“Example: Thyristor Converter-Based DC Motor Drive” on page 4-6

The seven DC drive models of the library, designated DC1 to DC7, are based on the DC brush motor
in the Electric Drives library. As in any electric motor, the DC brush motor consists of the stator
(fixed) part and the rotor (movable) part. The DC brush motor also has two types of windings — the
excitation or field winding and the armature winding. As the name implies, the field winding is used
to produce a magnetic excitation field in the motor, whereas the armature coils carry the induced
motor current. Since the time constant (L/R) of the armature circuit is much smaller than that of the
field winding, controlling speed by changing armature voltage is quicker than changing the field
voltage. Therefore the excitation field is fed from a constant DC voltage source, while the armature
windings are fed by a variable DC source. The latter source is produced by a phase-controlled
thyristor converter for the DC1 to DC4 models and by a transistor chopper for the DC5, DC6, and
DC7 models. The thyristor converter is fed by a single-phase AC source for DC1 and DC2 and by a
three-phase AC source for DC3 and DC4. Finally, the DC models can work in sets of quadrants.

Model Type of Converter Operation Quadrants
DC1 Single-phase thyristor converter I-II
DC2 Single-phase thyristor converter I-II-III-IV
DC3 Three-phase thyristor converter I-II
DC4 Three-phase thyristor converter I-II-III-IV
DC5 Chopper I
DC6 Chopper I-II
DC7 Chopper I-II-III-IV

Regenerative Braking
Operation in quadrants II and IV corresponds to forward and reverse braking, respectively. For the
DC models of the Electric Drives library, this braking is regenerative, meaning that the kinetic energy
of the motor-load system is converted to electric energy and returned to the power source. This
bidirectional power flow is obtained by inverting the motor's connections when the current becomes
null (DC1 and DC3) or by the use of a second converter (DC2 and DC4). Both methods allow inverting
the motor current in order to create an electric torque opposite to the direction of motion. The
chopper-fed DC drive models (DC5, DC6, DC7) produce regenerative braking in similar fashions.

Example: Thyristor Converter-Based DC Motor Drive
In this example, you build and simulate this simple thyristor converter-based DC motor drive:

4 Systems with Electric Drives

4-6



The example uses the DC3 model with a 200 hp DC motor parameter set during speed regulation. The
DC3 block models a two-quadrant three-phase thyristor converter drive. The motor connects to a load
and is driven to its 1750 rpm nominal speed.

Get the DC3 Model from the Electric Drives Library

1 Open a new window and save it as DC_example.
2 Add the Two-Quadrant Three-Phase Rectifier DC Drive block from the Simscape > Electrical >

Specialized Power Systems > Electric Drives > DC Drives library in the DC_example
window.

Connect the DC3 Model to a Voltage Source

All models of the library have three types of inputs: the electrical power inputs, the speed or torque
set point input (SP), and the mechanical torque input (Tm). Because the DC3 model is a three-phase
drive, it presents three electrical inputs: A, B, and C. In order for the DC3 model to work, you must
now connect those inputs to a proper voltage source:

1 Add a Three-Phase Source block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Electrical Sources library into your circuit. Connect the
voltage source outputs A, B, and C to the DC3 A, B, and C inputs, respectively.

In this example, you are driving a 200 hp DC motor of 500 V nominal armature voltage. The
mean output voltage V out of a three-phase thyristor rectifier bridge is given by

V out =
3 2 ⋅ Vl, rms

π ⋅ cosα

where Vl, rms is the phase-to-phase rms voltage value of the three-phase voltage source and α is
the firing angle value of the thyristors. For better voltage control, a lower firing angle limit is
usually imposed, and the maximum mean output voltage available from the rectifier bridge is
thus given by

V out, max =
3 2 ⋅ Vl, rms

π ⋅ cosαmin

where αmin is the lower firing angle limit. In our case, the lower firing angle limit used in the DC3
model is 20 degrees. With such an angle value and in order to have a maximum mean output
voltage value of 500 V to drive the 200 hp motor to its nominal speed, the needed phase-to-phase
rms voltage value given by the preceding equation is 370 V. Assuming the drive is connected to
an American electrical network, the closest standard voltage value is 460 V.
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2 Set the AC source phase-to-phase rms voltage value to 460 V and the frequency to 60 Hz. Name
the AC source 460 V 60 Hz.

Note that the voltage source amplitude and frequency values needed for each drive model of the
Electric Drives library can be found in the reference notes. The nominal values of the
corresponding motors are also included. The table contains the values corresponding to the DC3
200 hp model.

Drive Input Voltage Amplitude 460 V
Frequency 60 Hz

Motor Nominal Values Power 200 hp
Speed 1750 rpm
Voltage 500 V

In order to represent a real-life three-phase source, you must specify correct source resistance R
and inductance L values. To determine these, one usually uses the short-circuit power value Psc
and a given X /R ratio, where X = L ⋅ ω, ω being the angular frequency of the voltage source. As a
rule of thumb, the short-circuit power absorbed by the source impedance is supposed to be at
least 20 times bigger than the nominal power of the drive, and the X/R ratio is usually close to 10
for industrial plants.

The value of the source impedance Z is obtained by

Z = V2

Psc

where V is the phase-to-phase rms voltage value of the voltage source. For a high X /R ratio r, the
source resistance R is approximately equal to

R = Z
r  (4-1)

and the source inductance L to

L = Z
ω  (4-2)

In this example, the phase-to-phase rms voltage is worth 460 V and the source frequency is 60
Hz. If we assume a short-circuit power of 25 times the nominal drive power, we find a source
impedance of 0.056 Ω. For an X /R ratio of 10, using “Equation 4-1” and “Equation 4-2”, we find a
resistance value of 0.0056 Ω and an inductance value of 0.15 mH.

3 Clear the Specify impedance using short-circuit level check box, and set the AC source
resistance value to 0.0056 Ω and the inductance to 0.15 mH.

Connect the DC3 Model to a Mechanical Load

The Tm input represents the load torque applied to the shaft of the DC motor. If the values of the load
torque and the speed have opposite signs, the acceleration torque will be the sum of the
electromagnetic and load torques. Many load torques are proportional to the speed of the driven load
such as represented by the equation

Tmec = K ⋅ ωm = K′ ⋅ Nm  (4-3)

4 Systems with Electric Drives

4-8



where ωm is the speed in rad/s and N the speed in rpm. You will now build such a load.

To compute this type of mechanical load torque, the speed of the DC motor is needed. This one can be
obtained by using the outputs of the DC3 model. All drive models of the Electric Drives library have
four output vectors: Motor, Conv., Ctrl, and Wm. The Motor vector contains all motor-related
variables, the Conv. vector contains all converter voltage and current values, the Ctrl vector contains
all the regulation important values, such as the speed or torque reference signals, the speed or
torque regulation error, the firing angle value, and so on, and Wm is the motor speed in rad/s. All
input-output descriptions are available on the reference page of every model.

The motor speed (Wm) can be multiplied by the constant K of “Equation 4-3” to obtain the load
torque signal to be connected to the Tm input of the DC3 model:

1 Build the subsystem following and name it Linear load torque.

The constant K can be computed knowing that at nominal speed, the motor should develop
nominal torque. As shown in the table that contains the values corresponding to the DC3 200 hp
model, the DC motor used in this simulation has a nominal speed Nm,n of 1750 rpm. Since the
nominal mechanical output power Pm,n of the motor is 200 hp, the nominal mechanical load
torque Tmec,n can be computed following “Equation 4-4” (where viscous friction is neglected)

Pm, n = Tmec, n ⋅ ωm, n = Tn ⋅
π ⋅ Nm, n

30  (4-4)

where ωm,n is the nominal speed in rad/s. Using this equation, we find a nominal mechanical
torque of 814 N.m. Finally “Equation 4-3” gives us a K value of 4.44.

2 Set the constant value of the Linear load torque block to 4.44.
3 Connect the input and output of the Linear load torque block to Wm and Tm input of the DC3

block, respectively. Your model should now look like the following.

Define the Set Point

The set point input of the DC3 model can either be a speed value (in rpm) or a torque value (in N.m)
depending on the regulation mode (speed or torque regulation). In this example, we will set the DC3
block in speed regulation mode and drive the 200 hp DC motor to its nominal speed of 1750 rpm.

1 Add a Constant block into DC_example.
2 Connect the Constant block to the set point input of the DC3 model and name it Speed

reference.

 Simulate a DC Motor Drive

4-9



3 Set the set point to 1750 rpm.

Visualize Internal Signals

You must now use the DC3 model outputs to visualize interesting signals with a scope. Suppose you
need to visualize the following signals:

• The thyristor bridge firing angle
• The motor armature voltage
• The motor armature current and reference
• The speed reference and the motor speed

Note that all model input-output descriptions can be found in the corresponding reference notes.
Look under the mask of the DC3 block to see what signals are connected to the DC3 outputs. In the
Block tab, click Look Under Mask.

As you can see below, the firing angle is contained inside the Ctrl output vector. The firing angle
Alpha (see the DC3 block reference notes) is the second element of this vector.

The Motor vector (shown in the next figure) contains three of the needed signals. The armature
voltage and current signals are the first and third elements, respectively. The speed is the second
element of the Motor vector.
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Finally, the current and speed reference signals are the first and fourth elements of the Ctrl vector,
respectively (see the following figure). Note that the Ref. signal in the Regulation switch block would
be a torque reference in torque regulation mode.
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Internal bridge current and voltage signals can be extracted via the Conv. output, which is connected
to a multimeter output. To view these signals, add a Multimeter block from the Simscape >
Electrical > Specialized Power Systems > Fundamental Blocks > Measurements library into
your circuit. By clicking the Multimeter block, you can select the converter signals you want to
output. Refer to the Multimeter block reference page for more information on how to use the
Multimeter block.

By using a Selector block, you can now extract the needed signals from the three output vectors in
order to visualize them:

1 Build the following subsystem in order to extract all the needed visualization signals. Name it
Signal Selector.

2 Connect the Motor, Conv., and Ctrl outputs of the DC3 block to the Motor, Conv., and Ctrl inputs
of your Signal Selector block.

3 Copy two Scope blocks to your model. They will be used to display the output signals of the
Signal Selector block and the Multimeter block. For the first scope, open the Scope Parameters
dialog box. On the General tab, set the number of axes to 4, the simulation time range to auto,
and use a decimation of 20. Clear the Limit Data Points to last check box on the Data history
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tab. Connect the four outputs of the Signal Selector block to the inputs of the scope. Connect the
output of the Multimeter block to the input of the second scope.

Set the Fixed-Step Simulation Environment

All drive models of the library are discrete models. In order to simulate your system, you must now
specify the correct simulation time step and set the fixed-step solver option. Recommended sample
time values for DC drives, AC drives, and mechanical models can be found in the Remarks sections of
the corresponding block reference pages. The recommended sample time for the DC3 model is 5 µs.
Follow these steps:

1 Add a Powergui block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks library into DC_example. Open the Powergui, click Configure
Parameters, and in the Powergui block parameters dialog box set Simulation type to
Discrete. Set the sample time to 5 µs.

2 In the Simulation tab, click Model Settings. Select Solver. Under Solver selection select
fixed-step and discrete (no continuous states). Set the stop time to 12 seconds.

Before simulating your circuit, you must first set the correct DC3 internal parameters.

Set the High Power Drive Parameter Set

Many models of the Electric Drives library have two sets of parameters: a low-power set and a high-
power set. By default, all models are initially loaded with the low-power set. The DC3 model
parameters currently loaded in DC_example are those of a 5 hp drive.

You will now set the high-power drive parameters, which are those of a 200 hp drive. To do this, you
will use the graphical user interface:

1 Open the user interface by double-clicking the DC3 block.

The interface is divided following the three main parts of a drive system: the motor parameters
(DC Machine tab), the converter parameters (Converter tab), and the regulation parameters of
the drive controller (Controller tab).

2 To load the 200 hp parameters, click the Load button.

When you click the Load button, a window containing the low-power and high-power parameter
files of every AC and DC model appears. These files contain all the parameters used by the
graphical user interface. The name of each file begins with the model name followed by the
power value. The 200 hp version of DC3 is thus named dc3_200hp_params.

3 Select the dc3_200hp_params.mat file and click Load.

The 200 hp parameters are now loaded. Note that you can also save custom drive parameters by
using the Save button. When you do so, your custom parameters are saved in a MAT-file format and
can be reloaded at any time.

Set the Motor Inertia Value

All default inertias of the electric drives are “no-load” inertias that only represent rotor inertias.
When the motor is coupled to a load, the inertia parameter of the DC Machine tab represents the
combined inertias of the rotor and of the driven load. In this example, the no-load inertia of the DC3
200 hp motor is 2.5 kg*m^2. Since the drive is directly coupled to a load, you must increase this
value by the inertia of the load. Suppose that the new combined inertia amounts to 15 kg*m^2.
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1 In the DC Machine section of the dialog box, change the inertia value to 15 kg*m^2.
2 Click OK to apply the changes and close the dialog box.

Set the DC3 Controller Parameters and Simulation Results

The speed and current controllers of the DC3 block are both composed of a proportional-integral
regulator. You can find details on the regulators of each drive model on the corresponding block
reference pages. The user interface of each model contains a schematic of the drive controller
internal structure.

1 Open the user interface. Click the Controller tab and then the Schematic button.

All default regulation parameters (speed and current controller parameters) have been trimmed
for “no-load” inertias. Because the inertia has been modified, some changes need to be made in
the speed controller. The current controller should not be modified, the change of inertia having
little influence on the current control.

In order to visualize the changes that need to be made, run a simulation of the present circuit.
2 Start the simulation. The simulation results visualized on the scope are shown below.
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The armature current follows its reference but saturates at 450 A during the acceleration phase.
This saturation is a result of the current controller reference limit of 1.5 pu, which in turn causes
insufficient acceleration torque. The motor is unable to follow the 650 rpm/s default speed ramp.
Because the acceleration torque cannot be increased, to avoid a burnout of the armature circuit,
the speed ramp must be lowered by the same amount that the inertia was increased. If you
reduce the speed ramp ω̇ by an amount equal to the inertia increase, you can obtain the same
torque vs. speed curve (or current vs. speed) as the default value obtained with a 2.5 kg*m^2
inertia using the new inertia I.

Tem ω = I ⋅ ω̇ + Tmec + B ⋅ ω = I ⋅ ω̇ + K′ ⋅ ω + B ⋅ ω

The B ⋅ ω term represents the viscous friction in the drive where B is the viscous friction
coefficient.

In this case, we decrease the speed ramp slightly less than the inertia increase in order to have a
high enough acceleration, and set it to 200 rpm/s.

3 Open the user interface. In the Controller section, set the acceleration speed ramp parameter of
the speed controller menu to 200 rpm/s.

4 Start the simulation and observe the new results on the scope.
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The current regulation is very good, and no current regulator changes will be undertaken. The
speed regulation is satisfactory, but some improvements can be made: the initial tracking of the
speed reference can be faster, and the speed overshoot and the small speed ramping error
encountered during the accelerating phase can be reduced. A modification of the proportional
and integral gains of the PI speed regulator allows you to achieve these goals:

• By increasing the proportional gain of the speed controller, you increase the controller's
sensitivity because it reacts much faster to small speed regulation errors. As a result, initial
tracking of the speed reference is improved because the current reference issued by the
speed controller reacts faster.

• An increase of the integral gain allows the motor speed to catch up with the speed reference
ramp a lot faster during ramping periods, leading to a faster reaction to small speed error
integral terms that occur when a signal is regulated following a ramp. The controller will
react in order to diminish the speed error integral a lot faster by producing a slightly higher
acceleration torque when following an acceleration ramp.

Too high an increase of the proportional and integral gains can cause instability, the controller
becoming oversensitive. Too high gains can also cause current saturation. An easy way to adjust
the speed controller gains is to increase them step by step and to simulate the new configuration
after each change until the desired system performances are obtained (trial/error method).

When the current controller has to be trimmed, a good way to achieve this is to keep the rotor
still by setting a very high combined inertia value. This allows a decoupling of the electrical and
mechanical parameters. You then adjust the current controller parameters until the current
follows given current references perfectly. The same process applies to the current regulator as
those made above for speed regulation. Once the current regulator is trimmed, you can then trim
the speed regulator by resetting the combined inertia to its initial value.

5 Try different speed regulator values and observe the resulting changes in the system dynamics. A
proportional gain of 80 and an integral gain of 200 give very good results, as shown.
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The firing angle value lowers with the speed increase in order to generate a growing converter
output voltage. The converter is here working in rectifier mode, the power transiting from the AC
source to the DC motor. The voltage increase allows the converter to keep feeding current to the DC
motor during the acceleration phase, the armature voltage increasing proportionally with the speed.
The current increase observed during this phase is due to the increasing torque opposed by the load.
Around t = 8.5 s, the speed reaches its set point, and the armature current lowers to about 335 A
since no more acceleration torque is needed.

Before concluding this example, notice the two first-order filters used in the speed and current
controller diagrams in the controller schematic figure. These filters remove unwanted current and
speed harmonics in the current and speed measurement signals. These harmonics are caused by the
rectified output voltages of the three-phase full converters. The main ripple frequency introduced by
a three-phase full converter is equal to six times the voltage source frequency (6th harmonic). In the
case of this example, the first harmonic frequency is thus equal to 360 Hz. The cutoff frequency of the
first-order filters must at least be lower than 360 Hz. Since the filters are first-order filters, the cutoff
frequency must be a lot lower to have a reasonably good harmonic rejection. Keep in mind that too
low a cutoff frequency can cause system instability. In the case of chopper drives like DC5, DC6, and
DC7, the fundamental frequency is equal to the PWM frequency.

Simulate in Average-Value Mode

Most drive models can be simulated in average-value mode. In such mode, the Universal Bridge
blocks used to simulate the power converters driving the motors are replaced by average-value
converters. The average-value converter models used are described in the reference pages of each
drive model. This lets you increase the simulation time step and thus increase simulation speed.

Use the following procedure to simulate a model in average-value mode.

1 Open the user interface. Select the Average option in the Model detail level drop-down list.
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2 Select the Converter section.

Notice that it contains some extra parameters specific to average-value mode. These parameters
affect the external voltage source and are used by the average-value rectifier.

When simulating in average-value mode, the time step can be increased in order to run faster
simulations. A guideline is to increase the time step up to the smallest controller sampling time
used in the model. In this case the sampling time is the same for the speed and current
controllers and is equal to 100 µs.

3 Close the user interface and open the powergui block. Set Simulation type to Discrete. Set
the sample time to 100 µs. Run the simulation.

Notice that the simulation time is reduced. Observe the simulation results: the rectifier output
voltage and current ripples are not represented, you can see only the average value of these
signals. If you later try to visualize the input current, you will only see the 60 Hz fundamental
component of the detailed current.
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Simulate an AC Motor Drive

In this section...
“Dynamic Braking” on page 4-19
“Modulation Techniques” on page 4-19
“Open-Loop Volt/Hertz Control” on page 4-22
“Closed-Loop Speed Control with Slip Compensation” on page 4-23
“Flux-Oriented Control” on page 4-23
“Direct Torque Control” on page 4-25
“Example: AC Motor Drive” on page 4-26

To use the AC drive models of the Electric Drives library, you first specify the types of motors,
converters, and controllers used in the six AC drive models of the library designated AC1 to AC6. The
AC1, AC2, AC3, and AC4 models are based on the three-phase induction motor. This motor has a
three-phase winding at the stator and a wound rotor or a squirrel-cage rotor. The squirrel-cage rotor
consists of slots of conducting bars embedded in the rotor iron. The conducting bars are short-
circuited together at each end of the rotor by conducting rings. The AC5 model is based on a wound
rotor synchronous motor, and the AC6 model uses a permanent magnet synchronous motor. These AC
motors are fed by a variable AC voltage and frequency produced by an inverter. The type of inverter
used in the six AC drive models is a voltage source inverter (VSI) in the sense that this inverter is fed
by a constant DC voltage. This constant voltage is provided by an uncontrolled diode rectifier and a
capacitor (capacitive DC bus voltage).

Dynamic Braking
When the DC bus is provided by a diode rectifier, the drive doesn't have a bidirectional power flow
capability and therefore cannot perform regenerative braking. In the AC1, AC2, AC3, AC4, and AC6
models, a braking resistor in series with a chopper ensures the braking of the motor-load system.
This braking scheme is called dynamic braking. It is placed in parallel with the DC bus in order to
prevent its voltage from increasing when the motor decelerates. With dynamic braking, the kinetic
energy of the motor-load system is converted into heat dissipated in the braking resistor.

Modulation Techniques
The VSI inverters used in the AC drive models of the library are based on two types of modulation,
hysteresis modulation and space vector pulse width modulation (PWM).

The hysteresis modulation is a feedback current control method where the motor current tracks the
reference current within a hysteresis band. The following figure shows the operation principle of the
hysteresis modulation. The controller generates the sinusoidal reference current of desired
magnitude and frequency that is compared with the actual motor line current. If the current exceeds
the upper limit of the hysteresis band, the upper switch of the inverter arm is turned off and the
lower switch is turned on. As a result, the current starts to decay. If the current crosses the lower
limit of the hysteresis band, the lower switch of the inverter arm is turned off and the upper switch is
turned on. As a result, the current gets back into the hysteresis band. Hence, the actual current is
forced to track the reference current within the hysteresis band.
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Next figure shows the hysteresis current control modulation scheme, consisting of three hysteresis
comparators, one for each phase. This type of closed-loop PWM is used in AC3 and AC5 models.

The space vector modulation technique differs from the hysteresis modulation in that there are not
separate comparators used for each of the three phases. Instead, a reference voltage space vector Vs
is produced as a whole, sampled at a fixed frequency, and then constructed through adequate timing
of adjacent nonzero inverter voltage space vectors V1 to V6 and the zero voltage space vectors V0, V7.
A simplified diagram of a VSI inverter is shown below. In this diagram, the conduction state of the
three legs of the inverter is represented by three logic variables, SA, SB, and SC. A logical 1 means
that the upper switch is conducting and logical 0 means that the lower switch is conducting.
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Simplified Diagram of a VSI PWM Inverter

In this diagram, the conduction state of the three legs of the inverter is represented by three logic
variables, SA, SB, and SC. A logical 1 means that the upper switch is ON and logical 0 means that the
lower switch is ON.

The switching of SA, SB, SC results in eight states for the inverter. The switching states and the
corresponding phase to neutral voltages are summarized in the table that lists states, inverter
operations, and space voltage vectors. The six active vectors are an angle of 60 degrees apart and
describe a hexagon boundary. The two zero vectors are at the origin.

As an example, for the location of the Vs vector shown in the diagram of the inverter space-vector
voltage, the way to generate the inverter output is to use the adjacent vectors V1 and V2 on a part-
time basis to satisfy the average output demand. The voltage Vs can be resolved as:

Vb = 2
3Vs ⋅ sinδ

Va = Vs ⋅ cosδ− 1
2Vb

Va and Vb are the components of Vs along V1 and V2, respectively. Considering the period Tc during
which the average output must match the command, write the time durations of the two states 1 and
2 and the zero voltage state as:

ta = 3
2 ⋅

Va
Vd
⋅ Tc

tb = 2
3 ⋅

Vb
Vd
⋅ Tc

tz = Tc− ta + tb

State SA SB SC Inverter Operation Space Voltage Vector
0 1 1 1 Freewheeling V0

1 1 0 0 Active V1

2 1 1 0 Active V2

3 0 1 0 Active V3

4 0 1 1 Active V4

5 0 0 1 Active V5
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State SA SB SC Inverter Operation Space Voltage Vector
6 1 0 1 Active V6

7 0 0 0 Freewheeling V7

Open-Loop Volt/Hertz Control
The AC machine stator flux is equal to the stator voltage to frequency ratio because

φ(t) =∫v(t)dt

where

v(t) = 2 ⋅ V ⋅ sin(ω ⋅ t)

therefore

φ(t) = 2 ⋅ V
ω ⋅ cos(ω ⋅ t)

Because the motor is fed with a variable AC source voltage and frequency, it is important to maintain
the V/Hz constant in the constant torque region if magnetic saturation is to be avoided. A typical V/Hz
characteristic is shown below. Notice that the straight line has a small voltage boost in order to
compensate for resistance drop at low frequency. Open-loop V/Hz control is used with low-dynamics
applications such as pumps or fans where a small variation of motor speed with load is tolerable. The
AC1 model is based on an open-loop V/Hz controller.
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Closed-Loop Speed Control with Slip Compensation
In this type of control, a slip speed command is added to the measured rotor speed to produce the
desired inverter frequency. A PI-based speed regulator produces the slip command. The desired
inverter frequency generates the voltage command through a V/Hz characteristic such as the one
shown above. The AC2 model is based on a closed-loop speed control that uses V/Hz and slip
regulation.

Flux-Oriented Control
The construction of a DC machine is such that the field flux is perpendicular to the armature flux.
Being orthogonal, these two fluxes produce no net interaction on one another. Adjusting the field
current can therefore control the DC machine flux, and the torque can be controlled independently of
flux by adjusting the armature current. An AC machine is not so simple because of the interactions
between the stator and the rotor fields, whose orientations are not held at 90 degrees but vary with
the operating conditions. You can obtain DC machine-like performance in holding a fixed and
orthogonal orientation between the field and armature fields in an AC machine by orienting the stator
current with respect to the rotor flux so as to attain independently controlled flux and torque. Such a
control scheme is called flux-oriented control or vector control. Vector control is applicable to both
induction and synchronous motors. We will see now how it applies to induction motors.

Considering the d-q model of the induction machine in the reference frame rotating at synchronous
speed ωe,

Vqs = Rsiqs + d
dtφqs + ωeφds

Vds = Rsids + d
dtφds− ωeφqs

0 = Rriqr + d
dtφqr + (ωe− ωr)φdr

0 = Rridr + d
dtφdr − (ωe− ωr)φqr
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Te = 1.5p
Lm
Lr

(φdriqs− φqrids)

where

φqs = Lsiqs + Lmiqr

φds = Lsids + Lmidr

φqr = Lriqr + Lmiqs

φdr = Lridr + Lmids

The field-oriented control implies that the ids component of the stator current would be aligned with
the rotor field and the iqs component would be perpendicular to ids. This can be accomplished by
choosing ωe to be the speed of the rotor flux and locking the phase of the reference frame system
such that the rotor flux is aligned precisely with the d axis, resulting in

φqr = 0 d
dtφqr = 0

and

φdr = φr

which implies that

ωsl = (ωe− ωr) =
LmRr
φrLr

iqs

and that

Te = 1.5p
Lm
Lr

(φriqs)

It also follows that

d
dtφr = −

Rr
Lr

φr +
LmRr

Lr
ids

The analogy with DC machine performance is now clear. The electric torque is proportional to the iqs
component, whereas the relation between the flux φr and the ids component is given by a first-order
linear transfer function with a time constant Lr / Rr.

You cannot directly measure the rotor flux orientation in a squirrel-cage rotor induction machine. It
can only be estimated from terminal measurements. An alternative way is to use the slip relation
derived above to estimate the flux position relative to the rotor, as shown. The latter control scheme
is called indirect field-oriented control and is used in the AC3 model.
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Direct Torque Control
The field-oriented control is an attractive control method but it has a serious drawback: it relies
heavily on precise knowledge of the motor parameters. The rotor time constant is particularly
difficult to measure precisely, and it varies with temperature.

A more robust control method consists first in estimating the machine stator flux and electric torque
in the stationary reference frame from terminal measurements. The following relations are used:

φds =∫ Vds− Rsids dt

φqs =∫ Vqs− Rsiqs dt

φ s = φds
2 + φqs

2 ∠atan
φqs
φds

Te = 1.5p(φdsiqs− φqsids)

The estimated stator flux and electric torque are then controlled directly by comparing them with
their respective demanded values using hysteresis comparators. The outputs of the two comparators
are then used as input signals of an optimal switching table. The following table outputs the
appropriate switching state for the inverter.
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Switching Table of Inverter Space Vectors

S(1) S(2) S(3) S(4) S(5) S(6)

1
1 V2 V3 V4 V5 V6 V1

0 V0 V7 V0 V7 V0 V7

-1 V6 V1 V2 V3 V4 V5

-1
1 V3 V4 V5 V6 V1 V2

0 V7 V0 V7 V0 V7 V0

-1 V5 V6 V1 V2 V3 V4

Example: AC Motor Drive
In this example, you build and simulate this simple induction motor drive system:

The example illustrates the use of the AC4 model with a 200 hp induction motor parameter set during
torque regulation. The AC4 block models a DTC drive. During this example, the motor is connected to
a fan and its reaction to torque steps is simulated.

Get the AC4 Model from the Electric Drives Library

1 Open a new window and save it as ac_example.
2 Add a DTC Induction Motor Drive block from the Simscape > Electrical > Specialized Power

Systems > Electric Drives > AC Drives library in the ac_example window.

Connect the AC4 Model to a Voltage Source

As with the DC example, you must now connect the AC4 block to a proper voltage source:

1 Add a Three-Phase Source block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Electrical Sources library into your circuit. Connect the
voltage source outputs A, B, and C to the AC4 A, B, and C inputs, respectively.

In this example, we will be driving a 200 hp induction motor of 460 V nominal armature voltage
and 60 Hz nominal frequency. As specified in the DC example, the voltage source amplitude and
frequency values needed for each drive model of the Electric Drives library can be found in the
reference notes. The nominal values of the corresponding motors are also included. The table
contains the values corresponding to the AC4 200 hp model.
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Drive Input
Voltage

Amplitude 460 V
Frequency 60 Hz

Motor Nominal
Values

Power 200 hp
Speed 1800 rpm
Voltage 460 V

Set the AC source voltage amplitude and frequency values to 460 V and 60 Hz, respectively.
2 Set the AC source phase-to-phase rms voltage value to 460 V, and the frequency to 60 Hz. Name

the AC source 460 V 60 Hz.

To represent a real-life three-phase source, you must specify correct source resistance R and
inductance L values. The procedure to determine these values is described in the example,
“Connect the DC3 Model to a Voltage Source” on page 4-7. Following this procedure, you
determine a resistance value of 0.0056 Ω and an inductance value of 0.15 mH.

3 Set the AC source resistance value to 0.0056 Ω and the inductance to 0.15 mH.

Connect the AC4 Model to a Mechanical Load

The Tm input of the AC4 block represents the load torque applied to the shaft of the induction motor.
In this case, the load torque is opposed by a fan. This type of torque is typically a quadratic function
of the speed, as shown in “Equation 4-5”:

Tm = K ⋅ ωm
2 = K′ ⋅ Nm

2  (4-5)

where ωm is the speed in rad/s and Nm is the speed in rpm.

1 Build the subsystem of the following figure and name it Fan.

The constant K must be imposed so that at nominal speed, the motor develops nominal torque.
This torque can be determined using “Equation 4-4”. Using this equation, there is a nominal
value of 790 N.m. Finally, “Equation 4-5” gives a K value of 0.022.

2 Set the constant value K to 0.022.
3 Connect the Fan block to the block. Your schematic should now look like the following schematic.
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Define the Set Point

Now define the set point (SP) input of AC4. For this example, the induction motor torque is controlled
and a series of torque set points is imposed. A series of set points can be defined with the help of the
Stair Generator block.

1 Add a Stair Generator block from the Simscape > Electrical > Specialized Power Systems >
Control & Measurements > Pulse & Signal Generators library into ac_example. Connect
the block to the set point input of the AC4 model and name it Torque reference.

The Stair Generator block generates a signal changing at specified times. During this example,
generate the following torque series.

t (s) Torque Set Point (N.m)
0 0
0.02 600
0.25 0
0.5 -600
0.75 0

2 Set the Time field of the Stair Generator block to [0.02 0.25 0.5 0.75]. Set the Amplitude
field of theStair Generator block to [600 0 -600 0].

Visualize Internal Signals

Use the AC4 model outputs to visualize interesting signals such as:

• The motor torque value and set point
• The motor speed
• The motor flux modulus
• The motor statoric currents
• The DC bus voltage

All motor variable values can be read via the Motor vector. The Conv. vector contains all converter
related data. The Ctrl vector includes all reference signals and other control values.

The contents of the Conv. vector can be easily determined by adding a Multimeter block to the model.

Following the input-output description of the reference notes, the torque reference signal is the first
signal of output vector Ctrl.

1 Build the following subsystem to extract all the needed visualization signals. Name the
subsystem Signal Selector.
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The rad2rpm block contains the constant 30/π to convert the rotor speed from rad/s to rpm. A
Real-Imag to Complex block and a Complex to Magnitude-Angle block compute the magnitude of
the flux vector.

2 Copy a Scope block to your model to display the output signals of the Signal Selector block. Open
the Scope Parameters dialog box. On theGeneral tab, set the number of axes to 5, set the
simulation time range to auto, and use a decimation of 25. Clear the Limit Data Points to last
check box on the Data history tab. Connect the five outputs of the Signal Selector block to the
inputs of the scope.

Set the Fixed-Step Simulation Environment

All drive models of the library are discrete models. To simulate your system, you must now specify the
correct simulation time step and set the fixed-step solver option. Recommended sample time values
for DC drives, AC drives, and mechanical models are in the Remarks sections of the corresponding
block reference pages. The recommended sample time for the AC4 model is 1 µs.

1 Add a powergui block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks library into ac_example. Open the Powergui block. Set Simulation type
to Discrete. Set Sample time to 1 µs.

2 In the Simulation tab, click Model Settings. Select Solver. Under Solver selection, select
fixed-step and Discrete (no continuous states). Set the Stop time to 1 s and the
Fixed-step size to 1e-6.

Before simulating your circuit, you must first set the correct AC4 internal parameters.

Set the High Power Drive Parameter Set

As explained in the DC example, many drive models of the Electric Drives library have two sets of
parameters: a low power set and a high power set. By default, all models are initially loaded with the
low power set. The AC4 model parameters currently loaded in ac4_example are those of a 3 hp
drive.

You now set the high power drive parameters, which are those of a 200 hp drive. To do this, you use
the Load button of the user interface as specified in the DC example:
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1 Open the user interface by double-clicking the AC4 block.
2 To load the 200 hp parameters, click the Load button.
3 Select the ac4_200hp.matfile and click Load.

The 200 hp parameters are now loaded.

Set the Motor Inertia Value

You must now set the motor inertia value. Note that the inertia values currently specified in each AC
and DC model are “no-load” inertias that only represent the inertia of the rotor. If the motor is
coupled to a load, these values must be increased by the load inertias. In this case, the current value
of the inertia amounts to 3.1 kg*m^2. Assume that the combined inertia of the motor and the fan
amounts to 10 kg*m^2. Note that the use of a flexible shaft connected between the motor and the fan
would allow decoupling of the motor and load inertias. In that case, the inertia value of the AC4 block
would only be the sum of the rotor and shaft inertias.

1 In the Asynchronous Machine section of the dialog box, change the inertia value to 10
kg*m^2.

2 Click OK to apply the changes and close the dialog box.

Set the Braking Chopper Resistance Value

The three-phase inverter of the DTC system is fed by a DC voltage produced by a three-phase diode
rectifier. A capacitor located at the output of the rectifier reduces the DC bus voltage ripples. A
braking chopper block has also been added between the rectifier block and the inverter block, in
order to limit the DC bus voltage when the motor feeds back energy to the drive (shown below). This
energy is dissipated through a resistance when the DC bus voltage is too high.

The parameters of the braking chopper are available in the Converters and DC bus section of the
dialog box.
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The braking chopper parameters are currently set to limit the DC bus voltage to about 700 V.
Regarding the power P to be dissipated and the DC bus voltage limit Vlim, you can use the following
equation to set the chopper resistance value:

Rchop =
Vlim

2

P

A resistance of 3.3 Ω will dissipate 200 hp at 700 V.

Set the DC Bus Initial Voltage Value

Notice that the DC bus capacitance has a large value to reduce DC voltage ripples to small values.
The AC4 model does not include a DC bus capacitor preload system. If you start the simulation with
too small an initial bus voltage, too high initial currents are drawn from the rectifier to charge the
capacitor. These high current values could damage a real-life system. You must set an initial DC bus
voltage value to avoid such currents. This initial bus voltage must be equal to the rectified peak value
of the AC source. If the AC voltage source amplitude is equal to 460 V RMS, the rectified DC bus
voltage obtained with a capacitor is about 460 × 2V.

1 Open the Initial States tool of the powergui block. Set the Uc_DTC Induction Motor
Drive/Braking chopper/Cbus value to 650 V. Click Apply and then Close.

Setting the DC Bus Initial Voltage Value

Set the AC4 Controller Parameters

The control system of AC4 has two main parts, a speed controller and a torque and flux controller
(DTC). Information on these two parts is in the corresponding reference notes. For a quick idea of the
internal structure of the drive control system, a schematic is available inside the user interface of the
model. Open the schematics related to the AC4 model.

1 Open the user interface. Click the Controller section and then the Schematic button. You
should see the controller schematics shown.
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The speed controller consists of a simple proportional-integral regulator. The parameters of this
controller are the proportional and integral gains, the speed ramp values, the low-pass filter
cutoff frequency, the torque reference limits, and the sampling time. In this example, we will only
control the motor torque; the speed controller is not used. Refer to “Set the DC3 Controller
Parameters and Simulation Results” on page 4-14 for more details on how to trim a PI controller.

Regarding the DTC controller, there is not much to trim. The parameters are the torque and flux
bandwidths, the initial machine flux, the maximum switching frequency, and the DTC controller
sampling time. All these parameters are already trimmed and should normally not be modified.

The default regulation mode is speed regulation. In order to have torque regulation, you must
change the regulation mode in the Controller section of the user interface.

2 In the Controller section of the user interface, select Torque regulation for the Regulation
type field. Click OK to apply the changes and close the dialog box.

The circuit is now ready for simulation.
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Observe the motor's fast torque response to the torque set point changes. From 0.02 s to 0.25 s, the
fan speed increases because of the 600 N.m acceleration torque produced by the induction motor. At t
= 0.25 s, the electromagnetic torque jumps down to 0 N.m and the speed decreases because of the
load torque opposed by the fan. At t = 0.5 s, the motor torque develops a -600 N.m torque and allows
braking of the fan. During braking mode, power is sent back to the DC bus and the bus voltage
increases. As planned, the braking chopper limits the DC bus voltage to 700 V. At t = 0.75 s, the
electromagnetic torque jumps back to 0 N.m and the speed settles around -10 rpm and decreases
toward 0 rpm. Notice that the flux stays around 0.8 Wb throughout the simulation. The flux and
torque oscillation amplitudes are slightly higher than 0.02 Wb and 10 N.m respectively as specified in
the user interface. This is due to the combined effects of the 15 µs DTC controller sampling time, the
hysteresis control, and the switching frequency limitation.

It is interesting to visualize the rotating flux produced by the stator. To do so, use an XY Graph block.

1 Copy an XY Graph block inside the Signal Selector block of ac_example.
2 Connect the scope as shown.
3 Run a new simulation.
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This plot shows the simulation results of the XY Graph block. The rotating field is clearly visible. Its
modulus is about 0.8 Wb and its bandwidth is slightly bigger than 0.2 Wb.

Simulation Results
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Mechanical Models
In this section...
“Mechanical Shaft Block” on page 4-35
“Speed Reducer Block” on page 4-35

Mechanical Shaft Block
The Mechanical Shaft block is used to simulate a shaft interconnecting mechanically a motor drive
block to a mechanical load block. Hence the Mechanical Shaft block allows decoupling of the
mechanical parameters of the load from the ones of the motor. The mechanical shaft is represented
by its stiffness coefficient Ksh and damping coefficient Dsh. The shaft transmitted torque Tsh is
computed with

Tsh = Ksh∫ ωm− ωl dt + Dsh(ωm− ωl)

where ωm and ωl are the speeds of the motor and the load, respectively.

The following figure shows the interconnections between the Motor Drive block, the Mechanical
Shaft block, and the Mechanical Load block. The Mechanical Shaft block has two inputs, the load and
motor speeds, and one output, the shaft transmitted torque. Note that the transmitted torque is
applied at the load torque input of the motor. The transmitted torque is also applied at the input of
the Mechanical Load block, which can be modeled by

Tsh = Jl
dωl
dt + Bl ⋅ ωl

where Jl and Bl are the inertia coefficient and the viscous friction coefficient, respectively.

Interconnection Diagram of the Transmission Shaft

Speed Reducer Block
In many applications, the mechanical load requires high torque at low speed rather than low torque
at high speed. This can be obtained by interconnecting the motor to the mechanical load by a speed
reducer. The Speed Reducer block of the Electric Drives library is composed of a high-speed shaft and
a low-speed shaft connected by a speed reduction device, as shown in the following figure. The Speed
Reducer block has seven parameters: the stiffness and damping coefficients of the high-speed and the
low-speed shafts, the reduction ratio, and the speed reduction device inertia and efficiency. The two
inputs of the Speed Reducer block are the motor speed (high speed) and the load speed (low speed)
while the outputs are the high-speed shaft torque Th and the low-speed shaft torque Tl. The high-
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speed shaft torque must be applied to the load torque input of the motor. The low-speed shaft torque
must be applied directly to the Mechanical Load block.

Interconnection Diagram of the Three Internal Blocks of the Speed Reducer Block

4 Systems with Electric Drives

4-36



Mechanical Coupling of Two Motor Drives
In this section...
“Introduction” on page 4-37
“System Description” on page 4-38
“Speed Regulated AC4 with Torque Regulated DC2” on page 4-39
“Torque Regulated AC4 with Speed Regulated DC2” on page 4-40

Introduction
In order to test a motor drive under various load conditions, you must provide a variable and
bidirectional load at the motor shaft. Moreover, an ideal load should also allow returning the
absorbed energy from the motor back to the power grid as electric energy. Such a load can be
implemented using a four-quadrant motor drive such as the DC2 or DC4 models. Either of these two
motor drives can be conveniently coupled to the motor drive model being tested by the use of the
mechanical shaft model.

Therefore this case study will consist of coupling the AC4 motor drive model to the DC2 motor drive.
The AC4 motor drive is a DTC three-phase induction motor-based drive. The DC2 motor drive is a
single-phase dual-converter DC motor drive. In such a system, one drive is speed regulated while the
other is torque regulated, but each drive can operate either as a motor or as a generator, as will be
seen later. The DC2 motor drive is rated 3 hp, 240 V, 1800 rpm, and the AC4 motor drive is rated 3
hp, 380 V, 60 Hz, 4 poles.

Note It is also possible to couple two motor drives using the Mechanical input menu located in the
lower part of the GUI. The next figure indicates how to model a stiff shaft interconnection in a motor-
generator configuration. The speed output of drive 1 (mechanical input is load torque) is connected to
the speed input of drive 2 (mechanical input is motor speed), while drive 2 electromagnetic torque
output Te is applied to the mechanical torque input Tm of drive 1. The Kw factor represents the speed
reduction ratio. Also, because inertia J2 and viscous friction F2 are ignored in the machine of drive 2,
they have to be added in the machine tab of drive 1.
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System Description
The complete system consisting of two motor drives mechanically coupled together is shown in “SPS
Diagram of the Two Interconnected Drives” on page 4-38. The mechanical shaft model is contained
in the third block of the diagram. If you open this block, you will see, as in “Interconnections of the
Mechanical Shaft Model” on page 4-39, that the AC4 and DC2 motor speed signals are connected
respectively to the Nm and Nl inputs of the mechanical shaft model. The output Tl of the mechanical
shaft model represents the mechanical torque transmitted from the AC4 motor to the DC2 generator.
Therefore, this output is connected directly to the mechanical torque input of AC4, and is also sign
inverted and then connected to the mechanical torque input of DC2, as can be seen in “SPS Diagram
of the Two Interconnected Drives” on page 4-38.

SPS Diagram of the Two Interconnected Drives
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Interconnections of the Mechanical Shaft Model

Speed Regulated AC4 with Torque Regulated DC2
To begin with, the AC4 model operates as a speed regulated motor loaded by the DC2 model
operating as a torque regulated generator. This setup, contained in the cs_coupling_1 file, allows
the testing of the AC4 model speed ramps and load torque disturbance responses. Note that in steady
state, the signs of the AC4 electric torque and speed should be the same, confirming that AC4
operates as a motor. The DC2 electric torque and speed should be of opposite signs, confirming that
DC2 operates as a generator. This is in line with the sign of the reference torque applied to the DC2
motor drive that is opposite to the speed sign.

“Speed Ramp and Load Disturbance Torque Responses of the AC4 Motor Drive” on page 4-40 shows
the results of an AC4 motor drive startup at nearly full load followed by the application of load
disturbance torques. You can see that the AC4 motor speed is exactly superposed to the reference
ramp of +400 rpm/s since the AC4 electric torque maximum limit is high enough. The AC4 motor
speed reaches the demanded value of 400 rpm at t = 1.0 s. At that moment, the AC4 electric torque
drops down to 10 N.m. Then at t = 1.4 s, a reference torque of 0 N.m is applied to DC2; the AC4
electric torque immediately drops down to zero in order to maintain the regulated speed. At t = 1.9 s,
a reference torque of +10 N.m is applied to the DC2 drive, forcing AC4 to operate as a generator and
DC2 as a motor (look at the speed and torque signs of the two drives). Finally, a negative reference
speed ramp of -400 rpm/s is applied to AC4 at t = 2.3 s. Note that, again, AC4 precisely follows the
demanded ramp. A new steady state is reached at t = 2.8 s, and the AC4 electric torque stabilizes at
-10 N.m. “Speed Ramp and Load Disturbance Torque Responses of the AC4 Motor Drive” on page 4-
40 also shows the mechanical torque transmitted by the shaft, which is similar to the AC4 electric
torque but contains less ripple.
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Speed Ramp and Load Disturbance Torque Responses of the AC4 Motor Drive

Torque Regulated AC4 with Speed Regulated DC2
This time, AC4 operates as a torque regulated motor loaded by the DC2 drive that is speed regulated.
The complete system is shown in “SPS Diagram of the Two Interconnected Drives” on page 4-41 and
is contained in the cs_coupling_2 file. The interconnection of the mechanical shaft model with the
two drives remains unchanged with respect to “Interconnections of the Mechanical Shaft Model” on
page 4-39. All the regulator gains of both drives are the same as in the previous case. The setup is
tested in the same conditions as before.
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SPS Diagram of the Two Interconnected Drives

“Speed Ramp and Load Disturbance Torque Responses of the DC2 Motor Drive” on page 4-42 shows
the results of a DC2 motor drive startup at nearly full load followed by the application of load
disturbance torques. Note that the DC2 motor speed follows the reference ramp of 400 rpm/s with
some overshoot and undershoot. The DC2 motor speed reaches the demanded value of 400 rpm at
t = 1.0 s and stabilizes completely at t = 1.2 s. Then at t = 1.4 s, a reference torque of 0 N.m is
applied to AC4; observe how fast the AC4 torque responds. At t = 1.9 s, a reference torque of +10
N.m is applied to the AC4 drive, forcing DC2 to operate as a generator and AC4 as a motor (look at
the speed and torque signs of the two drives). Observe that the DC2 speed overshoots each time the
load torque changes. Finally, a negative reference speed ramp of -400 rpm/s is applied to DC2 at t =
2.3 s. The DC2 speed follows well but presents a small overshoot and a small undershoot. A new
steady state is reached at t = 2.8 s, and the DC2 electric torque stabilizes at -10 N.m. “Speed Ramp
and Load Disturbance Torque Responses of the DC2 Motor Drive” on page 4-42 also shows the
mechanical torque transmitted by the shaft, which is very similar to the negative of the DC2 electric
torque but with more ripple.

You can see from the results shown in “Speed Ramp and Load Disturbance Torque Responses of the
AC4 Motor Drive” on page 4-40 and “Speed Ramp and Load Disturbance Torque Responses of the
DC2 Motor Drive” on page 4-42 that the speed ramp responses are more precise and the load torque
disturbance more efficiently rejected with the AC4 drive than with the DC2 drive. This is essentially
due to the fast dynamics of the AC4 electric torque. Recall that the AC4 drive consists of a direct
torque controller based on hysteresis comparators and high-frequency switching, while the DC2 drive
relies entirely on naturally commutated thyristor converters. However, the torque ripple magnitude of
the AC4 drive is higher than for the DC2 drive.
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Speed Ramp and Load Disturbance Torque Responses of the DC2 Motor Drive
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Winding Machine

In this section...
“Introduction” on page 4-43
“Description of the Winder” on page 4-43
“Block Description” on page 4-44
“Simulation Results” on page 4-46

Introduction
Winding machines, also called winders, are used in the pulp and paper industry as well as in the
textile, steel, and plastic industries.

An important characteristic of most winders is that the force acting on the winding material must
remain constant. This is realized by controlling the winder torque proportionally to the roll variable
radius. Note that it is assumed here that the material is fed to the winder at constant speed. The
latter implies that the winder angular speed is forced to decrease proportionally to the roll radius.
Hence the winding machine is a constant power application, because the product of the winder
mechanical torque and its angular speed is constant.

Description of the Winder
The following graphic shows a physical representation of a winder, where W is the roll width, r1 the
core radius, r2 the roll radius, and MT the material thickness.

Physical Representation of a Winder

Beside the variables described above, the simulation also requires the following parameters and
variables:

MV Material mass per unit volume
L Material length
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M Material mass
Jr Material inertia
Jc Winder core inertia
Bω Winder viscous friction coefficient

Diagram of the Complete Winding System

“Diagram of the Complete Winding System” on page 4-44 shows a Simulink diagram of the complete
winding system. This system consists of four blocks: the Winder Control block, the DC Motor Drive
block, the Speed Reducer block, and the Winder Model block.

Block Description
Winder Model Block

This block computes various winder variables using the following equations.

Surface speed S

S = ω ⋅ r2

where ω is the winder angular speed.

Material length L

L =∫Sdt

Roll radius r2
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r2 = L ⋅MT
π + r1

2

Material mass M

M = MV ⋅ π ⋅W ⋅ r2
2− r1

2

Total winder inertia Jt and material inertia Jω

Jt = Jω + Jc

where

Jω = 1
2 ⋅M ⋅ r2

2 + r1
2

The winder angular speed is calculated using the following differential equation

Te = Jt
dω
dt + B ⋅ ω + Tl

where Tl is the winder load torque and Te is the motor drive electric torque. The calculation of the
tension or force F applied on the winding material is based on the same differential equation as
above, where the load torque is expressed as Tl = F·r2. Rearranging the equations in term of F yields

F =
Te− Jt ⋅ ω̇ − B ⋅ ω

r2

This estimated force is fed back to the Winder Control block in order to be regulated.

Note that in the above two equations, the term ω ⋅ J̇ t is omitted because it has been found to be
negligible for the case considered here.

Winder Control Block

This block contains a PID controller that regulates the tension applied on the winding material. The
output of this force controller is a torque reference set point for the winder motor drive. The Winder
Control block shown in “Winder Control Block” on page 4-46 also contains the tension versus speed
characteristic of the external process supplying the material to the winder at constant speed. This
characteristic consists in a straight line of slope equal to the ratio of the reference material tension
on the constant surface speed.
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Winder Control Block

DC Motor Drive Block

This block contains a complete two-quadrant three-phase rectifier DC drive with its three-phase
voltage source. The DC drive is rated 5 hp, 220 V, 50 Hz and is torque regulated.

Speed Reducer Block

The DC motor is connected to the winder by a Speed Reducer block. The speed reduction ratio is 10,
allowing the winder to turn 10 times slower than the motor, while the shaft-transmitted torque is
almost 10 times higher on the low-speed side. The torque required by the winder in this case study is
approximately 200 N.m.

Simulation Results
The winding machine simulation model is contained in the file cs_winder. The simulation
parameters are those of a paper winding application where the roll width is 10 m. Open the file and
look at the parameters in the Simulink masks of the Winder Model block, the Winder Control block,
the DC Motor Drive block, and the Speed Reducer block. In the Winder Control block, you will see
that the tension set point is 300 N and the surface speed set point is 5 m/s.

The rate of change of the tension set point is limited internally to 25 N/s so that the tension set point
requires 12 s to reach its final value. Note that the simulation time step of the complete model is 1 µs
in order to comply with the speed reducer, which is the block that requires the smallest simulation
time step.

Start the simulation and observe how well the material tension and the surface speed ramp to their
prescribed values in “Material Tension” on page 4-47 and “Surface Speed” on page 4-47
respectively. “Winder Angular Speed, Mechanical Torque, and Power” on page 4-48 shows the
winder angular speed, mechanical torque, and power. Note that once the operating point is reached
(300 N, 5 m/s), the angular speed decreases and the torque increases, both linearly, so that the power
is approximately constant. The reason why the mechanical power is not precisely constant but
decreases slightly is that the decreasing speed winder own inertia supplies a small part of the
constant power required by the winder.
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Material Tension

Surface Speed
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Winder Angular Speed, Mechanical Torque, and Power
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Robot Axis Control Using Brushless DC Motor Drive
In this section...
“Introduction” on page 4-49
“Description of the Robot Manipulator” on page 4-49
“Position Control Systems for Joints 1 and 2” on page 4-50
“Modeling the Robot Position Control Systems” on page 4-51
“Tracking Performance of the Motor Drives” on page 4-53

Introduction
Robots are complex electromechanical systems where several electric drives are used to control the
movement of articulated structures. The design of axis control systems for robots can be greatly
facilitated by the Electric Drives library, which can model complete axes including motor drives,
speed reducers, mechanical model of the arm, and controllers in the same diagram.

This case study presents the modeling and simulation of a six-degrees-of-freedom robot manipulator
using Electric Drives library blocks in combination with Simulink blocks. The two main joints models
are built using brushless DC motor drives that are connected to the rest of the manipulator through
speed reducers (a model included in the Electric Drives library). The control system, which consists
essentially of two position control loops, is built with Simulink blocks. The inner speed and torque
control loops are already included in the drive model. The rest of the manipulator and its load are
represented by two Simulink nonlinear models, one for each motor drive.

Detailed modeling is presented to demonstrate the versatility of the Electric Drives library. The
operation of the joints using typical trajectories is simulated and results are presented.

Description of the Robot Manipulator
The robot considered in this example is a general-purpose six-degrees-of-freedom robot manipulator
(GMF S-360) of parallelogram linkage type. “Six-Degrees-of-Freedom Robot Manipulator” on page 4-
50 shows the structure of the robot and its workspace. The robot has six axes. The three axes (Θ1,
Θ2, Θ3) shown in the figure are for arm positioning and the others (α, β, γ) are for orientation of the
end effector. In the horizontal plane, the robot can cover a 300 degree arc (Θ1 = -150° to Θ1 = 150°).

The robot's axes are driven by brushless DC motors that are modeled by permanent-magnet
synchronous motors fed by PWM inverters (AC6 drive model). Speed reducers of belt type and
gearbox are used to transmit torque from the motors to the joints.
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Six-Degrees-of-Freedom Robot Manipulator

Position Control Systems for Joints 1 and 2
We will consider in particular the two first joints (axis 1 and axis 2), which drive the entire robot and
its load. The first axis uses a 2 kW brushless DC motor and a 1:130 speed reducer. The second axis
uses a 1 kW brushless DC motor and a 1:100 speed reducer. “Brushless DC Motor Drive for Position
Control of Robot Joint” on page 4-51 shows a simplified diagram of the position control system for
one robot link.

The control system consists of three control loops connected in a cascade configuration: an outer
position loop includes an inner speed control loop and an innermost current control loop. The PM
synchronous motor is fed by a three-phase PWM inverter operating in current-controlled mode. Field-
orientation scheme is used to decouple the variables so that flux and torque can be separately
controlled by stator direct-axis current ids and quadrature-axis current iqs, respectively. The
quadrature-axis current reference iqs* (which represents the torque command) is provided by the
speed control loop. The direct-axis current reference ids* is kept equal to 0.

A speed/position sensor is used to provide the information required by the speed and position control
loops. The rotor position is also required for coordinates conversion (dq to abc).

Each motor drives the rest of the robot structure, including the other links and the load, through a
speed reducer.
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Brushless DC Motor Drive for Position Control of Robot Joint

Modeling the Robot Position Control Systems
The entire drive system for the robot's two first joints, including motor drives, speed reducers,
equivalent loads, and controllers is available in the “Robot Axis Control Using Brushless DC Motor
Drives” example.

The brushless DC motor drives are represented by two AC6 (PM Synchronous Motor Drive) blocks
from the Electric Drives library. This block models a complete brushless DC motor drive including a
permanent-magnet synchronous motor (PMSM), an IGBT inverter, speed controller, and current
controller. The AC6 inputs are the speed commands and the outputs are the motor speed, which are
fed to the inputs of the speed reducers.

The speed reducers are modeled by two Speed Reducer blocks from the Electric Drives library. The
inputs for these blocks are the motors' speeds, and the outputs are the torques from the low-speed
sides, which are applied to the robot structure model. The speed reducers are characterized by their
ratio and inertia and the stiffness and damping of input and output shafts.

The speed reducers' output shafts are connected to the T1 and T2 inputs of a Robot block that
represents the rest of the robot structure. This block calculates the effective torque reflected to each
joint. For each joint (numbered i), we can consider globally the other links effects as a single load
reflecting to the joint a torque that is composed of three terms

TL = Ji
d2θi
dt2 + Ci

dθi
dt + Gi ⋅ θi  (4-6)

where Θi is joint angular position, Ji is inertia, Ci is centrifugal and Coriolis coefficient, and Gi is
gravitational coefficient.

The Robot model is built with Simulink blocks.
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In this diagram, the parameters J1, C1, G1, J2, C2, and G2 are functions of joint positions. Implement
them by using polynomials or lookup tables.

The joint positions Θ1 and Θ2 are controlled by outer control loops that force Θ1 and Θ2 to follow the
references imposed by the trajectories of the manipulator. Various algorithms can be used for these
control loops. The most popular ones are proportional-derivative, computed torque, and adaptive. In
this example, proportional-derivative controllers are implemented for both axes.

Cubic polynomial test trajectories for robot motion are generated by the Trajectory Generator block.
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The test trajectories consist of a movement from position 6 to position 3 in the workspace (Θ2 varying
from -π/4 to π/4) while rotating around axis 1 from one position to another (Θ1 varying from -π/6 to
π/6). The parameters to be specified for this block are initial position [Θ1ini, Θ2ini], final position [Θ1fin,
Θ2fin], and move time. The following figure shows the changes of robot structure during the
programmed movement.

The variation of inertia due to structure changes is reflected to axis 1 as an inertia varying as a
function of Θ2 (from 215 kgm2 to 340 kgm2 passing by a minimum of 170 kgm2). The inertia reflected
to axis 2 is a constant (J2 = 50 kgm2). These inertia variations are represented by nonlinear functions
implemented in the Robot block.

Tracking Performance of the Motor Drives
The test trajectories described above constitute one of the most demanding trajectories for the motor
drive of the first and second joints. They are used here to evaluate the tracking performance of the
two electric drive systems.

In the example, the manipulator is programmed to rotate from -30° to 30° during 1.5 seconds, and at
the same time the arm is moved from the back position (Θ2 = -45°) to the most advanced position (Θ2
= 45°). The simulation is run using a time step of 1 µs.

The responses of the manipulator and the motor drives 1 and 2 are displayed on three scopes
connected to the output variables of the AC6 and Robot blocks.

During the movement, the joint positions Θ1 and Θ2 follow the imposed cubic trajectories with low
tracking error.

The brushless DC motor drives behave very well during the test trajectories. The DC bus voltages are
maintained at relatively constant levels during the deceleration of the motors. The developed torques
are proportional to the motor currents' amplitudes. This demonstrates the good operation of the field-
oriented control algorithms.
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Building Your Own Drive

In this section...
“Introduction” on page 4-54
“Description of the Drive” on page 4-55
“Modeling the Induction Motor Drive” on page 4-56
“Simulating the Induction Motor Drive” on page 4-59
“Starting the Drive” on page 4-59
“Steady-State Voltage and Current Waveforms” on page 4-59
“Speed Regulation Dynamic Performance” on page 4-60

Introduction
Although the Electric Drives library contains models of motor drives widely used in the industry, you
might have some specific requirements leading you to build your own motor drive model. The
following information describes how to build a motor drive model using Simulink and Simscape
Electrical Specialized Power Systems blocks. You will build the field-oriented-control motor drive,
very similar to the AC3 model. The following figure shows the block diagram of the drive.

Field-Oriented Variable-Frequency Induction Motor Drive
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Description of the Drive
The induction motor is fed by a current-controlled PWM inverter, which operates as a three-phase
sinusoidal current source. The motor speed ω is compared to the reference ω* and the error is
processed by the speed controller to produce a torque command Te*.

As shown below, the rotor flux and torque can be separately controlled by the stator direct-axis
current ids and quadrature-axis current iqs, respectively.

Field-Oriented Control Principle

The mathematical principles of this AC drive have been discussed in “Electric Drives Library” on page
4-2. Here, we will only rewrite the basic equations. The stator quadrature-axis current reference iqs*
is calculated from torque reference Te* as

iqs * = 2
3 ⋅

2
p ⋅

Lr
Lm

⋅
Te *
ψr est

where Lr is the rotor inductance, Lm is the mutual inductance, and |ψr|est is the estimated rotor flux
linkage given by

ψr
est

=
Lm ⋅ ids

1 + τr ⋅ s

where τr = Lr / Rr is the rotor time constant.

The stator direct-axis current reference ids* is obtained from rotor flux reference input |ψr|*.

ids * =
ψr *
Lm

The rotor flux position Θe required for coordinates transformation is generated from the rotor speed
ωm and slip frequency ωsl.

θe =∫ ωm + ωsl dt

The slip frequency is calculated from the stator reference current iqs* and the motor parameters.

ωsl =
Lm

ψr est
⋅

Rr
Lr
⋅ iqs *
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The iqs* and ids* current references are converted into phase current references ia*, ib*, ic* for the
current regulators. The regulators process the measured and reference currents to produce the
inverter gating signals.

The role of the speed controller is to keep the motor speed equal to the speed reference input in
steady state and to provide a good dynamic during transients. The controller can be a proportional-
integral type.

Modeling the Induction Motor Drive
Open the power_acdrive model and save it as case3 in your working directory so that you can
make further modifications without altering the original file.

The next figure shows the power_acdrive model in which blocks from Simscape Electrical
Specialized Power Systems and Simulink libraries are used to model the induction motor drive.

Vector Control of AC Motor Drive (power_acdrive)

The induction motor is modeled by an Asynchronous Machine block. The motor used in this case
study is a 50 HP, 460 V, four-pole, 60 Hz motor having the following parameters:

Rs 0.087 Ω
Lls 0.8 mH
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Lm 34.7 mH
Rr 0.228 Ω
Llr 0.8 mH

The reference speed and the load torque applied to the motor shaft can be both selected by a Manual
Switch block in order to use either a constant value or a step function. Initially the reference speed is
set to a constant value of 120 rad/s and the load torque is also maintained constant at 0 N.m

The field-oriented control is modeled by the Vector Control block, as shown in “Vector Control of AC
Motor Drive (power_acdrive)” on page 4-56. This block consists of Simulink blocks shown in the
following figure.

Vector Control Block

The IGBT inverter is modeled by a Universal Bridge block in which the Power Electronic device and
Port configuration options are selected as IGBT/Diode and ABC as output terminals respectively.
The DC link input voltage is represented by a 780 V DC voltage source.

The current regulator consists of three hysteresis controllers and is built with Simulink blocks. The
motor currents are provided by the measurement output of the Asynchronous Machine block.

The conversions between abc and dq reference frames are executed by the abc_to_dq0
Transformation and dq0_to_abc Transformation blocks
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abc_dq

dq_abc

The rotor flux is calculated by the Flux_Calculation block.

The rotor flux position (Θe) is calculated by the Teta Calculation in “Vector Control Block” on page 4-
57. The motor speed is provided by the measurement output of the Asynchronous Machine block.

The stator quadrature-axis current reference (iqs*) is calculated by the iqs*_Calculation block.

The stator direct-axis current reference (ids*) is calculated by the id*_Calculation block.

The speed controller is of proportional-integral type and is implemented using Simulink blocks.
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Simulating the Induction Motor Drive
In order to increase simulation speed, this model is discretized using a sample time of 2 µs. The
variable Ts = 2e-6 automatically loads into your workspace when you open this model. This sample
time Ts is used both for the power circuit (Ts specified in the Powergui) and the control system.

Run the simulation.

The motor voltage and current waveforms as well as the motor speed and torque are displayed on
four axes of the scope connected to the variables Vab, Iabc, ωm, and Te.

Starting the Drive
You can start the drive by specifying [1,0,0,0,0,0,0,0] as the initial conditions for the
Asynchronous Machine block (initial slip = 1 and no currents flowing in the three phases). The speed
reference is 120 rad/s.

The motor speed, electromechanical torque, and currents observed during the starting of the
induction motor drive are shown in “Starting the Induction Motor Drive” on page 4-59.

Note that you can save the final system state vector and use it as the initial state in a subsequent
simulation so that the simulation can start under steady-state conditions.

Starting the Induction Motor Drive

Steady-State Voltage and Current Waveforms
When the steady state is attained, you can stop the simulation and zoom on the scope signals.

This figure shows the motor voltage, current, and torque waveforms obtained when the motor is
running at no load (torque = 0 N.m) at a speed of 120 rad/s.

The 20 A band imposed by the hysteresis current regulator is clearly seen on the three motor
currents.
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Steady-State Motor Current, Voltage, and Torque Waveforms

Speed Regulation Dynamic Performance
You can study the drive dynamic performance (speed regulation performance versus reference and
load torque changes) by applying two changing operating conditions to the drive: a step change in
speed reference and a step change in load torque.

Use the Reference Speed selection switch and the Torque selection switch to set speed reference
steps from 120 rad/s to 160 rad/s at t = 0.2 s and the load torque steps from 0 N.m to 200 N.m at t =
1.8 s. The final state vector obtained with the previous simulation can be used as the initial condition
so that the simulation starts from steady state. Load the power_acdrive_init.mat file, which
creates the xInitial variable. In the Simulation tab, click Model Settings. Select Data Import/
Export. Select Initial state and then click OK. Restart the simulation.

The response of the induction motor drive to successive changes in speed reference and load torque
is shown here.
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Dynamic Performance of the Induction Motor Drive
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Retune the Drive Parameters
This example shows how to modify the parameters of an electric drive using the AC3 drive model. In
this example, the nominal power of the motor changes from 200 hp to 5 hp. To retune the drive
parameters:

• “Modify Motor Parameters” on page 4-62
• “Retune Parameters of the Flux Regulator” on page 4-63
• “Retune Parameters of the Speed Regulator” on page 4-65
• “Retune Parameters of the DC Bus Voltage” on page 4-67
• “Simulate and Analyze the Results” on page 4-68

Modify Motor Parameters
1 Open the example: ac3_example. Type ac3_example in the MATLAB Command Window.

The parameters are set for a 200 hp motor.
2 Simulate the model in Accelerator mode and observe the results.
3 Double-click the Field-Oriented Control Induction Motor Drive block and select the

Asynchronous Machine tab. Copy these parameters of the 5 hp motor into the drive's mask.

Parameter Value
Reference frame Rotor
Discrete solver model Forward

Euler
Electrical parameters > Nominal values > Power 3730
Electrical parameters > Nominal values > Voltage 460
Electrical parameters > Nominal values > Frequency 60
Electrical parameters > Equivalent circuit values > Main winding stator >
Resistance

1.115

Electrical parameters > Equivalent circuit values > Main winding stator >
Leakage inductance

0.005974

Electrical parameters > Equivalent circuit values > Main winding stator >
Mutual inductance

0.2037

Electrical parameters > Equivalent circuit values > Main winding rotor >
Resistance

1.083

Electrical parameters > Equivalent circuit values > Main winding rotor >
Leakage inductance

0.005974

Electrical parameters > Initial Currents > Ia_Magnitude 0
Electrical parameters > Initial Currents > Ia_Phase 0
Electrical parameters > Initial Currents > Ib_Magnitude 0
Electrical parameters > Initial Currents > Ib_Phase 0
Electrical parameters > Initial Currents > Ic_Magnitude 0
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Parameter Value
Electrical parameters > Initial Currents > Ic_Phase 0
Mechanical parameters > Inertia 0.02
Mechanical parameters > Friction factor 0.005752
Mechanical parameters > Pole pairs 2
Initial values > Slip 1
Initial values > Angle 0

Retune Parameters of the Flux Regulator
1 To measure the signals associated to the flux regulator, add these blocks into the demux

subsystem.

2 Select the Controller tab in the mask of the Field-Oriented Control Induction Motor Drive block.
Set the Regulation type to Torque regulation to access the controller parameters.

The torque regulation mode is required to bypass the speed regulator parameters and act
directly on the field-oriented control (FOC) controller.

The current controlled by the FOC controller depends of the machine flux. The flux controller
ensures that the required flux is correctly applied to the machine.

3 Copy these parameters into the drive’s mask:

Parameter Value
Machine flux > Initial 0.705
Machine flux > Nominal 0.705
Field oriented control > Flux controller > Proportional gain 1
Field oriented control > Flux controller > Integral gain 0
Field oriented control > Flux controller > Low-pass filter cutoff frequency 10e3
Field oriented control > Flux controller > Flux output limits > Negative -0.705*1.5
Field oriented control > Flux controller > Flux output limits > Positive 0.705*1.5
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Parameter Value
Field oriented control > Current controller Hysteresis bandwidth 1

4 To apply the nominal torque to the motor, modify the parameters of the Stair Generator blocks in
the Speed reference subsystem and in the Load torque subsystem.

5 On the Logging tab of the Scope block, set Decimation to 1 and Variable name to simout1.
Select Log data to workspace and set Save format to Structure With Time.

6 Simulate the system for 0.5 s. Open the FFT Analysis tool of the powergui block.

In the Input list, select the Stator current signal and set Start time to 0.23, Number of
cycles to 1, Fundamental frequency to 7.5, and Max Frequency (Hz) to 20000 Hz.

Click Display to get the FFT graph.
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7 Note that the switching frequency is about 5 kHz. To attenuate this frequency, set the Flux
controller Low-pass filter cutoff frequency parameter to 500 Hz.

8 Open the Scope block and observe the flux signal. Note that the steady-state error is high.

9 Gradually increase the Flux controller Proportional gain parameter and simulate until you
obtain a satisfactory response. Increasing the gain above a certain value can cause a saturation
of the Flux controller. The curve at the next plot is based on a proportional gain of 100.

10 Gradually increase the Flux controller Integral gain and simulate until you obtain a satisfactory
steady-state result with minimal error. The next plot is based on an integral gain of 90.

Retune Parameters of the Speed Regulator
1 Select the Controller tab in the mask of Field-Oriented Control Induction Motor Drive block and

set the Regulation type to Speed regulation to edit the controller parameters.

Parameter Value
Speed controller > Torque output limits> Negative -1200*1.5
Speed controller > Torque output limits> Positive 1200*1.5
Speed controller > PI regulator > Proportional gain 1
Speed controller > PI regulator > Integral gain 0
Speed controller > Speed cutoff frequency 500
Field oriented control > Maximum switching frequency 500
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The speed ramp acceleration must be calculated to avoid exceeding the torque output limit. The
required torque to accelerate the motor at 1750 rpm/s is given by:

Taccel = J ⋅ Accel rpm /s
30 ⋅ π

Taccel = 0.02 ⋅ 1750
30 ⋅ π = 3.67 Nm

2 To apply the nominal torque to the motor, modify the parameters of the Stair Generator blocks in
the Speed reference subsystem and in the Load torque subsystem.

3 Set the scope decimation to 25 to prevent memory overload. Start the simulation.

Observe the speed signal on the Scope block. The steady state error is high and the response
time is not acceptable.

4 Gradually increase the Proportional gain parameter of the speed controller and simulate until
you obtain a satisfactory response time without overshoot. Note that if the gain is too high, the
system will be oscillatory. The next plot is based on a proportional gain of 3.

5 Gradually increase the Integral gain of the speed controller and simulate until you obtain a
satisfactory steady state value with a minimal steady-state error. This curve is based on an
integral gain of 100.
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Retune Parameters of the DC Bus Voltage
1 Select the Converter and DC bus tab in the mask of the Field-Oriented Control Induction Motor

Drive block to tune the DC bus capacitor and the braking chopper parameters.
2 Set the DC Bus Capacitance parameter to 167e-6.

The DC bus capacitance is calculated in order to reduce the voltage ripple.

C =
Pmotor

12 ⋅ f ⋅ ΔV ⋅ VDC

where:

• Pmotor is the nominal power of the motor drive (W).
• f is the frequency of the AC source (Hz).
• ΔV is the desired voltage ripple (V).
• VDC is the average DC Bus voltage (V).

This equation gives an approximate value of the capacitor required for a given voltage ripple
level. Here the desired voltage ripple is 50 V.

The motor drive of 5 hp (3728 W) is fed by a 60 Hz three-phase source. The average DC bus
voltage is given by:

VDC = 1.35·VLL,

where VLL represents the line to line rms voltage of the source. The source line to line voltage is
460 Vrms so the DC voltage is VDC = 621 V.

The required capacitor is then equal to

C = 3728
12 ⋅ 60 ⋅ 50 ⋅ 621 = 167 μF.
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3 Set the Braking chopper Shutdown voltage to 660V and the Braking chopper Activation
voltage to 700 V.

In motor mode, the peak voltage of the DC bus is equal to

Vpeak = VLL ⋅ 2 = 460 ⋅ 2 = 650 V.

The shutdown voltage (Vshut) of the braking chopper should be a little bit higher than this value.
To limit the voltage increase during regenerative braking, shutdown voltage is set to 660 V, and
the activation voltage (Vact) is set to 700 V.

4 Set the Braking chopper Resistance to 131 ohms.

The braking chopper resistance is calculated using this equation:

R =
Vact

2

Pmotor
= 7002

3728 = 131 Ω

Simulate and Analyze the Results
Simulate the system and observe six sections of the simulation results.

1 No-load acceleration
2 Nominal load torque is applied
3 Steady state speed
4 Nominal generation torque is applied: Observe the DC bus voltage overshoot
5 Deceleration
6 Negative speed acceleration
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Modify a Drive Block
If you have to change electrical connections or control modules, you can do so by modifying a drive
block. The following example uses ac6_example to replace the three-phase electric source by a
battery. To modify a drive block:

• “Break the Link of the Drive Block” on page 4-69
• “Modify the Drive Block” on page 4-69
• “Use the Customized Drive Block” on page 4-70

Break the Link of the Drive Block
1 Open the ac6_example by typing ac6_example in the MATLAB Command window. The drive is

fed by a three-phase voltage source.
2 Simulate the model (in accelerator mode) and observe the results.
3 Break the link between the drive block and the Electric Drives library.

a Right-click the block, and then select Library Link > Disable Link. .
b Right-click the block again, and then select Library Link > Break Link

Modify the Drive Block
1 Right-click the drive block and select Mask > Look Under Mask.
2 Delete the three-phase electrical connections, the diode rectifier, and the braking chopper.

3 Add two Connection Port blocks from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Elements library, and then connect them to the positive
and negative terminals of the Three-Phase Inverter block. Add a Simulink Ground block and
connect it to the output port Conv.
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Use the Customized Drive Block
1 Save the model as ac6_example2.
2 In the diagram, delete the three-phase source. Replace it with a 300Vdc/1Ah/NiMH Battery block

and a 100 µF capacitor block connected in parallel.
3 Connect the Conv output of the block to a Terminator block. Remove the DC bus voltage blocks

that are in the Demux block.
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4 Add a Bus Selector block and then select the Voltage (V) bus signal coming from the m output of
the Battery block.
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Multilevel Modeling for Rapid Prototyping
In this section...
“Introduction” on page 4-72
“The System Architecture” on page 4-72
“The Simplified Model” on page 4-73
“The Average-Value Model” on page 4-76
“The Detailed Model” on page 4-81
“Comparison of the Multilevel Modeling Precision” on page 4-84
“Conclusion” on page 4-88

Introduction
Model-based design can considerably reduce the cost associated with system development. The
development of models for complex systems such as electric vehicles includes the following phases:

• Definition of functional specifications
• System design
• Tests and validation
• Implementation

This case study focuses on the first two phases and shows how the simulation could help the system
designer in decision making. The simulation is a very complex art. It can represent simple model with
precision which can be arguable whereas complex models can be represented with accurate
precision, very close to reality. The developer of models must always make a compromise between the
complexity of the models and the required precision. Of course, it is always preferable to have an
ultra-accurate model, but the parameters required by these models are usually difficult to determine,
especially during the first phases of system development. Moreover, the simulation of these accurate
models is very slow.

It is therefore necessary to use different detail level of simulation models. At first, the system
designer will need a first level model in order to have an overview of all the power flow in the system.
This will help in the design of different elements in the system to meet the power flow requirement.
Then, a more accurate model is required in order to adjust different systems, to fine tune the
parameters of the energy management system and to design power electronics converters. Finally, a
detailed model will allow the validation of the system behavior with a high degree of accuracy and to
perform other adjustments if required.

The System Architecture
The system architecture under study is based on the Toyota Prius THSII:
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More precisely, the study focuses on the different detailed levels of the electrical system model.

The battery model used is the basic model from the Simscape Electrical Specialized Power Systems
library and requires few parameters. A NiMH battery of 201 V, 6.5 Ah (just as the one used in the
Toyota Prius) is considered. For this model, it is not necessary to use different detailed level as it is
very easy to use and offers a good precision.

The Simplified Model
The simplified electrical model is based on the power balance principle on different elements. Note
that these simplified models have energy efficiency of 100%.

The DC/DC Converter

For the DC/DC converter, it is assumed that the DC bus voltage, which supplies the motor and the
generator, is maintained constant by a regulator. For this model, a DC bus of 500 V is required. The
voltage at the DC bus side is maintained constant using a fixed voltage source. From the power
balance principle, the corresponding current is requested from the battery. A filter is necessary to
break the algebraic loop. Below is the simplified DC/DC converter model:
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The Motor Drive

The electrical motor applies a mechanical torque on the system. The required torque is determined
by the energy management system. It is assumed that the torque regulator is well designed so that
the reference torque is directly applied on the motor shaft. By measuring the shaft speed and the DC
bus voltage, it is possible using the power balance principle to determine the corresponding DC bus
current. Below is the simplified model of the electrical motor:

The Generator Drive

The generator is represented exactly as the electrical motor. A negative torque is requested by the
energy management system in order to generate electrical power. As it is assumed that the generator
control system is ideal, the reference torque is directly applied to the mechanical system. The
corresponding current is deduced using the power balance principle.

Simulation Results

The simulation of the simplified electrical system is useful as it shows the performance of the energy
management system, the mechanical system and different electrical components. In fact, the short
simulation time (around 0.7 times the real time in normal mode) allows fast adjustments of the
energy management system for better performances. For this phase of simulation, the accelerator
position is set to 100% and the following results are obtained:
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It should be noted that in this phase of modeling, it is not possible to determine the stator current for
the motor and generator; that explains why these currents are nulls. The simplified model can now
help in the dimensioning of each component of the electrical system. The next section focuses on the
architecture of each component, including the electrical machines and different regulators.

The Average-Value Model
In this phase of simulation, the level of precision is improved. The different electrical machines and
regulators architectures are chosen.

The DC/DC Converter

The average value DC/DC converter uses a voltage regulator based on a Proportional-Integrator (PI)
controller to maintain the DC bus voltage equal to the voltage reference (of 500 V). The simulation
allows the selection of the inductor and capacitors and the adjustment of the PI controller parameters
in order to obtain the results similar to the simplified model. Below is the DC/DC converter model:
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As an average value converter is used, only the duty cycle is required by the boost converter. The
battery voltage is set by the boost converter based on the duty cycle and the DC bus voltage. On the
high voltage side, the DC bus current is set based on the duty cycle and the battery current. For more
information regarding this system, see Two-Quadrant Chopper DC Drive.

The Motor Drive

The motor is a permanent magnet synchronous machine (PMSM). From the simplified model results,
the motor requirement is determined. It should be able to produce a maximum torque of 400 Nm and
a maximum power of 50 kW up to 6000 rpm (this speed is obtained by simulating the simplified model
for 60 seconds, in order for the vehicle to reach 160 Km/h).

The motor control is done using vector control. As the machine uses an interior permanent magnet
rotor, it is possible to use the reluctance torque to increase the total output torque and operate at
very high speed. For more information on this configuration, see the ac6_IPMSM example. The
electric drive consists of the motor, the inverter and the vector controller.
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Similar to the DC/DC converter model, the inverter is represented by an average value model and the
effect of power semiconductors switching is not taken into consideration. The reference currents
(from the vector controller) are directly applied on the motor via controlled current sources.
Moreover, this inverter allows the modeling of the saturation current when the DC bus voltage is not
high enough to power the motor (at a given speed and torque). Below is the average value model:

In normal operation, the current sources are used to supply the machine. In the saturation, mode,
voltage sources are used instead. For more details on this system, see the PM Synchronous Motor
Drive.
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The Generator Drive

The generator is also a permanent magnet synchronous machine. From the simplified model results,
it should be able to provide a maximum power of 30 kW and a maximum speed of 15 000 rpm. A
vector controller is used to assure a proper operation of the generator. As a non-salient pole machine
is used, the classical control method (id = 0) is used throughout the operating region. Below is the
model of the complete system:

The average value model is identical for both the motor and generator.

Simulation Results

The simulation of the average value model allowed the dimensioning of electrical components
(inductor, capacitor, motor and generator) and the adjustment of different controllers systems. At this
stage, it is now possible to clearly visualize the electrical signals. This helps in fine tuning the
regulators and the energy management system. The longer simulation time (16 times the real time in
normal mode and 3.5 times the real time in accelerator mode) allows to represent more precisely the
behavior of the electrical system. Below are the results from different systems:
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The Detailed Model
In this phase of modeling, the average value models of converters are replaced by power
semiconductors switches. A method to generate the pulse width modulated (PWM) signals is also
determined.

The DC/DC Converter

For the detailed model of the DC/DC converter, the output of the PI controller is sent to the pulse
width modulator, which selects the pulse sequence required to maintain the DC bus voltage close to
the reference value. The PWM signals are then sent directly to the single leg power semiconductor
switch.
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The Motor and the Generator Drives

For the detailed model of these elements, the average value inverter is replaced by a 3 legs power
semiconductors switches consisting of 6 pairs of IGBT/diode. The output signal of the vector
controller is sent to the hysteresis controller, which generates the required PWM signals. For more
information about these systems see the PM Synchronous Motor Drive.

Simulation Results

The simulation of the detailed model gives a lot of information regarding the power converters. In
fact, it allows the selection of the PWM generation method, the adjustment of the switching
frequency (for the DC/DC converter) and the tuning of the hysteresis band of the current regulator
necessary for vector control (motor and generator). Moreover, it allows the dimensioning of the
converters as the instantaneous values of currents are accurately known. The selection of power
semiconductors switches and the dimensioning of heat sinks can be made afterwards.

In a broader view, this simulation helps to validate with a high precision the operation of the
electrical circuit and allows the detection of any problems caused by instability, over voltage or over
current. This high degree of precision is obtained of course, at the price of a longer calculation time.
In fact, the simulation time is around 90 times the real time in accelerator mode. Below are the
results from different systems:
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Comparison of the Multilevel Modeling Precision
Regarding the precision, the mechanical signals (the vehicle speed and torque) and the electrical
signals (the average power from different elements) are very close for all the three models. In fact,
the error on the vehicle speed is less than 2 Km/h and 1.5 Km/h for the simplified and the average
value models respectively. Regarding the motor power, the dynamics of the simplified and average
value models are also close to the detailed model. The main difference resides on the high frequency
component present on the detailed model signals due to the switching frequency of the inverter. The
maximum error from the two models is less than 5000 W (below 10%) and the average error is below
5%.
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Regarding the vehicle torque, the three models are very close with a maximum error of 5%. By
closely looking at the differences (right figure), it is noted that the simplified model reacts
instantaneously to the reference torque required by the energy management system. For the average
value model, the torque increases progressively to the desired torque with a greater accuracy
compared to the detailed model. Again, the detailed model is characterized by the high frequency
signal generated by the switching frequency of the electrical system.
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As for the battery signals, the simplified and the average value models follow exactly the dynamics of
the detailed model with no high frequency component.
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One of the main differences between the simplified and the average value models resides on the
electrical signals from the motor and the generator. In fact, the simplified model cannot represent the
motor or the generator current. The difference between the average value and the detailed models is
the presence of the high frequency component on the detailed model. The amplitude of currents is
exactly the same for the two models whereas the phase could be different due to variations on the
mechanical speed.
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Here is a table which summarizes the differences between the different detailed levels:

Conclusion
To conclude, the level of precision chosen depends on the stage of development the engineer is
working on. For example, at the beginning of the process, the system engineer wants to simulate its
system to have an idea on how it operates, with the objective to effectively adjust the energy
management system. The simulation of the simplified model helps to determine the speeds, torques
and electrical powers present in the system. As this model requires less calculation time (less than 1
times the real time), it is possible to study several configurations and obtain results close to reality in
a very short time.

Subsequently, the average value model allows the electrical engineer to design different control
systems and to select the motor and the generator based on the results from the simplified model.
The simulation time (less than 4 times the real time in accelerator mode) is acceptable. It allows the
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validation of the system behavior and the adjustment of both the control system and the energy
management system.

Finally, the specialist in power electronics can use the detailed model to select the power
semiconductors components based on the instantaneous and average values of currents and voltages.
The losses can be evaluated (for heat sink design), the switching frequency can be adjusted in order
to assure the electromagnetic interference (EMI) will not affect other systems. Moreover, the
complete simulation of the detailed model allows to validate the behavior of different elements in the
system and to fine tune the energy management system if necessary. Of course, this high level of
accuracy comes with a larger calculation time, around 90 times the real time. But this large time is
still acceptable if compared with the time required in an experimental setup.

Obviously, in the development of the detailed or the average value model, it is possible to isolate some
blocks, such as the DC/DC converter or the motor and generator drives in order to preliminary adjust
each system. The block can be added to the complete model when it operates properly.

Finally, when the simulation model is completed, it represents the reality with a high degree of
accuracy. The next phase, which consists of the realization of the system experimentally, can be made
with less time and at lower cost.
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Transients and Power Electronics in
Power Systems

These case studies provide detailed, realistic examples of how to use Simscape Electrical Specialized
Power Systems software in typical power utility applications. All these examples use fixed-step
discretized models. Case 1 shows a study of transients in an AC series-compensated transmission
system. Cases 2 to 5 show examples of power-electronics based flexible AC transmission systems
(FACTS) and cover two typical areas of FACTS applications:

• Cases 2 and 3 illustrate shunt reactive power compensation using two different technologies: a
SVC using thyristors and a STATCOM using a square-wave GTO voltage-sourced converter.

• Cases 4 and 5 illustrate two technologies of power conversion for HVDC transmission: thyristor
converters and pulse width modulation (PWM) voltage-sourced converters.

• “Series-Compensated Transmission System” on page 5-2
• “Thyristor-Based Static Var Compensator” on page 5-14
• “GTO-Based STATCOM” on page 5-20
• “Thyristor-Based HVDC Link” on page 5-25
• “VSC-Based HVDC Link” on page 5-38
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Series-Compensated Transmission System
In this section...
“Description of the Transmission System” on page 5-2
“Setting the Initial Load Flow and Obtaining Steady State” on page 5-5
“Transient Performance for a Line Fault” on page 5-6
“Frequency Analysis” on page 5-9
“Transient Performance for a Fault at Bus B2” on page 5-11

Description of the Transmission System
The example described in this section illustrates modeling of series compensation and related
phenomena such as subsynchronous resonance in a transmission system.

The single-line diagram shown here represents a three-phase, 60 Hz, 735 kV power system
transmitting power from a power plant consisting of six 350 MVA generators to an equivalent system
through a 600 km transmission line. The transmission line is split into two 300 km lines connected
between buses B1, B2, and B3.

Series and Shunt Compensated Transmission System

To increase the transmission capacity, each line is series compensated by capacitors representing
40% of the line reactance. Both lines are also shunt compensated by a 330 Mvar shunt reactance. The
shunt and series compensation equipment is located at the B2 substation where a 300 MVA-735/230
kV transformer feeds a 230 kV-250 MW load.

Each series compensation bank is protected by metal-oxide varistors (MOV1 and MOV2). The two
circuit breakers of line 1 are shown as CB1 and CB2.

This power system is available in the power_3phseriescomp model. Load this model and save it in
your working directory as case1 to allow further modifications to the original system.

Compare the Simscape Electrical Specialized Power Systems circuit model (“Series-Compensated
System (power_3phseriescomp)” on page 5-3) with the schematic diagram above (“Series and
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Shunt Compensated Transmission System” on page 5-2). The generators are simulated with a
Simplified Synchronous Machine block. A Three-Phase Transformer (Two Windings) block and a
Three-Phase Transformer (Three Windings) block are used to model the two transformers. Saturation
is implemented on the transformer connected at bus B2.

The B1, B2, and B3 blocks are Three-Phase V-I Measurement blocks taken from the Simscape >
Electrical > Specialized Power Systems > Fundamental Blocks > Measurements library. These
blocks are reformatted and given a black background color to give them the appearance of bus bars.
They output the three line-to-ground voltages and the three line currents. Open the dialog boxes of
B1 and B2. Note how the blocks are programmed to output voltages in pu and currents in pu/100
MVA. Notice also that the voltage and current signals are sent to internal Goto blocks by specifying
signal labels. The signals are picked up by the From blocks in the Data Acquisition subsystem.

The fault is applied on line 1, on the line side of the capacitor bank. Open the dialog boxes of the
Three-Phase Fault block and of the Three-Phase Breaker blocks CB1 and CB2. See how the initial
breaker status and switching times are specified. A line-to-ground fault is applied on phase A at t = 1
cycle. The two circuit breakers that are initially closed are then open at t = 5 cycles, simulating a
fault detection and opening time of 4 cycles. The fault is eliminated at t = 6 cycles, one cycle after the
line opening.

Series-Compensated System (power_3phseriescomp)

Series Compensation1 Subsystem

Now, open the Series Compensation1 subsystem of the power_3phseriescomp model. The three-
phase module consists of three identical subsystems, one for each phase. A note indicates how the
capacitance value and the MOV protection level are calculated. Open the Series Compensation1/
Phase A subsystem. You can see the details of the connections of the series capacitor and the Surge
Arrester block (renamed MOV). The transmission line is 40% series compensated by a 62.8 µF
capacitor. The capacitor is protected by the MOV block. If you open the dialog box of the MOV block,
notice that it consists of 60 columns and that its protection level (specified at a reference current of
500 A/column or 30 kA total) is set at 298.7 kV. This voltage corresponds to 2.5 times the nominal
capacitor voltage obtained at a nominal current of 2 kA RMS.

A gap is also connected in parallel with the MOV block. The gap is fired when the energy absorbed by
the surge arrester exceeds a critical value of 30 MJ. To limit the rate of rise of capacitor current when
the gap is fired, a damping RL circuit is connected in series. Open the Energy & Gap firing
subsystem. It shows how you calculate the energy dissipated in the MOV by integrating the power
(product of the MOV voltage and current).

When the energy exceeds the 30 MJ threshold, a closing order is sent to the Breaker block simulating
the gap.
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Series Compensation Module

Series Compensation1/PhaseA Subsystem

Series Compensation1/PhaseA Subsystem/Energy and Gap Firing

Three-Phase Saturable Transformer Model

Open the 300 MVA 735/230 kV Transformer dialog box and notice that the current-flux saturation
characteristic is set at

[0 0 ; 0.0012 1.2; 1 1.45] in pu

These data are the current and flux values at points 1, 2, and 3 of the piecewise linear approximation
to the flux linkage curve shown here.
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Saturable Transformer Model

The flux-current characteristic is approximated by the two segments shown in the graph here. The
saturation knee point is 1.2 pu. The first segment corresponds to the magnetizing characteristic in
the linear region (for fluxes below 1.2 pu). At 1 pu voltage, the inductive magnetizing current is
0.0010/1.0 = 0.001 pu, corresponding to 0.1% reactive power losses.

The iron core losses (active power losses) are specified by the magnetization resistance Rm = 1000
pu, corresponding to 0.1% losses at nominal voltage.

The slope of the saturation characteristic in the saturated region is 0.25 pu. Therefore, taking into
account the primary leakage reactance (L1 = 0.15 pu), the air core reactance of the transformer seen
from the primary winding is 0.4 pu/300 MVA.

Setting the Initial Load Flow and Obtaining Steady State
Before performing transient tests, you must initialize your model for the desired load flow. Use the
load flow utility of the Powergui to obtain an active power flow of 1500 MW out of the machine with a
terminal voltage of 1 pu (13.8 kV).

Open the Powergui block and select Machine Initialization. A new window appears. In the upper
right window you have the name of the only machine present in your system. Its Bus type should be
PV Generator and the desired Terminal Voltage should already be set to the nominal voltage of
13800 V. In the Active Power field, enter 1500e6 as the desired output power. Click the Compute
and Apply button. Once the load flow is solved, the phasors of AB and BC machine voltages as well
as currents flowing in phases A and B are updated in the left window. The required mechanical power
to drive the machine is displayed in watts and in pu, and the required excitation voltage E is
displayed in pu.
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Pmec 1.5159e9 W [0.72184 pu]
E/Vf 1.0075 pu

Notice that Constant blocks containing these two values are already connected to the Pm and E inputs
of the machine block. If you open the Machine block dialog box, you see that the machine initial
conditions (initial speed deviation dw = 0; internal angle theta, current magnitudes, and phase
angles) are automatically transferred in the last line.

Once the load flow is performed, you can obtain the corresponding voltage and current
measurements at the different buses. In the Powergui block, select Steady State Voltages and
Currents. You can observe, for example, the phasors for phase A voltages at buses B1, B2, and B3
and the current entering line 1 at bus B1.

B1/Va 6.088e5 V ; 18.22 degrees
B2/Va 6.223e5 V ; 9.26 degrees
B3/Va 6.064e5 V ; 2.04 degrees
B1/Ia 1560 A ; 30.50 degrees

The active power flow for phase A entering line 1 is therefore

Pa = Va ⋅ Ia ⋅ cos φa = 608.8 kV
2 ⋅ 1.56 kA

2 ⋅ cos 30.50.− 18.22 = 464 MW

corresponding to a total of 464 * 3 = 1392 MW for the three phases.

Transient Performance for a Line Fault
To speed up the simulation, you need to discretize the power system. The sample time is specified in
the Powergui block as a variable Ts. The sample time Ts=50e-6 has already been defined in the
Model Initialization function in the Callbacks of the Model Properties. The sample time Ts is also
used in the Discrete Integrator block of the MOV energy calculator controlling the gap.

Ensure that the simulation parameters are set as follows.

Stop time 0.2
Solver options type Fixed-step; discrete (no continuous

state)
Fixed step size Ts

Line-to-Ground Fault Applied on Line 1

Ensure that the fault breaker is programmed for a line-to-ground fault on phase A. Start the
simulation and observe the waveforms on the three scopes. These waveforms are shown here.
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Simulation Results for a Four-Cycle Line-to-Ground Fault at the End of Line 1

The simulation starts in steady state. At the t = 1 cycle, a line-to-ground fault is applied and the fault
current reaches 10 kA (a: trace 3). During the fault, the MOV conducts at every half cycle (b: trace 2)
and the energy dissipated in the MOV (b: trace 3) builds up to 13 MJ. At t = 5 cycles the line
protection relays open breakers CB1 and CB2 (see the three line currents on trace 2) and the energy
stays constant at 13 MJ. As the maximum energy does not exceed the 30 MJ threshold level, the gap is
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not fired. At the breaker opening, the fault current drops to a small value and the line and series
capacitance starts to discharge through the fault and the shunt reactance. The fault current
extinguishes at the first zero crossing after the opening order given to the fault breaker (t = 6 cycles).
Then the series capacitor stops discharging and its voltage oscillates around 220 kV (b: trace 1).

Three-Phase-to-Ground Fault Applied on Line 1

Double-click the Three-Phase Fault block to open the Block Parameters dialog box. Select the
Phase B Fault and Phase C Fault check boxes, so that you now have a three-phase-to-ground fault.

Restart the simulation. The resulting waveforms are shown.
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Simulation Results for a Four-Cycle Three-Phase-to-Ground Fault at the End of Line 1

Note that during the fault the energy dissipated in the MOV (b: trace 3) builds up faster than in the
case of a line-to-ground fault. The energy reaches the 30 MJ threshold level after three cycles, one
cycle before the opening of the line breakers. As a result, the gap is fired and the capacitor voltage
(b: trace 1) quickly discharges to zero through the damping circuit.

Frequency Analysis
One particular characteristic of series-compensated systems is the existence of subsynchronous
modes (poles and zeros of the system impedance below the fundamental frequency). Dangerous
resonances can occur if the mechanical torsion modes of turbine/generator shafts are in the vicinity
of the zeros of the system impedance. Also, high subsynchronous voltages due to impedance poles at
subsynchronous frequencies drive transformers into saturation. The transformer saturation due to
subsynchronous voltages is illustrated at the end of this case study. The torque amplification on a
thermal machine is illustrated in another example (see the power_thermal model).

Now measure the positive-sequence impedance versus frequency seen from bus B2.

The section “Analyze a Simple Circuit” on page 1-10 explains how the Impedance Measurement block
allows you to compute the impedance of a linear system from its state-space model. However, your
case1 model contains several nonlinear blocks (machine and saturation of transformers). If you
connect the Impedance Measurement block to your system, all nonlinear blocks are ignored. This is
correct for the transformer, but you get the impedance of the system with the machine disconnected.
Before measuring the impedance, you must therefore replace the machine block with an equivalent
linear block having the same impedance.

Delete the Simplified Synchronous Machine block from your case1 model and replace it with the
Three-Phase Source block from the Simscape > Electrical > Specialized Power Systems >
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Fundamental Blocks > Electrical Sources library. Open the block dialog box and set the
parameters as follows to get the same impedance value (L = 0.22 pu/ (6 * 350 MVA) Quality factor =
15).

Phase-to-phase rms voltage 13.8e3
Phase angle of phase A 0
Frequency (Hz) 60
Internal connection Yg Specify impedance using short-circuit level
3-phase short-circuit level 6*350e6
Base voltage 13.8e3
X/R ratio 15

Save your modified model as case1Zf.

Add the Impedance Measurement block from the Simscape > Electrical > Specialized Power
Systems > Fundamental Blocks > Measurements library into your model. This block is used to
perform the impedance measurement. Connect the two inputs of this block between phase A and
phase B of the B2 bus. Measuring the impedance between two phases gives two times the positive-
sequence impedance. Therefore you must apply a factor of 1/2 to the impedance to obtain the correct
impedance value. Open the dialog box and set the multiplication factor to 0.5.

In the Powergui block, select Impedance Measurement. A new window opens, showing your
Impedance Measurement block name. Fill in the frequency range by entering 0:500. Select the
linear scales to display Z magnitude vs. frequency plot. Click the Save data to workspace button
and enter Zcase1 as the variable name to contain the impedance vs. frequency. Click the Display
button.

When the calculation is finished, the magnitude and phase as a function of frequency are displayed in
the two graphs on the window. If you look in your workspace, you should have a variable named
Zcase1. It is a two-column matrix containing frequency in column 1 and complex impedance in
column 2.

The impedance as a function of frequency (magnitude and phase) is shown here.
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Impedance vs. Frequency Seen from Bus B2

You can observe three main modes: 9 Hz, 175 Hz, and 370 Hz. The 9 Hz mode is mainly due to a
parallel resonance of the series capacitor with the shunt inductors. The 175 Hz and 370 Hz modes
are due to the 600 km distributed parameter line. These three modes are likely to be excited at fault
clearing.

If you zoom in on the impedance in the 60 Hz region, you can find the system's short-circuit level at
bus B2. You should find a value of 58 Ω at 60 Hz, corresponding to a three-phase short-circuit power
of (735 kV)2 / 58 = 9314 MVA.

Transient Performance for a Fault at Bus B2
The configuration of the substation circuit breakers normally allows clearing a fault at the bus
without losing the lines or the transformers. You now modify your case1 model to perform a three-
cycle, three-phase-to-ground fault at bus B2:

1 Disconnect the Three-Phase Fault block and reconnect it so that the fault is now applied on bus
B2.

2 Open the Three-Phase Fault block and make the following modifications in its dialog box:

Phase A, Phase B, Phase C, Ground
Faults

All selected

Transition times [2/60 5/60]
Transition status [1, 0, 1...] (0/1)

You have now programmed a three-phase-to-ground fault applied at the t = 2 cycles.
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3 Open the dialog boxes of circuit breakers CB1 and CB2 and make the following modifications:

Switching of Phase A Not selected
Switching of Phase B Not selected
Switching of Phase C Not selected

The circuit breakers are not switched anymore. They stay at their initial state (closed).
4 In the Data Acquisition subsystem, insert a Selector block in the Vabc_B2 output of bus B2

connected to the scope. Set the Elements parameter to 1. This allows you to see the phase A
voltage clearly on the scope.

5 You now add blocks to read the flux and the magnetization current of the saturable transformer
connected at bus B2.

Add a Multimeter block from the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Measurements library into your case1 model. Open the Transformer
dialog box. In the Measurements list, select Flux and magnetization current. Open the
Multimeter block. Verify that you have six signals available. Select flux and magnetization
current on phase A, and click OK.

6 You now have two signals available at the output of the Multimeter block. Use a Demux block to
send these two signals on a two-trace scope.

7 In the Simulation tab, click Model Settings. Select Solver and then change Stop time to 0.5.
This longer simulation time allows you to observe the expected low-frequency modes (9 Hz).
Start the simulation.

The resulting waveforms are plotted here.
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Simulation Results for a Three-Cycle Three-Phase-to-Ground Fault at Bus B2

The 9 Hz subsynchronous mode excited at fault clearing is clearly seen on the phase A voltage at bus
B2 (trace 1) and capacitor voltage (trace 3). The 9 Hz voltage component appearing at bus B2 drives
the transformer into saturation, as shown on the transformer magnetizing current (trace 5). The flux
in phase A of the transformer is plotted on trace 4. At fault application the voltage at transformer
terminals drops to zero and the flux stays constant during the fault.

At fault clearing, when the voltage recovers, the transformer is driven into saturation as a result of
the flux offset created by the 60 Hz and 9 Hz voltage components. The pulses of the transformer
magnetizing current appear when the flux exceeds its saturation level. This current contains a 60 Hz
reactive component modulated at 9 Hz.
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Thyristor-Based Static Var Compensator
In this section...
“Introduction” on page 5-14
“Description of the SVC” on page 5-14
“Steady-State and Dynamic Performance of the SVC” on page 5-17
“Misfiring of TSC1” on page 5-18

Introduction
The example described in this section illustrates application of Simscape Electrical Specialized Power
Systems software to study the steady-state and dynamic performance of a static var compensator
(SVC) on a transmission system. The SVC is a shunt device of the Flexible AC Transmission Systems
(FACTS) family using power electronics. It regulates voltage by generating or absorbing reactive
power. If you are not familiar with the SVC, see the Static Var Compensator (Phasor Type) block
documentation, which describes the SVC principle of operation.

The Static Var Compensator (Phasor Type) block of the Simscape > Electrical > Specialized
Power Systems > FACTS library is a simplified model that can simulate any SVC topology. You can
use it with the phasor simulation type of the Powergui block for studying dynamic performance and
transient stability of power systems. Due to low frequencies of electromechanical oscillations in large
power systems (typically 0.02 Hz to 2 Hz), this type of study usually requires simulation times of 30–
40 seconds or more.

The SVC model described in this example is rather a detailed model of a particular SVC topology
(using thyristor-controlled reactor (TCR) and thyristor-switched capacitors (TSCs)) with full
representation of power electronics. This type of model requires discrete simulation at fixed time
steps (50 µs in this case) and it is used typically for studying the SVC performance on a much smaller
time range (a few seconds). Typical applications include optimizing of the control system, impact of
harmonics, transients and stresses on power components during faults.

Description of the SVC
The single-line diagram of the modeled SVC is shown on “Single-Line Diagram of the SVC” on page 5-
15. It represents a 300 Mvar SVC connected on a 735 kV transmission system.

This example is available in the power_svc_1tcr3tsc model. Load this model and save it in your
working directory as case2 to allow further modifications to the original system. This model is shown
on “SPS Model of the 300 Mvar SVC on a 735 kV Power System (power_svc_1tcr3tscs)” on page 5-
15.
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Single-Line Diagram of the SVC

SPS Model of the 300 Mvar SVC on a 735 kV Power System (power_svc_1tcr3tscs)

SVC Power Components

The SVC consists of a 735 kV/16 kV, 333 MVA coupling transformer, one 109 Mvar TCR bank and
three 94 Mvar TSC banks (TSC1 TSC2 TSC3) connected on the secondary side of the transformer.

Switching the TSCs in and out allows a discrete variation of the secondary reactive power from zero
to 282 Mvar capacitive (at 16 kV) by steps of 94 Mvar, whereas phase control of the TCR allows a
continuous variation from zero to 109 Mvar inductive. Taking into account the leakage reactance of
the transformer (0.15 pu), the SVC equivalent susceptance seen from the primary side can be varied
continuously from -1.04 pu/100 MVA (fully inductive) to +3.23 pu/100 Mvar (fully capacitive).
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The SVC Controller monitors the primary voltage and sends appropriate pulses to the 24 thyristors (6
thyristors per three-phase bank) to obtain the susceptance required by the voltage regulator.

Each three-phase bank is connected in delta so that, during normal balanced operation, the zero-
sequence tripplen harmonics (3rd, 9th,...) remain trapped inside the delta, thus reducing harmonic
injection into the power system.

The power system is represented by an inductive equivalent (6000 MVA short circuit level) and a 200-
MW load. The internal voltage of the equivalent system can be varied by means of a Three-Phase
Programmable Voltage Source block to observe the SVC dynamic response to changes in system
voltage.

SVC Control System

SVC Controller Model

The SVC control system consists of the following four main modules:

• Measurement System measures the positive-sequence primary voltage. This system uses discrete
Fourier computation technique to evaluate fundamental voltage over a one-cycle running average
window. The voltage measurement unit is driven by a phase-locked loop (PLL) to take into account
variations of system frequency.

• Voltage Regulator uses a PI regulator to regulate primary voltage at the reference voltage (1.0 pu
specified in the SVC Controller block menu). A voltage droop is incorporated in the voltage
regulation to obtain a V-I characteristic with a slope (0.01 pu/100 MVA in this case). Therefore,
when the SVC operating point changes from fully capacitive (+300 Mvar) to fully inductive (-100
Mvar) the SVC voltage varies between 1-0.03=0.97 pu and 1+0.01=1.01 pu.

• Distribution Unit uses the primary susceptance Bsvc computed by the voltage regulator to
determine the TCR firing angle α and the status (on/off) of the three TSC branches. The firing
angle α as a function of the TCR susceptance BTCR is implemented by a look-up table from the
equation

BTCR = 2 π − α + sin 2α
π

where BTCR is the TCR susceptance in pu of rated TCR reactive power (109 Mvar)
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• Firing Unit consists of three independent subsystems, one for each phase (AB, BC and CA). Each
subsystem consists of a PLL synchronized on line-to-line secondary voltage and a pulse generator
for each of the TCR and TSC branches. The pulse generator uses the firing angle α and the TSC
status coming from the Distribution Unit to generate pulses. The firing of TSC branches can be
synchronized (one pulse is sent at positive and negative thyristors at every cycle) or continuous.
The synchronized firing mode is usually the preferred method because it reduces harmonics
faster. Verify that the Synchronized firing mode has been selected in the Firing Unit dialog box.

Steady-State and Dynamic Performance of the SVC
Now observe the steady-state waveforms and the SVC dynamic response when the system voltage is
varied. Run the simulation and observe waveforms on the SVC Scope block. These waveforms are
reproduced below.

Waveforms Illustrating SVC Dynamic Response to System Voltage Steps

Initially the source voltage is set at 1.004 pu, resulting in a 1.0 pu voltage at SVC terminals when the
SVC is out of service. As the reference voltage Vref is set to 1.0 pu, the SVC is initially floating (zero
current). This operating point is obtained with TSC1 in service and TCR almost at full conduction (α =
96 degrees).

At t=0.1s voltage is suddenly increased to 1.025 pu. The SVC reacts by absorbing reactive power
(Q=-95 Mvar) to bring the voltage back to 1.01 pu. The 95% settling time is approximately 135 ms. At
this point all TSCs are out of service and the TCR is almost at full conduction (α = 94 degrees).

At t=0.4 s the source voltage is suddenly lowered to 0.93 pu. The SVC reacts by generating 256 Mvar
of reactive power, thus increasing the voltage to 0.974 pu.
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At this point the three TSCs are in service and the TCR absorbs approximately 40% of its nominal
reactive power (α =120 degrees).

Observe on the last trace of the scope how the TSCs are sequentially switched on and off. Each time a
TSC is switched on the TCR α angle changes from 180 degrees (no conduction) to 90 degrees (full
conduction). Finally, at t=0.7 s the voltage is increased to 1.0 pu and the SVC reactive power is
reduced to zero.

You may open the Signal & Scopes subsystem to observe additional waveforms.The TCR voltage and
current in branch AB as well as thyristors pulses are displayed on the TCR AB scope. The figure
below zooms on three cycles when the firing angle α is 120 degrees.

Steady-State Voltage and Current in TCR AB

Misfiring of TSC1
The final case study simulates a TSC misfiring.

Each time a TSC is switched off a voltage remains trapped across the TSC capacitors. If you look at
the TSC1 Misfiring scope inside the Signals & Scope subsystem, you can observe the TSC1 voltage
(first trace) and the TSC1 current (second trace) for branch AB. The voltage across the positive
thyristor (thyristor conducting the positive current) is shown on the third trace and the pulses sent to
this thyristor are shown on the fourth trace. Notice that the positive thyristor is fired at maximum
negative TSC voltage, when the valve voltage is minimum.

If by mistake the firing pulse is not sent at the right time, very large overcurrents can be observed in
the TSC valves. Look inside the SVC Controller block for how a misfiring can be simulated on TSC1. A
Timer block and an OR block are used to add pulses to the normal pulses coming from the Firing
Unit.

Open the Timer block menu and remove the 100 multiplication factor. The timer is now programmed
to send a misfiring pulse lasting one sample time at time t= 0.121 s.

Restart simulation. Waveforms observed on the TSC1 Misfiring scope are reproduced below.
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TSC Voltages and Current Resulting from Misfiring on TSC1

Observe that the misfiring pulse is sent when the valve voltage is maximum positive immediately
after the TSC has blocked. This thyristor misfiring produces a large thyristor overcurrent (18 kA or
6.5 times the nominal peak current). Also, immediately after the thyristor has blocked, the thyristor
voltage reaches 85 kV (3.8 times the nominal peak voltage). To prevent such overcurrents and
overvoltages, thyristor valves are normally protected by metal oxide arresters (not simulated here).
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GTO-Based STATCOM
In this section...
“Introduction” on page 5-20
“Description of the STATCOM” on page 5-20
“Steady-State and Dynamic Performance of the STATCOM” on page 5-22

Introduction
The example described in this section illustrates application of Simscape Electrical Specialized Power
Systems software to study the steady-state and dynamic performance of a static synchronous
compensator (STATCOM) on a transmission system. The STATCOM is a shunt device of the Flexible
AC Transmission Systems (FACTS) family using power electronics. It regulates voltage by generating
or absorbing reactive power. If you are not familiar with the STATCOM, please refer to the Static
Synchronous Compensator (Phasor Type) block documentation, which describes the STATCOM
principle of operation.

Depending on the power rating of the STATCOM, different technologies are used for the power
converter. High power STATCOMs (several hundreds of Mvars) normally use GTO-based, square-wave
voltage-sourced converters (VSC), while lower power STATCOMs (tens of Mvars) use IGBT-based (or
IGCT-based) pulse-width modulation (PWM) VSC. The Static Synchronous Compensator (Phasor Type)
block of the Simscape > Electrical > Specialized Power Systems > FACTS library is a simplified
model, which can simulate different types of STATCOMs. You can use it with phasor simulation type,
available through the Powergui block, for studying dynamic performance and transient stability of
power systems. Due to low frequencies of electromechanical oscillations in large power systems
(typically 0.02 Hz to 2 Hz), this type of study usually requires simulation times of 30–40 seconds or
more.

The STATCOM model described in this example is rather a detailed model with full representation of
power electronics. It uses a square-wave, 48-pulse VSC and interconnection transformers for
harmonic neutralization. This type of model requires discrete simulation at fixed type steps (25 µs in
this case) and it is used typically for studying the STATCOM performance on a much smaller time
range (a few seconds). Typical applications include optimizing of the control system and impact of
harmonics generated by converter.

Description of the STATCOM
The STATCOM described in this example is available in the power_statcom_gto48p model. Load
this model and save it in your working directory as case3 to allow further modifications to the
original system. This model represents a three-bus 500 kV system with a 100 Mvar STATCOM
regulating voltage at bus B1.

The internal voltage of the equivalent system connected at bus B1 can be varied by means of a Three-
Phase Programmable Voltage Source block to observe the STATCOM dynamic response to changes in
system voltage.

STATCOM Power Component

The STATCOM consists of a three-level 48-pulse inverter and two series-connected 3000 µF
capacitors which act as a variable DC voltage source. The variable amplitude 60 Hz voltage produced
by the inverter is synthesized from the variable DC voltage which varies around 19.3 kV.
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Double-click on the STATCOM 500kV 100 MVA block.

It consists of four 3-phase 3-level inverters coupled with four phase shifting transformers introducing
phase shift of +/-7.5 degrees.

Except for the 23rd and 25th harmonics, this transformer arrangement neutralizes all odd harmonics
up to the 45th harmonic. Y and D transformer secondaries cancel harmonics 5+12n (5, 17, 29, 41,...)
and 7+12n (7, 19, 31, 43,...). In addition, the 15° phase shift between the two groups of transformers
(Tr1Y and Tr1D leading by 7.5°, Tr2Y and Tr2D lagging by 7.5°) allows cancellation of harmonics
11+24n (11, 35,...) and 13+24n (13, 37,...). Considering that all 3n harmonics are not transmitted by
the transformers (delta and ungrounded Y), the first harmonics that are not canceled by the
transformers are therefore the 23rd, 25th, 47th and 49th harmonics. By choosing the appropriate
conduction angle for the three-level inverter (σ = 172.5°), the 23rd and 25th harmonics can be
minimized. The first significant harmonics generated by the inverter will then be 47th and 49th.
Using a bipolar DC voltage, the STATCOM thus generates a 48-step voltage approximating a sine
wave.

The following figure reproduces the primary voltage generated by the STATCOM 48-pulse inverter as
well as its harmonics contents.

Frequency Spectrum of Voltage Generated by 48-Pulse Inverter at No Load

This frequency spectrum was obtained by running the power_48pulsegtoconverter example,
which uses the same converter topology. The FFT analysis was performed by using the FFT Analysis
tool in the Powergui block. FFT uses one cycle of inverter voltage during the no-load operation and a
0–6000 Hz frequency range.

 GTO-Based STATCOM

5-21



STATCOM Control System

Open the STATCOM Controller.

The control system task is to increase or decrease the capacitor DC voltage, so that the generated AC
voltage has the correct amplitude for the required reactive power. The control system must also keep
the AC generated voltage in phase with the system voltage at the STATCOM connection bus to
generate or absorb reactive power only (except for small active power required by transformer and
inverter losses).

The control system uses the following modules:

• PLL (phase locked loop) synchronizes GTO pulses to the system voltage and provides a reference
angle to the measurement system.

• Measurement System computes the positive-sequence components of the STATCOM voltage and
current, using phase-to-dq transformation and a running-window averaging.

• Voltage regulation is performed by two PI regulators: from the measured voltage Vmeas and the
reference voltage Vref, the Voltage Regulator block (outer loop) computes the reactive current
reference Iqref used by the Current Regulator block (inner loop). The output of the current
regulator is the α angle which is the phase shift of the inverter voltage with respect to the system
voltage. This angle stays very close to zero except during short periods of time, as explained
below.

A voltage droop is incorporated in the voltage regulation to obtain a V-I characteristics with a
slope (0.03 pu/100 MVA in this case). Therefore, when the STATCOM operating point changes
from fully capacitive (+100 Mvar) to fully inductive (-100 Mvar) the SVC voltage varies between
1-0.03=0.97 pu and 1+0.03=1.03 pu.

• Firing Pulses Generator generates pulses for the four inverters from the PLL output (ω.t) and the
current regulator output (α angle).

To explain the regulation principle, let us suppose that the system voltage Vmeas becomes lower than
the reference voltage Vref. The voltage regulator will then ask for a higher reactive current output
(positive Iq= capacitive current). To generate more capacitive reactive power, the current regulator
will then increase α phase lag of inverter voltage with respect to system voltage, so that an active
power will temporarily flow from AC system to capacitors, thus increasing DC voltage and
consequently generating a higher AC voltage.

As explained in the preceding section, the conduction angle σ of the 3-level inverters has been fixed
to 172.5°. This conduction angle minimizes 23rd and 25th harmonics of voltage generated by the
square-wave inverters. Also, to reduce noncharacteristic harmonics, the positive and negative
voltages of the DC bus are forced to stay equal by the DC Balance Regulator module. This is
performed by applying a slight offset on the conduction angles σ for the positive and negative half-
cycles.

The STATCOM control system also allows selection of Var control mode (see the STATCOM Controller
dialog box). In such a case, the reference current Iqref is no longer generated by the voltage
regulator. It is rather determined from the Qref or Iqref references specified in the dialog box.

Steady-State and Dynamic Performance of the STATCOM
You will now observe steady-state waveforms and the STATCOM dynamic response when the system
voltage is varied. Open the programmable voltage source menu and look at the sequence of voltage
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steps that are programmed. Also, open the STATCOM Controller dialog box and verify that the
STATCOM is in Voltage regulation mode with a reference voltage of 1.0 pu. Run the simulation and
observe waveforms on the STATCOM scope block. These waveforms are reproduced below.

Waveforms Illustrating STATCOM Dynamic Response to System Voltage Steps

Initially the programmable voltage source is set at 1.0491 pu, resulting in a 1.0 pu voltage at bus B1
when the STATCOM is out of service. As the reference voltage Vref is set to 1.0 pu, the STATCOM is
initially floating (zero current). The DC voltage is 19.3 kV. At t=0.1s, voltage is suddenly decreased by
4.5% (0.955 pu of nominal voltage). The STATCOM reacts by generating reactive power (Q=+70
Mvar) to keep voltage at 0.979 pu. The 95% settling time is approximately 47 ms. At this point the DC
voltage has increased to 20.4 kV.

Then, at t=0.2 s the source voltage is increased to1.045 pu of its nominal value. The STATCOM reacts
by changing its operating point from capacitive to inductive to keep voltage at 1.021 pu. At this point
the STATCOM absorbs 72 Mvar and the DC voltage has been lowered to 18.2 kV. Observe on the first
trace showing the STATCOM primary voltage and current that the current is changing from
capacitive to inductive in approximately one cycle.

Finally, at t=0.3 s the source voltage in set back to its nominal value and the STATCOM operating
point comes back to zero Mvar.

The figure below zooms on two cycles during steady-state operation when the STATCOM is capacitive
and when it is inductive. Waveforms show primary and secondary voltage (phase A) as well as
primary current flowing into the STATCOM.
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Steady-State Voltages and Current for Capacitive and Inductive Operation

Notice that when the STATCOM is operating in capacitive mode (Q=+70 Mvar), the 48-pulse
secondary voltage (in pu) generated by inverters is higher than the primary voltage (in pu) and in
phase with primary voltage. Current is leading voltage by 90°; the STATCOM is therefore generating
reactive power.

On the contrary, when the STATCOM is operating in inductive mode, secondary voltage is lower than
primary voltage. Current is lagging voltage by 90°; the STATCOM is therefore absorbing reactive
power.

Finally, if you look inside the Signals and Scopes subsystem you will have access to other control
signals. Notice the transient changes on α angle when the DC voltage is increased or decreased to
vary reactive power. The steady-state value of α (0.5 degrees) is the phase shift required to maintain
a small active power flow compensating transformer and converter losses.
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Thyristor-Based HVDC Link
In this section...
“Description of the HVDC Transmission System” on page 5-25
“Frequency Response of the AC and DC Systems” on page 5-26
“Control and Protection Systems” on page 5-27
“System Startup/Stop — Steady-State and Step Response” on page 5-29
“DC Line Fault” on page 5-33
“AC Line-to-Ground Fault at the Inverter” on page 5-35

Description of the HVDC Transmission System
The example in this section illustrates modeling of a high-voltage direct current (HVDC) transmission
link using 12-pulse thyristor converters [1]. Perturbations are applied to examine the system
performance. The objectives of this example are to demonstrate the use of Simscape Electrical
Specialized Power Systems blocks in combination with Simulink blocks in the simulation of a
complete pole of a 12-pulse HVDC transmission system.

Open the power_hvdc12pulse model and save it under a different name to allow further
modifications to the original system.

A 1000 MW (500 kV, 2 kA) DC interconnection is used to transmit power from a 500 kV, 5000 MVA, 60
Hz system to a 345 kV, 10000 MVA, 50 Hz system. The AC systems are represented by damped L-R
equivalents with an angle of 80 degrees at fundamental frequency (60 Hz or 50 Hz) and at the third
harmonic.

The rectifier and the inverter are 12-pulse converters using two Universal Bridge blocks connected in
series. The converters are interconnected through a 300-km line and 0.5 H smoothing reactors. The
converter transformers (Wye grounded/Wye/Delta) are modeled with Three-Phase Transformer
(Three-Windings) blocks. The transformer tap changers are not simulated. The tap position is rather
at a fixed position determined by a multiplication factor applied to the primary nominal voltage of the
converter transformers (0.90 on the rectifier side; 0.96 on the inverter side).

From the AC point of view, an HVDC converter acts as a source of harmonic currents. From the DC
point of view, it is a source of harmonic voltages.

The order n of these characteristic harmonics is related to the pulse number p of the converter
configuration: n = kp ± 1 for the AC current and n = kp for the direct voltage, k being any integer. In
the example, p = 12, so that injected harmonics on the AC side are 11, 13, 23, 25, and on the DC side
are 12, 24.

AC filters are used to prevent the odd harmonic currents from spreading out on the AC system. The
filters are grouped in two subsystems. These filters also appear as large capacitors at fundamental
frequency, thus providing reactive power compensation for the rectifier consumption due to the firing
angle α. For α = 30 degrees, the converter reactive power demand is approximately 60% of the power
transmitted at full load. The AC filters subsystem contains the high Q (100) tuned filters at the 11th
and 13th harmonics and the low Q (3), or damped filter, used to eliminate the higher order
harmonics, e.g., 24th and up. Extra reactive power is also provided by capacitor banks.

Two Breaker blocks apply faults on the rectifier DC side and on the inverter AC side to examine
system performance.
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The power system and the control and protection system are both discretized with the same sample
time Ts = 50 µs. Some protection systems have a sample time of 1 or 2 ms.

Frequency Response of the AC and DC Systems
The section “Analyze a Simple Circuit” on page 1-10 explains how you can use the Impedance
Measurement block to compute the impedance of a linear system from its state-space model. As the
thyristor valves of the converters are nonlinear blocks, they are ignored in the impedance calculation
and you get the impedances with the valves open.

The rectifier and inverter subsystems use Impedance Measurement blocks to measure the frequency
response between phase A and phase B of the AC systems. Measuring the impedance between two
phases gives two times the positive-sequence impedance. Therefore you specify a multiplication
factor of 1/2 on the Impedance Measurement blocks to obtain the correct impedance value. The ZDC
Impedance Measurement block measures the impedance on the DC line rectifier terminal side.

You can use the Impedance vs Frequency Measurement tool of Powergui to display the magnitude
and phase as a function of frequency measured by the three Impedance Measurement blocks..

The magnitudes of the three impedances as a function of frequency are shown here.

Positive-Sequence Impedances of the Two AC Systems and of the DC Line

Note the two minimum impedances on the Z magnitudes of the AC systems. These series resonances
are created by the 11th and 13th harmonic filters. They occur at 660 Hz and 780 Hz on the 60 Hz
system. Note also that the addition of 600 Mvar capacitive filters on the inductive systems creates
resonances around 188 Hz on the rectifier side and 220 Hz on the inverter side. In the 60 Hz region,
the magnitude is 56.75 Ω for the 60 Hz system, corresponding to an effective short-circuit level of
5002/56.75 = 4405 MVA on the rectifier side (5000 MVA - 600 Mvar of filters).
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For the DC line, note the series resonance at 240 Hz, which corresponds to the main mode likely to
be excited on the DC side, under large disturbances.

Control and Protection Systems
The Rectifier Pole Control (Current) and the Inverter Pole Control (Current/Voltage/Gamma)
subsystems generate the current reference for both converters and initiates the starting and stopping
of the DC power transmission. At the inverter, the Gamma Measurement subsystem measures the
extinction angle Gamma of the 6-pulse thyristor converters.

The protection systems can be switched on and off. At the rectifier, the DC fault protection detects a
fault on the line and takes the necessary action to clear the fault. The Low AC Voltage Detection
subsystem at the rectifier and inverter serves to discriminate between an AC fault and a DC fault. At
the inverter, the Commutation Failure Prevention Control subsystem [2] mitigates commutation
failures due to AC voltage dips.

Synchronization and Firing System

The synchronization and generation of the 12 firing pulses is performed by the 12-Pulse Firing
Control system. This system uses the primary voltages to synchronize and generate the pulses
according to the alpha firing angle computed by converter controller. The synchronizing voltages are
measured at the primary side of the converter transformer because the waveforms are less distorted.
A Phase Locked Loop (PLL) is used to generate three voltages synchronized on the fundamental
component of the positive-sequence voltages. The firing pulse generator is synchronized to the three
voltages generated by the PLL. At the zero crossings of the commutating voltages (AB, BC, CA), a
ramp is reset. A firing pulse is generated whenever the ramp value becomes equal to the desired
delay angle provided by the controller.

Steady-State V-I Characteristic

The Rectifier Pole Control and the Inverter Pole Control subsystems implement this steady-state
characteristic:

Rectifier and Inverter Steady-State Characteristics and VDCOL Function

In normal operation, the rectifier controls the current at the Id_ref reference value, whereas the
inverter controls the voltage or gamma at the Vd_ref or Gamma_min reference value.
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The system normally operates at point 1 as shown in the figure. However, during a severe
contingency producing a voltage drop on the AC system 1 feeding the rectifier, the operating point
moves to point 2. The rectifier, therefore, is forced to a minimum α mode and the inverter is in
current control mode. Similarly, a voltage drop on the AC system feeding the inverter will force a
control mode change to Gamma regulation to limit the angle to γ min. During severe contingency, a
faster response is necessary to increase the commutation margin and consequently to reduce the
probability of a commutation failure. The Commutation Failure Prevention Control subsystem (look
under the Inverter protections block) generates a signal that decreases the maximum limit of the
delay angle during the voltage drop (e.g., during an AC fault).

Note γ = extinction angle = 180º - α - µ , µ = commutation or overlap angle

VDCOL Function

Another important control function is implemented to change the reference current according to the
value of the DC voltage. This control, named Voltage Dependent Current Order Limiter (VDCOL),
automatically reduces the reference current (Id_ref) set point when VdL decreases (as, for example,
during a DC line fault or a severe AC fault). Reducing the Id reference currents also reduces the
reactive power demand on the AC system, helping to recover from fault. The VDCOL parameters are
explained by this diagram:

VDCOL Characteristic; Id_ref = f(VdL)

The Id_ref value starts to decrease when the Vd line voltage falls below a threshold value
VdThresh. The actual reference current used by the controllers is available at the second controller
output, named Id_ref_lim. IdMinAbs is the absolute minimum Id_ref value. When the DC line
voltage falls below the VdThresh value, the VDCOL drops instantaneously to Id_ref. However,
when the DC voltage recovers, VDCOL limits the Id_ref rise time with a time constant defined by
parameter Tup.

Current, Voltage, and Gamma Regulators

Both rectifier and inverter controls have current regulator calculating firing αi. At the inverter,
operating in parallel with the current regulator are the voltage and/or gamma regulators calculating
firing angles αv and/or αg. The effective α angle is the minimum value of αi, αv and/or αg. All regulators
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are of the proportional- integral type. They should have high enough gains for low frequencies
(<10 Hz) to maintain the current, voltage, or gamma response equal to the reference current
(Id_ref_lim), reference voltage (Vd_ref), or reference gamma (Gamma_min), as long as α is within
the minimum and maximum limits (5º < α < 166º for rectifier, 92º < α < 166º for inverter). As
described before, a signal (D_alpha) received from the Commutation Failure Prevention protection
can temporarily reduce the 166º limit at the inverter. The regulator gains Kp and Ki are adjusted
during small perturbations in the reference.

Another particularity of the regulator is the linearization of the proportional gain. As the Vd voltage
generated by the rectifier and the inverter is proportional to cos(α), the ΔVd variation due to a Δα
change is proportional to sin(α). With a constant Kp value, the effective gain is, therefore,
proportional to sin(α). To keep a constant proportional gain, independent of the α value, the gain is
linearized by multiplying the Kp constant by 1/sin(α). This linearization is applied for a range of α
defined by two limits specified in the Rectifier and Inverter Pole Control blocks.

System Startup/Stop — Steady-State and Step Response
The system is programmed to start and reach a steady state. Then a step is applied first to the
reference current and later to the voltage reference so you can observe the dynamic response of the
regulators. Finally, a stop sequence is initiated to bring the power transmission smoothly down before
blocking the converters. Notice in the Converter Controller that after reception of the Stop signal a
Forced_alpha is ordered for 0.150 s, and then 0.1 s later the blocking of the pulses is ordered.

Start the simulation and observe the signals on the Rectifier and Inverter scopes. The waveforms are
reproduced here:
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Startup/Stop of the DC System and Step Applied on the Current and Voltage Reference

In the Master Control, the converters pulse generators are deblocked and the power transmission
started by ramping the reference current at t = 20 ms. The reference reaches the minimum value of
0.1 pu in 0.3 s. Observe that the DC current starts to build and the DC line is charged at its nominal
voltage. At t = 0.4 s, the reference current is ramped from 0.1 to 1 pu (2 kA) in 0.18 s (5 pu/s). The
DC current reaches steady state at the end of the starting sequence at approximately 0.58 s. The
rectifier controls the current and the inverter controls the voltage. Trace 1 of both Rectifier and
Inverter scopes shows the DC line voltage (1 pu = 500 kV). At the inverter, the voltage reference is
also shown. Trace 2 shows the reference current and the measured Id current (1 pu = 2 kA). During
the ramp, the inverter is actually controlling the current (Trace 4: Mode = 1) to the value of
Id_ref_lim less the Current Margin (0.1 pu) and the rectifier tries to control the current at
Id_ref_lim. At the inverter, the control mode changes from current control to gamma control
(Mode = 6) before stabilizing to voltage control (Mode = 2) at t = 0.3 s. The rectifier becomes
thereafter in control of the current. However, a control mode change will occur and alpha is limited to
the minimum value of 5 degrees (Mode = 3) during an increase of the DC voltage initiated by a
voltage reference increase at the inverter, as explained in the next paragraph. At steady state
(measured at t between 1.3 and 1.4 s), the α firing angles are around 16.5 degrees and 143 degrees
respectively on the rectifier and inverter side. The inverter control measures the extinction angle γ
for each thyristor of the two six-pulse bridges (i.e., the bridge connected to the Wye and Delta
windings) by determining the elapsed time expressed in electrical degrees from the end of current
conduction to the zero crossing of the commutating voltage. The mean value of the measured gamma
for the last 12 extinctions (6 of the Delta converter and 6 of the Wye converter) is shown in traces 5
along with Gamma reference. In steady state, the mean γ is around 22.5 degrees.
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At t = 0.7 s, a -0.2 pu step is applied during 0.1 s to the reference current so that you can observe the
dynamic response of the regulators. Later on, at t = 1.0 s, a 0.1 pu step is applied during 0.2 s at the
inverter reference voltage. Observe that at the inverter the extinction angle reaches the reference
value (e.g., the minimum acceptable value) and that the Gamma regulator takes control at t around
1.1 s. At t around 1.3 s the voltage regulator retakes control of the voltage.

At t = 1.4 s the Stop sequence is initiated by ramping down the current to 0.1 pu. At t = 1.6 s a
Forced-alpha (to 166 deg) at the rectifier extinguishes the current and at the inverter the Forced-
alpha (to 92 deg with a limited rate) brings down the DC voltage due to the trapped charge in the line
capacitance. At t = 1.7 s the pulses are blocked in both converters.

Comparison of Theory and Simulation Results in Steady State

The main equations governing the steady-state operation of the DC system are given here so that you
can compare the theoretical values to the simulation results.

The following expression relates the mean direct voltage Vd of a 12-pulse bridge to the direct current
Id and firing angle α (neglecting the ohmic losses in the transformer and thyristors):

Vd = 2 × Vdo × cos α − Rc × Id

where Vdo is the ideal no-load direct voltage for a six-pulse bridge:

Vdo = 3 2/π × Vc

Vc is the line-to-line RMS commutating voltage that is dependent on the AC system voltage and the
transformer ratio.

Rc is the equivalent commutating resistance.

Rc = 3/π × Xc

Xc is the commutating reactance or transformer reactance referred to the valve side.

The following rectifier parameters were used in the simulation.

The Vc voltage must take into account the effective value of the voltage on the 500 kV bus and the
transformer ratio. If you look at the waveforms displayed on the AC_Rectifier scope, you find 0.96 pu
when the direct current Id has reached its steady state (1 pu).

If you open the rectifier transformer dialog box, you find a multiplication factor of 0.90 applied to the
primary nominal voltage. The voltage applied to the inverter is therefore boosted by a factor of
1/0.90.

Vc = 0.96 * 200 kV/0.90 = 213.3 kV
Id = 2 kA
α = 16.5º
Xc = 0.24 pu, based on 1200 MVA and 222.2 kV = 9.874 Ω

Therefore, this theoretical voltage corresponds well with the expected rectifier voltage calculated
from the inverter voltage and the voltage drop in the DC line (R = 4.5 Ω) and in the rectifier
smoothing reactor (R = 1 Ω):

Vd = VdLinverter + RDCline + Rinductance × Id
Vd = 500 kV + 4.5 Ω + 1 Ω × 2 = 511 kV
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The µ commutation or overlap angle can also be calculated. Its theoretical value depends on α, the
DC current Id, and the commutation reactance Xc.

Vdo = 3 2/π × 213.3 = 288.1 kV

Rc = 3/π × 9.874 = 9.429 Ω

Vd = 2 × 288.1 kV × cos 16.5° − 9.429 × 2 = 515 kV

μ = acos cos α − Xc ⋅ Id ⋅ 2
Vc − α

μ = acos cos 16.5° − 9.874 ⋅ 2 ⋅ 2
213.3 − 16.5° = 17.6°

Now verify the commutation angle by observing the currents in two valves, for example, current
extinction in valve 1 and current buildup in valve 3 of the Y six-pulse bridge of the rectifier. These
signals are available in the VALVE13_RECT scope.

The waveforms illustrating two cycles are shown in the following figure. The measured commutation
angle is 14 steps of 50 µs or 15.1º of a 60 Hz period. The resolution with a 50 µs time step is 1.1º; this
angle compares reasonably well with the theoretical value.

Valve Voltage and Currents (Commutation from Valve 1 to Valve 3)

Finally, to validate the γ measurement at the inverter, observe the valve 1 voltage and current in the
VALVE1_INV scope. Also observe the commutating voltage corresponding to the outgoing valve 1 to
be extinguished and the mean value of γ as shown in “Current and Commutation Voltage of Valve 1
Showing γ” on page 5-33. Verify also that the values of α, µ, and γ add up to 180º.
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Current and Commutation Voltage of Valve 1 Showing γ

DC Line Fault
Deactivate the steps applied on the current reference and on the voltage reference in the Master
Control and in the Inverter Control and Protection respectively by setting the switches in lower
position. In the DC Fault block, change the multiplication factor of 100 to 1, so that a fault is now
applied at t = 0.7 s. Reduce the Simulation Stop time to 1.4 s. Open the Rectifier scope as well as the
Fault scope to observe the fault current and the Protection Rectifier scope to observe the DC Fault
protection action. Restart the simulation.
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DC Line Fault on the Rectifier Side
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At fault application (t = 0.7 s), the DC current increases to 2.2 pu and the DC voltage falls to zero at
the rectifier. This DC voltage drop is seen by the Voltage Dependent Current Order Limiter (VDCOL)
and the DC Fault protection. The VDCOL reduces the reference current to 0.3 pu at the rectifier. A
DC current still continues to circulate in the fault. Then, at t = 0.77 s, the rectifier α firing angle is
forced to 166 degrees by the DC Fault protection after detecting a low DC voltage. The rectifier now
operates in inverter mode. The DC line voltage becomes negative and the energy stored in the line is
returned to the AC system, causing rapid extinction of the fault current at its next zero crossing. Then
α is released at t = 0.82 s and the normal DC voltage and current recover in approximately 0.5 s.
Notice, the temporary mode change in the Rectifier controls between 1.18 s and 1.25 s.

AC Line-to-Ground Fault at the Inverter
Now modify the fault timings to apply a line-to-ground fault. In the DC Fault block, change the
multiplication factor of 1 to 100, so that the DC fault is now eliminated. In the A-G Fault block,
change the multiplication factor in the switching times to 1, so that a six-cycle line-to-ground fault is
now applied at t = 0.7 s at the inverter. Restart the simulation.
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Rectifier, Inverter Signals for an AC Line Fault on Inverter Side
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Voltages and Currents on the 50 Hz Side for an AC Line Fault on the Inverter Side

Notice the 120 Hz oscillations in the DC voltage and currents during the fault. An unavoidable
commutation failure occurs at the inverter at the very beginning of the fault and the DC current
increases to 2 pu. A commutation failure is the result of a failure of the incoming valve to take over
the direct current before the commutation voltage reverses its polarity. The symptoms are a zero DC
voltage across the affected bridge causing an increase of the DC current at a rate determined mainly
by the DC circuit inductance. When the fault is cleared at t = 0.8 s, the VDCOL operates and reduces
the reference current to 0.3 pu. The system recovers in approximately 0.35 s after fault clearing.

Look at the waveforms displayed on the PROTECTION INVERTER scope. The Low AC Voltage block
detects the fault and locks the DC Fault protection that in this case should not detect a DC fault even
if the DC line voltage dips. Look at the Commutation Failure Prevention Control (CFPREV) output
(A_min_I) which decreases the maximum delay angle limit to increase the commutation margin
during and after the fault.

Now open the dialog box of the CFPREV block located inside the Inverter Protections subsystem and
deactivate the CFPREV protection by deselecting the “ON State.” Restart the simulation. Notice the
slightly different transient behavior during and after the fault.
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VSC-Based HVDC Link
In this section...
“Introduction” on page 5-38
“Description of the HVDC Link” on page 5-38
“VSC Control System” on page 5-40
“Dynamic Performance” on page 5-43

Introduction
The increasing rating and improved performance of self-commutated semiconductor devices have
made possible High Voltage DC (HVDC) transmission based on Voltage-Sourced Converter (VSC). Two
technologies offered by the manufacturers are the HVDC Light [1 on page 5-46] and the HVDCplus [2
on page 5-46].

The example described in this section illustrates modeling of a forced-commutated Voltage-Sourced
Converter high-voltage direct current (VSC-HVDC) transmission link. The objectives of this example
are to demonstrate the use of Simscape Electrical Specialized Power Systems blocks in the simulation
of a HVDC transmission link based on three-level Neutral Point Clamped (NPC) VSC converters with
single-phase carrier based Sinusoidal Pulse Width Modulation (SPWM) switching. Perturbations are
applied to examine the system dynamic performance.

Description of the HVDC Link
The principal characteristic of VSC-HVDC transmission is its ability to independently control the
reactive and real power flow at each of the AC systems to which it is connected, at the Point of
Common Coupling (PCC). In contrast to line-commutated HVDC transmission, the polarity of the DC
link voltage remains the same with the DC current being reversed to change the direction of power
flow.

The HVDC link described in this example is available in the power_hvdc_vsc model. You can run
the command by entering the following in the MATLAB Command Window: power_hvdc_vsc. Load
this model and save it in your working directory as case5 to allow further modifications to the
original system. This model represents a 200 MVA, +/- 100 kV VSC-HVDC transmission link.

The 230 kV, 2000 MVA AC systems (AC system1 and AC system2 subsystems) are modeled by damped
L-R equivalents with an angle of 80 degrees at fundamental frequency (50 Hz) and at the third
harmonic. The VSC converters are three-level bridge blocks using IGBT/diodes. The relative ease with
which the IGBT can be controlled and its suitability for high-frequency switching, has made this
device the better choice over GTO and thyristors. Open the Station 1 and Station 2 subsystems to see
how they are built.

A converter transformer (Wye grounded /Delta) is used to permit the optimal voltage transformation.
The present winding arrangement blocks tripplen harmonics produced by the converter. The
transformer tap changer or saturation are not simulated. The tap position is rather at a fixed position
determined by a multiplication factor applied to the primary nominal voltage of the converter
transformers The multiplication factors are chosen to have a modulation index around 0.85
(transformer ratios of 0.915 on the rectifier side and 1.015 on the inverter side). The converter
reactor and the transformer leakage reactance permit the VSC output voltage to shift in phase and
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amplitude with respect to the AC system, and allows control of converter active and reactive power
output.

To meet AC system harmonic specifications, AC filters form an essential part of the scheme. They can
be connected as shunt elements on the AC system side or the converter side of the converter
transformer. Since there are only high frequency harmonics, shunt filtering is therefore relatively
small compared to the converter rating. It is sufficient with a high pass-filter and no tuned filters are
needed. The later arrangement is used in our model and a converter reactor, an air cored device,
separates the fundamental frequency (filter bus) from the raw PWM waveform (converter bus). The
AC harmonics generation [4] mainly depends on the:

• Type of modulation (e.g. single-phase or three-phase carrier based, space vector, etc.)
• Frequency index p = carrier frequency / modulator frequency (e.g. p = 1350/50 = 27)
• Modulation index m = fundamental output voltage of the converter / pole to pole DC voltage

The principal harmonic voltages are generated at and around multiples of p. The shunt AC filters are
27th and 54th high pass totaling 40 Mvar. To illustrate the AC filter action, we did an FFT analysis in
steady state of the converter phase A voltage and the filter bus phase A voltage, using the Powergui
block. The results are shown in “Phase A Voltage and FFT Analysis: (a) Converter Bus (b) Filter Bus”
on page 5-39.

Phase A Voltage and FFT Analysis: (a) Converter Bus (b) Filter Bus

The reservoir DC capacitors are connected to the VSC terminals. They have an influence on the
system dynamics and the voltage ripple on the DC side. The size of the capacitor is defined by the
time constant τ corresponding to the time it takes to charge the capacitor to the base voltage (100
kV) if it is charged with the base current (1 kA). This yields

τ = C · Zbase = 70e-6 · 100 = 7 ms

with Zbase = 100kV/1 kA

The DC side filters blocking high-frequency are tuned to the 3rd harmonic, i.e., the main harmonic
present in the positive and negative pole voltages. It is shown that a reactive converter current
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generate a relatively large third harmonic in both the positive and negative pole voltages [3] but not
in the total DC voltage. The DC harmonics can also be zero-sequence harmonics (odd multiples of 3)
transferred to the DC side (e.g., through the grounded AC filters). A smoothing reactor is connected
in series at each pole terminal.

To keep the DC side balanced, the level of the difference between the pole voltages has to be
controlled and kept to zero (see the DC Voltage Balance Control block in the VSC Controller block).

The rectifier and the inverter are interconnected through a 75 km cable (2 pi sections). The use of
underground cable is typical for VSC-HVDC links. A circuit breaker is used to apply a three-phase to
ground fault on the inverter AC side. A Three-Phase Programmable Voltage Source block is used in
station 1 system to apply voltage sags.

VSC Control System
“Overview of the Control System of a VSC Converter and Interface to the Main Circuit” on page 5-40
shows an overview diagram of the VSC control system and its interface with the main circuit [3].

Overview of the Control System of a VSC Converter and Interface to the Main Circuit

The converter 1 and converter 2 controller designs are identical. The two controllers are independent
with no communication between them. Each converter has two degrees of freedom. In our case, these
are used to control:

• P and Q in station 1 (rectifier)
• Udc and Q in station 2 (inverter).

The control of the AC voltage would be also possible as an alternative to Q. This requires an extra
regulator which is not implemented in our model.

Open the VSC Controller subsystem to see the details.
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The sample time of the controller model (Ts_Control) is 74.06 µs, which is ten times the simulation
sample time. The later is chosen to be one hundredth of the PWM carrier period (i.e., 0.01/1350 s)
giving an acceptable simulation precision. The power elements, the anti-aliasing filters and the PWM
Generator block use the fundamental sample time (Ts_Power) of 7.406 µs. The unsynchronized PWM
mode of operation is chosen for our model.

The normalized sampled voltages and currents (in pu) are provided to the controller.

The Clark Transformations block transforms the three-phase quantities to space vector components α
and β (real and imaginary part). The signal measurements (U and I) on the primary side are rotated
by ±pi/6 according to the transformer connection (YD11 or YD1) to have the same reference frame
with the signal measured on the secondary side of the transformer (see block CLARK YD).

The dq transformations block computes the direct axis “d” and the quadratic axis “q” quantities (two
axis rotating reference frame) from the α and β quantities.

The Signal Calculations block calculates and filters quantities used by the controller (e.g., active and
reactive power, modulation index, DC current and voltage, etc.).

Phase Locked Loop (PLL)

The Phase Locked Loop block measures the system frequency and provides the phase synchronous
angle Θ (more precisely [sin(Θ), cos(Θ)]) for the dq Transformations block. In steady state, sin(Θ) is in
phase with the fundamental (positive sequence) of the α component and phase A of the PCC voltage
(Uabc).

Outer Active and Reactive Power and Voltage Loop

The active and reactive power and voltage loop contains the outer loop regulators that calculates the
reference value of the converter current vector (Iref_dq) which is the input to the inner current loop.
The control modes are: in the “d” axis, either the active power flow at the PCC or the pole-to-pole DC
voltage; in the “q” axis, the reactive power flow at the PCC. Note that, it would be also possible to add
an AC voltage control mode at the PCC in the “q” axis. The main functions of the Active and reactive
power and voltage loop are described below.

The Reactive Power Control regulator block combines a PI control with a feedforward control to
increase the speed response. To avoid integrator wind-up the following actions are taken: the error is
reset to zero, when the measured PCC voltage is less than a constant value (i.e., during an AC
perturbation); when the regulator output is limited, the limitation error is fed back with the right
sign, to the integrator input. The AC Voltage control override block, based on two PI regulators, will
override the reactive power regulator to maintain the PCC AC voltage within a secure range,
especially in steady-state.

The Active Power Control block is similar to the Reactive Power Control block. The extra Ramping
block ramps the power order towards the desired value with an adjusted rate when the control is de-
blocked. The ramped value is reset to zero when the converter is blocked. The DC Voltage control
override block, based on two PI regulators, will override the active power regulator to maintain the
DC voltage within a secure range, especially during a perturbation in the AC system of the station
controlling the DC voltage.

The DC Voltage Control regulator block uses a PI regulator. The block is enabled when the Active
Power Control block is disabled. The block output is a reference value, for the “d” component of
converter current vector, for the Current Reference Limitation block.
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The Current Reference Calculation block transforms the active and reactive power references,
calculated by the P and Q controllers, to current references according to the measured (space vector)
voltage at the filter bus. The current reference is estimated by dividing the power reference by the
voltage (up to a minimum preset voltage value).

The current reference vector is limited to a maximum acceptable value (i.e., equipment dependent)
by the Current Reference Limitation block. In power control mode, equal scaling is applied to the
active and reactive power reference when a limit is imposed. In DC voltage control mode, higher
priority is given to the active power when a limit is imposed for an efficient control of the voltage.

Inner Current Loop

The main functions of Inner Current Loop block are described below.

The AC Current Control block tracks the current reference vector (“d” and “q” components) with a
feed forward scheme to achieve a fast control of the current at load changes and disturbances (e.g.,
so short-circuit faults do not exceed the references) [3] [5] [6]. In essence, it consist of knowing the
U_dq vector voltages and computing what the converter voltages have to be, by adding the voltage
drops due to the currents across the impedance between the U and the PWM-VSC voltages. The state
equations representing the dynamics of the VSC currents are used (an approximation is made by
neglecting the AC filters). The “d” and “q” components are decoupled to obtain two independent first-
order plant models. A proportional integral (PI) feedback of the converter current is used to reduce
the error to zero in steady state. The output of the AC Current Control block is the unlimited
reference voltage vector Vref_dq_tmp.

The Reference Voltage Conditioning block takes into account the actual DC voltage and the
theoretical maximum peak value of the fundamental bridge phase voltage in relation to the DC
voltage to generate the new optimized reference voltage vector. In our model (i.e., a three-level NPC
with carrier based PWM), the ratio between the maximum fundamental peak phase voltage and the
DC total voltage (i.e., for a modulation index of 1) is 2 / 3  = 0.816. By choosing a nominal line
voltage of 100 kV at the transformer secondary bus and a nominal total DC voltage of 200 kV the
nominal modulation index would be 0.816. In theory, the converter should be able to generate up to
1/0.816 or 1.23 pu when the modulation index is equal to 1. This voltage margin is important for
generating significant capacitive converter current (i.e., a reactive power flow to the AC system).

The Reference Voltage Limitation block limits the reference voltage vector amplitude to 1.0, since
over modulation is not desired.

The Inverse dq and Inverse Clark transformation blocks are required to generate the three-phase
voltage references to the PWM.

DC Voltage Balance Control

The DC Voltage Balance Control can be enabled or disabled. The difference between the DC side
voltages (positive and negative) are controlled to keep the DC side of the three level bridge balanced
(i.e., equal pole voltages) in steady-state. Small deviations between the pole voltages may occur at
changes of active/reactive converter current or due to nonlinearity on lack of precision in the
execution of the pulse width modulated bridge voltage. Furthermore, deviations between the pole
voltages may be due to inherent unbalance in the circuit components impedance.

The DC midpoint current Id0 determines the difference Ud0 between the upper and lower DC voltages
(“DC Voltages and Currents of the Three-Level Bridge” on page 5-43) .

5 Transients and Power Electronics in Power Systems

5-42



DC Voltages and Currents of the Three-Level Bridge

Id0 = − Id1 + Id2 = − C ⋅ d
dt Ud1−Ud2 = − C ⋅ d

dt Ud0

By changing the conduction time of the switches in a pole it is possible to change the average of the
DC midpoint current Id0 and thereby control the difference voltage Ud0. For example, a positive
difference (Ud0 ≥ 0) can be decreased to zero if the amplitude of the reference voltage which
generates a positive midpoint current is increased at the same time as the amplitude of the reference
voltage which generates a negative DC midpoint current is decreased. This is done by the addition of
an offset component to the sinusoidal reference voltage. Consequently, the bridge voltage becomes
distorted, and to limit the distortion effect, the control has to be slow. Finally, for better performance
this function should be activated in the station controlling the DC voltage.

Dynamic Performance
In the next sections, the dynamic performance of the transmission system is verified by simulating
and observing the

• Dynamic response to step changes applied to the principal regulator references, like active/
reactive power and DC voltage

• Recovery from minor and severe perturbations in the AC system

For a comprehensive explanation of the procedure followed obtaining these results and more, refer to
the Model Information block.
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System Startup - Steady-State and Step Response

Startup and P & Q Step Responses in Station 1
The main waveforms from the scopes are reproduced below.

Startup and Udc Step Response in Station 2

Station 2 converter controlling DC voltage is first deblocked at t=0.1 s. Then, station 1 controlling
active power converter is deblocked at t=0.3 s and power is ramped up slowly to 1 pu. Steady state is
reached at approximately t=1.3 s with DC voltage and power at 1.0 pu (200 kV, 200 MW). Both
converters control the reactive power flow to a null value in station 1 and to 20 Mvar (-0.1 pu) into
station 2 system.

After steady state has been reached, a -0.1 pu step is applied to the reference active power in
converter 1 (t=1.5 s) and later a -0.1 pu step is applied to the reference reactive power (t=2.0 s). In
station 2, a -0.05 pu step is applied to the DC voltage reference. The dynamic response of the
regulators are observed. Stabilizing time is approximately 0.3 s.The control design attempts to
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decouple the active and reactive power responses. Note how the regulators are more or less mutually
affected.

AC Side Perturbations

From the steady-state condition, a minor and a severe perturbation are executed at station 1 and 2
systems respectively. A three-phase voltage sag is first applied at station 1 bus. Then, following the
system recovery, a three-phase to ground fault is applied at station 2 bus. The system recovery from
the perturbations should be prompt and stable. The main waveforms from the scopes are reproduced
in the two figures below.

Voltage Step on AC System 1

The AC voltage step (-0.1 pu) is applied at t=1.5 s during 0.14 s (7 cycles) at station 1. The results
show that the active and reactive power deviation from the pre-disturbance is less than 0.09 pu and
0.2 pu respectively. The recovery time is less than 0.3 s and the steady state is reached before next
perturbation initiation.

The fault is applied at t=2.1 s during 0.12 s (6 cycles) at station 2.
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Three-Phase to Ground Fault at Station 2 Bus

Note that during the three-phase fault the transmitted DC power is almost halted and the DC voltage
tends to increase (1.2 pu) since the DC side capacitance is being excessively charged. A special
function (DC Voltage Control Override) in the Active Power Control (in station 1) attempts to limit the
DC voltage within a fixed range. The system recovers well after the fault, within 0.5 s. Note the
damped oscillations (around 10 Hz) in the reactive power.
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Transient Stability of Power Systems
Using Phasor Simulation

These case studies provide detailed, realistic examples of how to use the Simscape Electrical
Specialized Power Systems phasor simulation method in typical power utility applications.

As explained in the section “Using the Phasor Solution Method for Stability Studies” on page 2-33,
phasor simulation is the preferred method for simulating power grids when you are interested in the
magnitude and phase of voltages and currents at fundamental frequency (50 Hz or 60 Hz). The
phasor simulation method is activated by means of the Powergui block. It supports all the elements of
the Simscape Electrical Specialized Power Systems library. The case studies listed below show
application examples of some of these phasor models.

• “Improve Transient Stability Using SVC and PSS” on page 6-2
• “Control Power Flow Using UPFC and PST” on page 6-6
• “Wind Farm Using Doubly-Fed Induction Generators” on page 6-13
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Improve Transient Stability Using SVC and PSS
In this section...
“Introduction” on page 6-2
“Description of the Transmission System” on page 6-2
“Single-Phase Fault — Impact of PSS — No SVC” on page 6-3
“Three-Phase Fault — Impact of SVC — PSS in Service” on page 6-4

Introduction
The example described in this section illustrates modeling of a simple transmission system containing
two hydraulic power plants. A static var compensator (SVC) and power system stabilizers (PSS) are
used to improve transient stability and power oscillation damping of the system. The power system
illustrated in this example is quite simple. However, the phasor simulation method allows you to
simulate more complex power grids.

If you are not familiar with the SVC and PSS, please see the reference pages for the following blocks:
Static Var Compensator (Phasor Type), Generic Power System Stabilizer, and Multiband Power
System Stabilizer.

Description of the Transmission System
The single line diagram shown below represents a simple 500 kV transmission system.

500 kV Transmission System

A 1000 MW hydraulic generation plant (M1) is connected to a load center through a long 500 kV, 700
km transmission line. The load center is modeled by a 5000 MW resistive load. The load is fed by the
remote 1000 MVA plant and a local generation of 5000 MVA (plant M2).

A load flow has been performed on this system with plant M1 generating 950 MW so that plant M2
produces 4046 MW. The line carries 944 MW which is close to its surge impedance loading (SIL =
977 MW). To maintain system stability after faults, the transmission line is shunt compensated at its
center by a 200 Mvar static var compensator (SVC). The SVC does not have a power oscillation
damping (POD) unit. The two machines are equipped with a hydraulic turbine and governor (HTG),
excitation system, and power system stabilizer (PSS).

This system is available in the power_svc_pss model. Load this model and save it in your working
directory as case1to allow further modifications to the original system.

First, look inside the two Turbine and Regulators subsystems to see how the HTG and the excitation
system are implemented. Two types of stabilizers can be connected on the excitation system: a
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generic model using the acceleration power (Pa= difference between mechanical power Pm and
output electrical power Peo) and a Multiband stabilizer using the speed deviation (dw). These two
stabilizers are standard models of the Simscape > Electrical > Specialized Power Systems >
Fundamental Blocks > Machines library. Manual Switch blocks surrounded by a blue zone allow
you to select the type of stabilizer used for both machines or put the PSS out of service.

The SVC is the phasor model from the Simscape > Electrical > Specialized Power Systems >
FACTS library. Open its dialog box and check in the Power data parameters that the SVC rating is +/-
200 Mvar. In the Control parameters, you can select either Voltage regulation or Var control (Fixed
susceptance Bref) mode. Initially the SVC is set in Var control mode with a susceptance Bref=0,
which is equivalent to having the SVC out of service.

A Fault Breaker block is connected at bus B1. You will use it to program different types of faults on
the 500 kV system and observe the impact of the PSS and SVC on system stability.

To start the simulation in steady-state, the machines and the regulators have been previously
initialized by means of the Machine Initialization utility of the Powergui block. Load flow has been
performed with machine M1 defined as a PV generation bus (V=13800 V, P=950 MW) and machine
M2 defined as a swing bus (V=13800 V, 0 degrees). After the load flow has been solved, the reference
mechanical powers and reference voltages for the two machines have been automatically updated in
the two constant blocks connected at the HTG and excitation system inputs: Pref1=0.95 pu (950
MW), Vref1=1.0 pu; Pref2=0.8091 pu (4046 MW), Vref2=1.0 pu.

Single-Phase Fault — Impact of PSS — No SVC
Verify that the PSSs (Generic Pa type) are in service and that a 6-cycle single-phase fault is
programmed in the Fault Breaker block (Phase A checked, fault applied at t=0.1 s and cleared at
t=0.2 s).

Start the simulation and observe signals on the Machines scope. For this type of fault the system is
stable without SVC. After fault clearing, the 0.6 Hz oscillation is quickly damped. This oscillation
mode is typical of interarea oscillations in a large power system. First trace on the Machines scope
shows the rotor angle difference d_theta1_2 between the two machines. Power transfer is maximum
when this angle reaches 90 degrees. This signal is a good indication of system stability. If d_theta1_2
exceeds 90 degrees for too long a period of time, the machines will loose synchronism and the system
goes unstable. Second trace shows the machine speeds. Notice that machine 1 speed increases
during the fault because during that period its electrical power is lower than its mechanical power. By
simulating over a long period of time (50 seconds) you will also notice that the machine speeds
oscillate together at a low frequency (0.025 Hz) after fault clearing. The two PSSs (Pa type) succeed
to damp the 0.6 Hz mode but they are not efficient for damping the 0.025 Hz mode. If you select
instead the Multi-Band PSS, you will notice that this stabilizer type succeeds to damp both the 0.6 Hz
mode and the 0.025 Hz mode.

You will now repeat the test with the two PSSs out of service. Restart simulation. Notice that the
system is unstable without PSS. You can compare results with and without PSS by double-clicking on
the blue block on the right side labeled “Show impact of PSS for 1-phase fault.” The displayed
waveforms are reproduced below.
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Impact of PSS for a Single-Phase Fault

Note This system is naturally unstable without PSS. If you remove the fault (by deselecting phase A
in the Fault Breaker), you will see the instability slowly building up at approximately 1 Hz after a few
seconds.

Three-Phase Fault — Impact of SVC — PSS in Service
You will now apply a 3-phase fault and observe the impact of the SVC for stabilizing the network
during a severe contingency.

First put the two PSS (Generic Pa type) in service. Reprogram the Fault Breaker block to apply a 3-
phase-to-ground fault. Verify that the SVC is in fixed susceptance mode with Bref = 0. Start the
simulation. By looking at the d_theta1_2 signal, you should observe that the two machines quickly fall
out of synchronism after fault clearing. In order not to pursue unnecessary simulation, the Simulink
Stop block is used to stop the simulation when the angle difference reaches 3*360 degrees.

Now open the SVC block menu and change the SVC mode of operation to Voltage regulation. The SVC
will now try to support the voltage by injecting reactive power on the line when the voltage is lower
than the reference voltage (1.009 pu). The chosen SVC reference voltage corresponds to the bus
voltage with the SVC out of service. In steady state the SVC will therefore be floating and waiting for
voltage compensation when voltage departs from its reference set point.

Restart simulation and observe that the system is now stable with a 3-phase fault. You can compare
results with and without SVC by double-clicking on the blue block labeled “Show impact of SVC for 3-
phase fault.” The displayed waveforms are reproduced below.
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Impact of the SVC for a Three-Phase Fault
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Control Power Flow Using UPFC and PST
In this section...
“Introduction” on page 6-6
“Description of the Power System” on page 6-6
“Power Flow Control with the UPFC” on page 6-7
“UPFC P-Q Controllable Region” on page 6-8
“Power Flow Control Using a PST” on page 6-9

Introduction
The example described in this section illustrates application of Simscape Electrical Specialized Power
Systems software to study the steady-state and dynamic performance of a unified power flow
controller (UPFC) used to relieve power congestion in a transmission system.

If you are not familiar with the UPFC, please see the reference page for the Unified Power Flow
Controller (Phasor Type) block.

Description of the Power System
The single-line diagram of the modeled power system is shown in “500 kV / 230 kV Transmission
System” on page 6-6.

500 kV / 230 kV Transmission System

A UPFC is used to control the power flow in a 500 kV /230 kV transmission system. The system,
connected in a loop configuration, consists essentially of five buses (B1 to B5) interconnected through
three transmission lines (L1, L2, L3) and two 500 kV/230 kV transformer banks Tr1 and Tr2. Two
power plants located on the 230 kV system generate a total of 1500 MW which is transmitted to a 500
kV, 15000 MVA equivalent and to a 200 MW load connected at bus B3. Each plant model includes a
speed regulator, an excitation system as well as a power system stabilizer (PSS). In normal operation,
most of the 1200 MW generation capacity of power plant #2 is exported to the 500 kV equivalent
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through two 400 MVA transformers connected between buses B4 and B5. For this example we are
considering a contingency case where only two transformers out of three are available (Tr2= 2*400
MVA = 800 MVA). The load flow shows that most of the power generated by plant #2 is transmitted
through the 800 MVA transformer bank (899 MW out of 1000 MW) and that 96 MW is circulating in
the loop. Transformer Tr2 is therefore overloaded by 99 MVA. The example illustrates how a UPFC
can relieve this power congestion. The UPFC located at the right end of line L2 is used to control the
active and reactive powers at the 500 kV bus B3, as well as the voltage at bus B_UPFC. The UPFC
consists of two 100 MVA, IGBT-based, converters (one shunt converter and one series converter
interconnected through a DC bus). The series converter can inject a maximum of 10% of nominal line-
to-ground voltage (28.87 kV) in series with line L2.

This example is available in the power_upfc model. Load this model and save it in your working
directory as case2to allow further modifications to the original system.

Using the Machine Initialization tool of the Powergui block, the model has been initialized with plants
#1 and #2 generating respectively 500 MW and 1000 MW and with the UPFC out of service (Bypass
breaker closed). The resulting power flow obtained at buses B1 to B5 is indicated on the model by red
numbers. This load flow corresponds to load flow shown in the single-line diagram, in “500 kV / 230
kV Transmission System” on page 6-6.

Power Flow Control with the UPFC
Parameters of the UPFC are given in the dialog box. Verify, in the Power data parameters, that the
series converter is rated 100 MVA with a maximum voltage injection of 0.1 pu. The shunt converter is
also rated 100 MVA. Also verify, in the control parameters, that the shunt converter is in Voltage
regulation mode and that the series converter is in Power flow control mode. The UPFC reference
active and reactive powers are set in the magenta blocks labeled Pref(pu) and Qref(pu). Initially the
Bypass breaker is closed and the resulting natural power flow at bus B3 is 587 MW and -27 Mvar. The
Pref block is programmed with an initial active power of 5.87 pu corresponding to the natural power
flow. Then, at t=10s, Pref is increased by 1 pu (100 MW), from 5.87 pu to 6.87 pu, while Qref is kept
constant at -0.27 pu.

Run the simulation and look on the UPFC scope how P and Q measured at bus B3 follow the
reference values. Waveforms are reproduced below.
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UPFC Dynamic Response to a Change in Reference Power from 587 MW to 687 MW

At t=5 s, when the Bypass breaker is opened, the natural power is diverted from the Bypass breaker
to the UPFC series branch without noticeable transient. At t=10 s, the power increases at a rate of 1
pu/s. It takes one second for the power to increase to 687 MW. This 100 MW increase of active power
at bus B3 is achieved by injecting a series voltage of 0.089 pu with an angle of 94 degrees. This
results in an approximate 100 MW decrease in the active power flowing through Tr2 (from 899 MW
to 796 MW), which now carries an acceptable load. See the variations of active powers at buses B1 to
B5 on the VPQ Lines scope.

UPFC P-Q Controllable Region
Now, open the UPFC dialog box and select Show Control parameters (series converter). Select Mode
of operation = Manual Voltage injection. In this control mode the voltage generated by the series
inverter is controlled by two external signals Vd, Vq multiplexed at the Vdqref input and generated in
the Vdqref magenta block. For the first five seconds the Bypass breaker stays closed, so that the PQ
trajectory stays at the (-27Mvar, 587 MW) point. Then when the breaker opens, the magnitude of the
injected series voltage is ramped, from 0.0094 to 0.1 pu. At 10 s, the angle of the injected voltage
starts varying at a rate of 45 deg/s.

Run the simulation and look on the UPFC scope the P and Q signals who vary according to the
changing phase of the injected voltage. At the end of the simulation, double-click on the blue block
labeled “Double click to plot UPFC Controllable Region.” The trajectory of the UPFC reactive power
as function of its active power, measured at bus B3, is reproduced below. The area located inside the
ellipse represents the UPFC controllable region.
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UPFC Controllable Region

Power Flow Control Using a PST
Although not as flexible as the UPFC, the phase shifting transformer (PST) is nevertheless a very
efficient means to control power flow because it acts directly on the phase angle δ, as shown in
“Power Transfer Between Two Voltage Sources Without and With PST” on page 6-9. The PST is the
most commonly used device to control power flow on power grids.

Power Transfer Between Two Voltage Sources Without and With PST

You will now use a PST with an on load tap changer (OLTC) to control the power flow on your power
system. A phasor model of PST using the delta hexagonal connection is available in the Simscape >
Electrical > Specialized Power Systems > FACTS > Transformers library. For details on this PST
connection, please refer to the Three-Phase OLTC Phase Shifting Transformer Delta-Hexagonal
(Phasor Type) block reference page.

Delete the UPFC block in your model as well as the magenta blocks controlling the UPFC. Also delete
the UPFC Measurements subsystem and the UPFC scope. Add the Three-Phase OLTC Phase Shifting
Transformer Delta-Hexagonal (Phasor Type) block from the Simscape > Electrical > Specialized
Power Systems > FACTS > Transformerslibrary into your model. Connect the ABC terminals to the
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B_UPFC bus and connect the abc terminals to the B3 bus. Now, open the PST block dialog box and
modify the following parameters:

Nominal parameters [Vnom(Vrms Ph Ph) Pnom(VA)
Fnom (Hz)]

[500e3 800e6 60]

Number of taps per half tapped winding 20

The nominal power is set to 800 MVA (maximum expected power transfer through the PST). The
number of taps is set to 20, so that the phase shift resolution is approximately 60/20 = 3 degrees per
step.

In the power system, the natural power flow (without PST) from B_UPFC to B3 is P=+587 MW. If
V1and V2 in “Power Transfer Between Two Voltage Sources Without and With PST” on page 6-9
represent the internal voltages of systems connected respectively to B_UPFC and B3, it means that
the angle δ of equation 1 is positive. Therefore, according to equation 2, to increase power flow from
B_UPFC to B3, the PST phase shift Ψ of abc terminals with respect to ABC terminals must be also
positive. For this type of PST the taps must be moved in the negative direction. This is achieved by
sending pulses to the Down input of the PST tap changer.

The tap position is controlled by sending pulses to either the Up input or the Down input. In our case,
as we need to increase phase shift from zero toward positive values, we have to send pulses to the
Down input. Copy a Pulse Generator block and connect it to the Down input of the PST. Open the
block dialog box and modify the following parameters:

Period 5
Pulse Width (% of period) 10

Therefore, every 5 seconds the taps will be moved by one step in the negative direction and the phase
shift will increase by approximately 3 degrees.

Finally, connect a Bus Selector block to the measurement output m of the PST. Open its dialog box
and select the following two signals:

• Tap
• Psi (degrees)

Connect these two signals to a two input scope to observe the tap position and the phase shift during
simulation. Set the simulation time to 25 s and start simulation.

On the VPQ lines scope, observe voltages at buses B1 to B5 and active and reactive power transfer
through these buses. The variation of tap position, PST phase shift Ψ and active power transfer
through bus B3 (power through PST) and B4 (power through transformer Tr2) are reproduced on the
figure below.
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Control of Active Power Through B3 and B4 by Changing Tap Position of PST

Each tap change produces a phase angle variation of approximately 3 degrees, resulting in a 60 MW
power increase through B3. At tap position -2, the power through transformer Tr2 as decreased from
900 MW to 775 MW, thus achieving the same goal as the UPFC for steady state control. You could get
a better resolution in phase angle and power steps by increasing the number of taps in the OLTC.

You can notice that the discrete variation of phase angle produces overshoots and slight oscillations
in active power. These power oscillations which are typical interarea electromechanical oscillations of
machines in power plants 1 and 2 are quickly damped by the power system stabilizers (PSSs)
connected on the excitation systems.

If you disconnect the PSS from the vstab input of the excitation system (located in the Reg_M1 and
Reg_M2 subsystems of the power plants) you will realize the impact of PSS on interarea oscillation
damping. The active power through B3 with and without PSS is reproduced below. Without PSS, the
1.2 Hz under damped power oscillations are clearly unacceptable.
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Damping of Power Oscillations by PSS
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Wind Farm Using Doubly-Fed Induction Generators
In this section...
“Description of the Wind Farm” on page 6-13
“Turbine Response to a Change in Wind Speed” on page 6-14
“Simulation of a Voltage Sag on the 120 kV System” on page 6-16
“Simulation of a Fault on the 25 kV System” on page 6-18

Description of the Wind Farm
The example described in this section illustrates application of Simscape Electrical Specialized Power
Systems software to study the steady-state and dynamic performance of a 9 MW wind farm connected
to a distribution system.

The wind farm consists of six 1.5 MW wind turbines connected to a 25 kV distribution system
exporting power to a 120 kV grid through a 30 km 25 kV feeder. A 2300V, 2 MVA plant consisting of a
motor load (1.68 MW induction motor at 0.93 PF) and of a 200 kW resistive load is connected on the
same feeder at bus B25. A 500 kW load is also connected on the 575 V bus of the wind farm. The
single-line diagram of this system is illustrated in “Single-Line Diagram of the Wind Farm Connected
to a Distribution System” on page 6-13.

Single-Line Diagram of the Wind Farm Connected to a Distribution System

Both the wind turbine and the motor load have a protection system monitoring voltage, current and
machine speed. The DC link voltage of the DFIG is also monitored. Wind turbines use a doubly-fed
induction generator (DFIG) consisting of a wound rotor induction generator and an AC/DC/AC IGBT-
based PWM converter. The stator winding is connected directly to the 60 Hz grid while the rotor is
fed at variable frequency through the AC/DC/AC converter. The DFIG technology allows extracting
maximum energy from the wind for low wind speeds by optimizing the turbine speed, while
minimizing mechanical stresses on the turbine during gusts of wind. The optimum turbine speed
producing maximum mechanical energy for a given wind speed is proportional to the wind speed.
Another advantage of the DFIG technology is the ability for power electronic converters to generate
or “Turbine Power Characteristics” on page 6-14 absorb reactive power, thus eliminating the need
for installing capacitor banks as in the case of squirrel-cage induction generators.

This system is available in the power_wind_dfig model. Load this model and save it in your working
directory as case3to allow further modifications to the original system. In this case study, the rotor is
running at subsynchronous speed for wind speeds lower than 10 m/s and it is running at a super-
synchronous speed for higher wind speeds. The turbine mechanical power as function of turbine
speed is displayed in for wind speeds ranging from 5 m/s to 16.2 m/s. These characteristics are
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obtained with the specified parameters of the Turbine data (“Turbine Power Characteristics” on
page 6-14).

Turbine Power Characteristics

The DFIG is controlled to follow the ABCD curve in “Turbine Power Characteristics” on page 6-14.
Turbine speed optimization is obtained between point B and point C on this curve.

The wind turbine model is a phasor model that allows transient stability type studies with long
simulation times. In this case study, the system is observed during 50 s. The 6-wind-turbine farm is
simulated by a single wind-turbine block by multiplying the following three parameters by six, as
follows:

• The nominal wind turbine mechanical output power: 6*1.5e6 watts, specified in the Turbine
data menu

• The generator rated power: 6*1.5/0.9 MVA (6*1.5 MW at 0.9 PF), specified in the Generator
data menu

• The nominal DC bus capacitor: 6*10000 microfarads, specified in the Converters data menu

The mode of operation is set to Voltage regulation in the Control Parameters dialog box. The
terminal voltage will be controlled to a value imposed by the reference voltage (Vref=1 pu) and the
voltage droop (Xs=0.02 pu).

Turbine Response to a Change in Wind Speed
Observe the turbine response to a change in wind speed. Initially, wind speed is set at 8 m/s, and then
at t=5s, wind speed increases suddenly at 14 m/s. “Waveforms for a Gust of Wind (Wind Farm in
Voltage Regulation Mode)” on page 6-15 illustrates the waveforms associated with this simulation.
At t=5 s, the generated active power starts increasing smoothly (together with the turbine speed) to
reach its rated value of 9MW in approximately 15s. Over that time frame the turbine speed increases
from 0.8 pu to 1.21 pu. Initially, the pitch angle of the turbine blades is zero degree and the turbine
operating point follows the red curve of the turbine power characteristics up to point D. Then the
pitch angle is increased from 0 deg to 0.76 deg to limit the mechanical power. Observe also the
voltage and the generated reactive power. The reactive power is controlled to maintain a 1 pu
voltage. At nominal power, the wind turbine absorbs 0.68 Mvar (generated Q=-0.68 Mvar) to control
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voltage at 1pu. If you change the mode of operation to Var regulation with the Generated
reactive power Qref set to zero, you will observe that the voltage increases to 1.021 pu when the
wind turbine generates its nominal power at unity power factor (“Waveforms for a Gust of Wind
(Wind Farm in Var Regulation Mode)” on page 6-16).

Waveforms for a Gust of Wind (Wind Farm in Voltage Regulation Mode)
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Waveforms for a Gust of Wind (Wind Farm in Var Regulation Mode)

Simulation of a Voltage Sag on the 120 kV System
Now observe the impact of a voltage sag resulting from a remote fault on the 120 kV system. In this
simulation the mode of operation is initially Var regulation with Qref=0 and the wind speed is
constant at 8 m/s. A 0.15 pu voltage drop lasting 0.5 s is programmed, in the 120 kV voltage source
menu, to occur at t=5 s. The simulation results are illustrated in “Voltage Sag on the 120 kV System
(Wind Farm in Var Regulation Mode)” on page 6-17. Observe the plant voltage and current as well as
the motor speed. Note that the wind farm produces 1.87 MW. At t=5 s, the voltage falls below 0.9 pu
and at t=5.22 s, the protection system trips the plant because an undervoltage lasting more than 0.2
s has been detected (exceeding protection settings for the Plant subsystem). The plant current falls to
zero and motor speed decreases gradually, while the wind farm continues generating at a power level
of 1.87 MW. After the plant has tripped, 1.25 MW of power (P_B25 measured at bus B25) is exported
to the grid.
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Voltage Sag on the 120 kV System (Wind Farm in Var Regulation Mode)

Now, the wind turbine control mode is changed to Voltage regulation and the simulation is
repeated. You will notice that the plant does not trip anymore. This is because the voltage support
provided by the 5 Mvar reactive power generated by the wind turbines during the voltage sag keeps
the plant voltage above the 0.9 pu protection threshold. The plant voltage during the voltage sag is
now 0.93 pu (“Voltage Sag on the 120 kV System (Wind Farm in Voltage Regulation Mode)” on page
6-18).
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Voltage Sag on the 120 kV System (Wind Farm in Voltage Regulation Mode)

Simulation of a Fault on the 25 kV System
Finally, now observe the impact of a single phase-to-ground fault occurring on the 25 kV line. At t=5 s
a 9 cycle (0.15 s) phase-to-ground fault is applied on phase A at B25 bus. When the wind turbine is in
Voltage regulation mode, the positive sequence voltage at wind turbine terminals (V1_B575)
drops to 0.8 pu during the fault, which is above the undervoltage protection threshold (0.75 pu for a
t>0.1 s). The wind farm therefore stays in service (“Wind Farm Waveforms During Fault at Bus B25
(Wind Farm in Voltage Regulation Mode)” on page 6-19). However, if the Var regulation mode is
used with Qref=0, the voltage drops under 0.7 pu and the undervoltage protection trips the wind
farm. We can now observe that the turbine speed increases. At t=40 s the pitch angle starts to
increase to limit the speed (“Wind Farm Waveforms During Fault at Bus B25 (Wind Farm in Var
Regulation Mode)” on page 6-19).
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Wind Farm Waveforms During Fault at Bus B25 (Wind Farm in Voltage Regulation Mode)

Wind Farm Waveforms During Fault at Bus B25 (Wind Farm in Var Regulation Mode)
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